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Preface

Welcome to the Hyperion Analyzer Release 7.0 Administrator’s Guide. This 
preface discusses the following topics:

● “Purpose” on page xi

● “Audience” on page xi

● “Document Structure” on page xii

● “Where to Find Documentation” on page xiii

● “Conventions” on page xiv

● “Additional Support” on page xv

● “Documentation Feedback” on page xvi

Purpose
This guide provides information that you need to Administer Hyperion Analyzer. 
It explains Hyperion Hyperion Analyzer features and options and contains the 
concepts, processes, procedures, formats, tasks, and examples that you need to use 
the software.

Audience
This guide is for system administrators who are responsible for administering, 
optimizing, customizing, securing, and supporting Hyperion Analyzer 
implementations. 
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Document Structure
This document contains the following information: 

Chapter 1, “Administrating Hyperion Analyzer”, identifies the most common 
tasks Hyperion Analyzer administrators perform, the resources available to 
complete these tasks, and considerations to undertake before beginning 
administration.

Chapter 2, “Managing Security and Access”, describes the processes and 
procedures associated with establishing user authentication methods, customizing 
authentication securing Hyperion Analyzer information.

Chapter 3, “Administration Tools Overview”, gives an overview of the interface, 
and permissions controlling the use of Hyperion Analyzer.

Chapter 4, “Managing Users”, describes the creation, modification, use, and 
maitenance of Hyperion Analyzer user profiles.

Chapter 5, “Managing User Groups”, describes the creation, modification, use, 
and maitenance of Hyperion Analyzer user group profiles.

Chapter 6, “Managing Report Groups”, describes the creation, modification, use, 
and maitenance of Hyperion Analyzer report groups.

Chapter 7, “Managing Database Connections”, describes the creation, 
modification, use, and maintenance of database connections.  It includes 
information on database connection properties and profiles Hyperion Essbase, 
Hyperion Financial Management and multiple relational database connection 
types.

Chapter 8, “Optimizing Hyperion Analyzer”, describes using the Hyperion 
Analyzer Analysis Server Console to control user sessions and network 
communication.

Chapter 9, “Configuration and Integration Options”, describes both the 
analyzer.properties file and Hyperion HUB.  These tools manage configuration 
and integration options for Hyperion applications.

Chapter 10, “Hyperion Analyzer Utilities”, profiles the 5.0.3 Migration Utility, the 
Batch Import Export Utility, and the Web Publishing Batch Utility.

Appendix A, “Customizing HTML Web Content” is a complete reference for 
Hyperion Analyzer HTML templates, tags, tokens, and actions.

Appendix B, “Applet Parameters”, lists applet parameters and other 
applet-specific information.
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Appendix C, “Repository Tables”, is a table of Hyperion Analyzer repository 
tables and their functions.

Appendix D, “User Preferences”, outlines all Hyperion Analyzer user preferences 
and their function.

The Glossary contains a list of key terms and their definitions.

The Index contains a list of Hyperion Analyzer terms and their page references. 

Where to Find Documentation
All Hyperion Analyzer documentation is accessible from the following locations:

● The Information Map, located from the application Help menu.

● Online help is accessible from the product that it documents. Start the product 
and click the Help button or menu command.

● The Hyperion Solutions Web site is located at http://www.hyperion.com.

● Access to the Hyperion Download Center is through 
http://hyperion.subscribenet.com.

➤ To access documentation from the Hyperion Solutions Web site:

1. Log on to http://www.hyperion.com.

2. Select the Support link and type your username and password to log on.

Note: New users must register to receive a username and password.

3. Follow the on-screen instructions.

➤ To access documentation from the Hyperion Download Center:

1. Log on to http://hyperion.subscribenet.com.

2. In the Login ID and Password text boxes, enter your assigned login ID name 
and password. Then click Login.

3. If you are a member on multiple Hyperion Download Center accounts, select 
the account that you want to use for the current session.

4. Follow the on-screen instructions.

➤ To order printed documentation:

http://www.hyperion.com
http://www.hyperion.com
http://hyperion.subscribenet.com
http://hyperion.subscribenet.com


xiv ■

Preface

Hyperion Analyzer Release 7.0 Administrator’s Guide

● Visit the Hyperion Solutions Web site at http://www.hyperion.com.

● In the United States, call Hyperion Solutions Customer Support at 
877-901-4975.

● From outside the United States, including Canada, call Hyperion Solutions 
Customer Support at 203-703-3600. Clients who are not serviced by support 
from North America should call their local support centers.

Conventions
The following table shows the conventions that are used in this document: 

Table i: Conventions Used in This Document 

Item Meaning

➤ Arrows indicate the beginning of procedures consisting of 
sequential steps or one-step procedures.

Brackets [] In examples, brackets indicate that the enclosed elements 
are optional.

Bold Bold in procedural steps highlights major interface 
elements.

CAPITAL LETTERS Capital letters denote commands and various IDs. 
(Example: CLEARBLOCK command)

Ctrl + 0 Keystroke combinations shown with the plus sign (+) 
indicate that you should press the first key and hold it 
while you press the next key. Do not type the plus sign.

Example text Courier font indicates that the example text is code or 
syntax.

Courier italics Courier italic text indicates a variable field in command 
syntax. Substitute a value in place of the variable shown in 
Courier italics.

ARBORPATH When you see the environment variable ARBORPATH in 
italics, substitute the value of ARBORPATH from your site.

n, x Italic n stands for a variable number; italic x can stand for 
a variable number or an alphabet. These variables are 
sometimes found in formulas.

http://www.hyperion.com
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Additional Support
In addition to providing documentation and online help, Hyperion offers the 
following product information and support. For details on education, consulting, 
or support options, visit Hyperion’s Web site at http://www.hyperion.com.

Education Services
Hyperion offers instructor-led training, custom training, and eTraining covering all 
Hyperion applications and technologies. Training is geared to administrators, end 
users, and information systems (IS) professionals. 

Consulting Services
Experienced Hyperion consultants and partners implement software solutions 
tailored to clients’ particular reporting, analysis, modeling, and planning 
requirements. Hyperion also offers specialized consulting packages, technical 
assessments, and integration solutions.

Ellipses (...) Ellipsis points indicate that text has been omitted from an 
example.

Mouse orientation This document provides examples and procedures using 
a right-handed mouse. If you use a left-handed mouse, 
adjust the procedures accordingly.

Menu options Options in menus are shown in the following format. 
Substitute the appropriate option names in the 
placeholders, as indicated.

Menu name > Menu command > Extended menu 
command 

For example: 1. Select File > Desktop > Accounts. 

Table i: Conventions Used in This Document (Continued)

Item Meaning

http://www.hyperion.com


xvi ■

Preface

Hyperion Analyzer Release 7.0 Administrator’s Guide

Technical Support
Hyperion provides enhanced electronic-based and telephone support to clients to 
resolve product issues quickly and accurately. This support is available for all 
Hyperion products at no additional cost to clients with current maintenance 
agreements.

Documentation Feedback
Hyperion strives to provide complete and accurate documentation. We value 
your opinions on this documentation and want to hear from you. Send us your 
comments by clicking the link for the Documentation Survey, which is located on 
the Information Map for your product.
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1

Chapter

1
Administrating Hyperion 
Analyzer

Hyperion Analyzer Administration Tools provide easy-to-use interfaces for 
administrating and optimizing Hyperion Analyzer.  This chapter provides the 
following information:

● Administration Tasks

● Administration Resources

● Hyperion Analyzer Components

● Hyperion Analyzer Architecture Overview

● Other Hyperion Analzyer Resources

● Starting Hyperion Analyzer Administration Tools

● Lockout Recovery

● Exiting Hyperion Analyzer Administration Tools

Administration Tasks

Installation, Configuration and Migration

The Hyperion Analyzer Installation Guide describes installation and installation 
options essential to installing and configuring Hyperion Analyzer. This guide 
includes procedures for establishing a Hyperion Analyzer repository, executing 
silent installations, and installing Hyperion Analyzer samples. Redeployment 
follows the same process as installation, and administrators reconfiguring or 
redeploying Hyperion Analyzer are also encouraged to consult the Hyperion 
Analyzer Installation Guide.



20 ■

Administrating Hyperion Analyzer

Hyperion Analyzer Release 7.0 Administrator’s Guide

Managing Security and Access

Administrators may use the default Hyperion Analyzer authentication and 
security, Hyperion Essbase authentication, and external authentication methods to 
validate users and logons. All security and authentication protocols are managed 
by way of Hyperion Analyzer Administration Tools.

Managing Users, User Groups and Database Connections

Hyperion Analyzer Administration Tools is the primary interface for managing 
users, user groups, and database connections. In addition, administrators can 
assign predefined roles that control user access to the Hyperion Analyzer system.

Optimizing the Hyperion Analyzer System

System administrators can use the Java-based Hyperion Analyzer Analysis Server 
Console to monitor, maintain and optimize the Hyperion Analyzer system. This 
console provides statistics on server logons, data hits, and data response times. 
Administrators can also manually disconnect users idle in excess of a time 
limitation, and show, clear and export console output.

Automating the Distribution of HTML Web Content

Hyperion Analyzer enables users to convert a currently displayed report, or and 
entire report group to HTML, by specifying JSP templates. This Web publishing 
process can also be automated using a command line batch utility that converts 
report groups to HTML as scheduled.

Configuring Integrated Hyperion Applications

Administrators must register Hyperion applications available to Hyperion 
Analyzer users through the Related Content feature. Hyperion applications can be 
registered through both the Analyzer.properties file and the Hyperion Hub 
server, but external authentication is required to use Hyperion Hub.

Education and Training

Hyperion Analyzer provides administrators with tools to support user training and 
education, including these:

● The Hyperion Analyzer Sample Report Group
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● Hyperion Analyzer API Toolkit samples

● Documentation deliverables in HTML and PDF

Customizing HTML Web Content

You can customize HTML Web Client templates, or create new templates for 
displaying Hyperion Analyzer content.

Administration Resources
You will use the following items and information to administer Hyperion 
Analyzer:

● Hyperion Analyzer Components

● Hyperion Analyzer Architecture Overview

● Other Hyperion Analzyer Resources

Hyperion Analyzer Components
Hyperion Analyzer consists of the following components:

● Four client applications

● An analysis server

● A repository

● An API Toolkit

The repository centrally stores Hyperion Analyzer system data, user IDs, user 
preferences, and report definitions in relational database tables.

The Analysis Server communicates report definitions and system information 
among the repository, Web clients, and Hyperion Analyzer Administration Tools.

The Hyperion Analyzer Administration Tools client provides a 100-percent 
Java graphical interface for managing users, users groups, and database 
connections using a supported Web browser. It also provides access to several 
administration utilities.

The Hyperion Analyzer Java Web Client is an easy-to-use graphical interface 
that enables online analysis of both Hyperion Essbase and relational data. You can 
design and format custom analysis applications without “coding.” 
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The Hyperion Analyzer Windows Client is the same easy-to-use Java Web 
Client interface and functionality delivered as a stand-alone Java application for 
supported Microsoft Windows operating systems.

The Hyperion Analyzer HTML Web Client is a 100-percent HTML thin client 
used by way of a supported Web browser. It is engineered for information 
consumers who do not require advanced design and content-creation capabilities.

The Hyperion Analyzer API Toolkit enables developers to incorporate the 
Hyperion Analyzer Java Web Client look and feel and functionality into their own 
custom Web applications.

Hyperion Analyzer Architecture Overview
Hyperion Analyzer functionality is distributed across a multi-tiered architecture:

● Client layer

● Mid-tier layer

● Database server layer

The client layer refers to the four clients and the API Toolkit.  All clients 
communicate with the rest of the Hyperion Analyzer system using Hypertext 
Transmission Protocol (HTTP).

The mid-tier layer includes:

● The Web server

● The J2EE Application Server

● The Hyperion Analyzer Analysis Server

● Drivers and protocols for communicating with the database server layer

The database server layer supports and shares both OLAP and relational 
databases, and the relational Hyperion Analyzer repository.

A supported Web server is required to present the Web page from which Web 
clients are launched, to deliver files containing Java components, and to transport 
images generated at run time.  After clients are established, the Web server 
manages all client mid-tier HTTP communication.
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Hyperion Analyzer has been restructured to run inside leading J2EE-compliant 
application servers.  The supported J2EE Application Server shares Hyperion 
Analyzer business logic, manages network traffic, maintains system security for 
large numbers of concurrent users, and provides scalability and stability through 
load balancing and fault tolerance.

Figure 1: Hyperion Analyzer Architecture Diagram

Other Hyperion Analzyer Resources
These additional components, executables and servlets are provided to help you 
administrate Hyperion Analyzer:
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Hyperion Analyzer Installer

Hyperion Analyzer uses a new common installer to provide a consistent end-user 
installation experience across the range of Hyperion products. The installer detects 
cross-component compatibility issues earlier and subsequently reduces 
installation-related problems and support calls. For more information, see the 
Hyperion Analyzer Windows Installation Guide or Hyperion Analyzer UNIX 
Installation Guide.

Hyperion Analyzer Configuration Test Servlet

Use the Hyperion Analyzer Configuration Test Servlet to diagnose and resolve 
connectivity issues. To start the servlet, start a Web browser and replace 
“index.html” in the path to the Hyperion Analyzer launch page with “Config.”  The 
servlet displays links that centrally report environmental variables and 
Analyzer.properties file parameters, and test connectivity to the class 
factory, the Hyperion Analyzer repository, the external authentication 
configuration file, and the Essbase ADM driver.

For more information, see “Hyperion Analyzer Configuration Test Servlet” on 
page 153.

Hyperion Analyzer Administration Tools

The Hyperion Analyzer Administration Tools client provides a 100% Java 
graphical interface for managing users, users groups, and database connections via 
a supported Web browser. It is also instrumental in setting authentication services 
for the Hyperion Analyzer system and configuring Hyperion Hub connectivity.

For more information, see Chapter 3, “Administration Tools Overview.”

Hyperion Analyzer Analysis Server Console

System Administrators can use the Java-based Hyperion Analyzer Analysis Server 
Console to monitor, maintain, and optimize the Hyperion Analyzer System. This 
console provides statistics on server logons, data hits, and data response times. 
Administrators can also manually disconnect users idle in excess of a time 
limitation, and show, clear, and export console output.

For more information, see “Hyperion Analyzer Analysis Server Console” on 
page 117.
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Hyperion Analyzer Save As Web Page Batch Utility

The new Hyperion Analyzer Save As Web Page Batch Utility automates the 
process of publishing Hyperion Analyzer reports to the Web, using JSP templates. 
For more information, see “Web Publishing Batch Utility” on page 150.

Analyzer.properties File

The Analyzer.properties file contains variables controlling Hyperion 
Analyzer functionality.  Administrator modifications to the file support their 
specific implementations in the following ways:

● Controlling the result set

● Updating the license key without reinstalling

● Identifying integrated Hyperion applications for Hyperion Analyzer

● Configuring Essbase XTD Deployment Services

● Formatting data value tool tips

● Controlling Page Queries

For more information, see “Analyzer.Properties File” on page 122.

CssConfig.xml File

External authentication is managed using a configuration XML file that specifies 
the platforms and authentication providers of your specific implementation. Users 
must establish the components used in support of external authentication, and then 
coordinate them by editing the XML file.

Hyperion Hub

Hyperion Hub is a central application and business metadata repository for 
Hyperion applications and tools. Additionally, Hyperion Analyzer can export 
XML report definitions to Hyperion Hub to be used by other interoperable 
Hyperion applications, and import XML report definitions from other Hyperion 
Analyzer implementations or environments.

For more information, see “Configuring Hyperion Hub” on page 121.
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Hyperion Analyzer Batch Import/Export Utility via API Toolkit

The new batch import/export utility enables administrators to import reports, 
report groups, user IDs, point of view definitions and personal variable definitions.

The batch import/export utility is also instrumental in migrating from certain 
releases of Hyperion Analyzer to the current release.

Hyperion Analyzer Migration Utility

The AdminMigrate.exe and AnalyzerMigrate.exe migration utilities 
enable Hyperion Analyzer 5.0.3 users to convert the majority of their Hyperion 
Analyzer repository information to the new Hyperion Analyzer 7.0 architecture 
and repository format.

For more information, see “Hyperion Analyzer 5.0.3 Migration Utility” on 
page 133.

Administration Strategies
The specifics of your Hyperion Analyzer implementation determine the 
administration tasks you undertake, and their order.  Key considerations include 
the following questions:

● Are you implementing Hyperion Analyzer for the first time, or are you 
upgrading an existing implementation?

● Are you implementing Hyperion Analyzer on Microsoft Windows, a UNIX 
environment or a mixture of both?

● Are you supporting analysis of Hyperion Essbase, Hyperion Financial 
Management, relational data sources, or a combination of these data sources?

● What type of user authentication method will you use?

● With which other applications will Hyperion Analyzer be integrated?

● What objectives must interoperability support, and what configuration is 
necessary for interoperability to succeed?
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Starting Hyperion Analyzer Administration 
Tools

Prerequisites for Starting

Before you can start, an administrator must provide you with the uniform resource 
locator (URL) of the Hyperion Analyzer Java Web Client launch page, and your 
computer must satisfy any System Requirements.

Logging On to Hyperion Analyzer Administration Tools

➤ To start the Hyperion Analyzer Administration Tools client:

1. Start a supported Web browser.

2. Select File > Open from the menu.

3. Enter the URL of the Hyperion Analyzer launch page, and press Enter.

4. Click the link launching Hyperion Analzyer Administration Tools.

The Hyperion Analyzer Administration Tools application window is 
displayed, and then the Login dialog box is displayed.

5. Enter a valid user ID and Password in the Login dialog box.

Note: Hyperion Analyzer is delivered with a defined user ID, Administrator, and 
password, password. If you edit the Administrator user profile, do not forget the 
Administrator password. Loss of the Administrator password prevents 
administration until another user with an Administrator role privileges resets the 
password.

6. If prompted with a Domain drop down list box, select an authentication 
method.

Analyzer authentication is the default authentication method.  Essbase and 
external authentication may also be available.

7. Click OK.
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Lockout Recovery
Do not forget the Administrator password. Loss of the Administrator password 
prevents administration until another user with an Administrator role privileges 
resets the password.

If you are unable to log in as an administrator because of lost or forgotten 
passwords, Hyperion Analyzer technical support may be able to recover the 
system password. However, since there is no “back door” into Hyperion Analyzer, 
recovering system passwords is difficult.

Exiting Hyperion Analyzer Administration Tools

➤ To exit the Hyperion Analyzer Administration Tools client, select File > Exit.
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Authentication Options
Hyperion Analyzer supports three methods for validating user IDs and passwords:

● Analyzer Authentication

● Essbase Authentication

● External Authentication

Authentication methods are not mutually exclusive. Administrators may use a 
combination of methods and set an order of precedence. Administrators must 
evaluate the advantages and disadvantages of each method before deciding which 
to use.

Analyzer Authentication
Native Hyperion Analyzer authentication is always available to every valid 
Hyperion Analyzer user.

Analyzer authentication validates the user against known user IDs and passwords 
in the Hyperion Analyzer repository.  Administrators using this authentication 
method have the additional option of setting Hyperion Analyzer passwords to 
expire at specified interval of days.

The Hyperion Analyzer Batch Import/Export utility enables administrators to 
compose an aru XML file that automates the creation and modification of users 
and user groups in the Hyperion Analyzer repository. See Chapter 3, “Hyperion 
Analyzer Utilities” for more information.
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Essbase Authentication
When Hyperion Essbase authentication is enabled, Hyperion Analyzer uses the 
specified Essbase server to validate the user ID and password for login. This 
method requires the administrator to specify the server name or server IP address.

Essbase authentication is summarized by the following table:

Table 1: Essbase Authentication Summary

External Authentication
When external authentication is enabled, Hyperion Analyzer uses a centralized, 
independent authentication provider to validate the user ID and password. Using 
external authentication provides the following benefits:

● The existing corporate structure of user accounts is employed by Hyperion 
applications, thus reducing administrative overhead

● The benefit of single sign-on to Hyperion applications is added, thus 
eliminating the need for users to log on multiple times with multiple user 
names and passwords

Additionally, external authentication is a prerequisite for Hyperion Analyzer to 
operate with Hyperion Hub and some kinds of related content.

Hyperion Analyzer supports three external authentication providers:

● Lightweight Directory Access Protocol Directory 3.0 (LDAP)

● Microsoft Active Directory, Windows 2000 sp3 (MSAD)

● Microsoft Windows NT LAN Manager 4.0 (NTLM)

Essbase Authentication Action Hyperion Analyzer Response

Essbase validates the user and the 
existence of a Hyperion Analyzer user 
profile.

Hyperion Analyzer logs on the user.

Hyperion Essbase validates the user but 
cannot validate the existence of a 
Hyperion Analyzer user profile.

Hyperion Analyzer assigns the Essbase 
user ID and password to a new user 
profile (created using a default user 
group).

Hyperion Essbase cannot validate the 
user.

Hyperion Analyzer displays a failed 
logon message.
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Hyperion Analyzer supports four external authentication platforms:

● Microsoft Windows NT 4.0

● Microsoft Windows 2000

● Microsoft Windows 2003

● UNIX

Note: NTLM implementations on UNIX platforms require that a Hyperion 
Remote Authentication Module be installed on a Windows NT or Windows 2000 
server.

Single Sign-on
One of the benefits of external authentication is single sign-on. Externally 
authenticated users are granted access to multiple Hyperion applications after 
logging on only once. After external authentication, an encrypted token containing 
the user ID and password is passed among Hyperion applications to automatically 
reauthenticate the user.

Setting Authentication Methods
Authentication methods are set, in whole or in part, using the Hyperion Analyzer 
Administration Tools client.

Setting Analyzer Authentication

➤ To initiate Analyzer Authentication:

1. From the launch page, start Hyperion Analyzer Administration Tools.

2. Select Edit > Authentication Services.

The Authentication Services dialog box is displayed. It contains a General tab 
and three authentication method tabs.

3. Select the General tab.

Within the Select Domain Types group the Analyzer check box is selected. 
The check box is not selectable, so users cannot clear it. This ensures that 
Analyzer authentication is always available.
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Within the Default Domain Type group the Analyzer option is selected. This 
sets Analyzer authentication as the default in the Login dialog box.

4. Select the Analyzer tab.

This tab features a password expiration setting.

5. Optional: To set passwords to expire after a specified interval of days, select 
the check box and enter a whole number in the entry field.

6. Click OK.

Setting Essbase Authentication

➤ To initiate Essbase authentication:

1. From the launch page, start Hyperion Analyzer Administration Tools.

2. Select Edit > Authentication Services.

The Authentication Services dialog box is displayed. It contains a General tab 
and three authentication method tabs.

3. Select the General tab.

Within the Select Domain Types group the Analyzer check box is selected. 
This check box is not selectable, so users cannot clear it. This ensures that 
Analyzer authentication is always available.

4. Select the Essbase check box.

This selection enables the Essbase tab.

5. Select a default domain type by clicking an option button in the Default 
Domain Type group.

If you want Essbase to serve as the default authentication domain, select 
Essbase. This sets Essbase authentication as the default in the Login dialog 
box.  If you want Analyzer to serve as the default authentication domain, select 
Analyzer.

6. Select the Essbase tab.

7. In the Essbase Server field, enter the server domain name or the IP address.

8. Select a defined Hyperion Analyzer user group from the Default User Group 
drop-down list box.



Configuring External Authentication

2

■ 33Hyperion Analyzer Release 7.0 Administrator’s Guide

When Hyperion Essbase can validate the user but cannot determine whether a 
Hyperion Analyzer user ID has yet been created, a new user ID is created with 
the Essbase user ID and password. The privileges of the specified Default User 
Group are assigned to the new user ID.

Hyperion Analyzer is delivered with an Administrators user group that assigns 
all the privileges normally given to the system administrator.

If the None option is selected, a new user ID is created, but the user cannot use 
Hyperion Analyzer until an administrator assigns the new user ID to a 
Hyperion Analyzer user group.

For more information on creating user groups and assigning user 
roles/privileges, see the Hyperion Analyzer Administration Tools Online 
Help.

9. Click OK.

Configuring External Authentication
Configuring external authentication has been broken down into the following 
processes:

1. External Authentication Prerequisites

2. Install Hyperion Analyzer

3. Define Hyperion Analyzer user groups

4. Editing the Configuration File

5. Restarting the Application Server

6. Specifying the Configuration File Location

7. Copy archives to the application server JRE

8. Mapping Groups to User Groups

External Authentication Prerequisites
Before you can implement external authentication, the following determinations 
must be made:
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1. Is the security platform implemented from an application or an application 
server?

Table 2 lists the Web servers / application servers that are supported, on each 
operating system, by the Hyperion security platform.

2. Which platforms and authentication providers will be used in external 
authentication?

Table 2: Supported Web Servers/Application Servers by OS

Operating System Web/App Servers

Windows NT 4.0, sp 6a or higher IIS 4.x, Apache 2.0.43

Windows 2000 Server and 
Advanced Server, sp 3 or higher 

IIS 5.x, Apache 2.0.43

Windows 2003 IIS 6.x

Solaris 8 and 9 Apache 1.3.27

HP-UX 11i Apache 1.3.27

AIX 5.1L IBM HTTP Server 1.3.26.1
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Note: The tested and supported LDAP servers are: iPlanet 5.2, Novell eDirectory 
8.7, IBM Directory Server 5.1, and Domino LDAP 5.x and 6.0. iPlanet is now known 
as Sun[tm] Open Net Environment (Sun ONE).

3. If you are considering implementing security using an NTLM provider for 
Hyperion applications installed on a UNIX machine or multiple Windows 
domains where there is no trust relationship, is the Hyperion Remote 
Authentication Module installed on a Windows NT or Windows 2000 server?

Install the Hyperion Remote Authentication Module from the Hyperion 
Download Center. After the Remote Authentication Module is installed, you 
must provide its URL to the <remoteServer> element in the XML 
configuration file.

4. If you want to enable authentication from multiple Windows domains, but you 
do not want to set up trust relationships between those domains, install the 
Hyperion Remote Authentication Module on a separate Windows server. This 

Table 3: Supported Authentication Providers and Platforms

LDAP 3 
compatible 
directories NTLM

Microsoft 
Active 
Directory

Windows NT 
4.0, sp 6a or 
higher

X X X

Windows 2000 
Server and 
Advanced 
Server, sp 3 or 
higher 

X X X

Windows 2003 X X X

UNIX X X - requires 
installation of 
Hyperion  
Remote 
Authentication 
Module

X
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enables users on one domain to log into Hyperion applications on other 
domains. All domains involved must be configured to use the same Hyperion 
Remote Authentication Module instance.

5. Hyperion applications can integrate with Web Access Management Solutions 
such as Netegrity SiteMinder. Web Access Management Solutions are 
employed by organizations to manage and enforce authentication, 
authorization, and single sign-on for web resources such as JSP files, ASP 
files, or HTML files.

The Hyperion security platform enables single sign-on for web-based 
Hyperion applications. Integration with a Security Agent requires 
configuration of the <securityAgent> element in the XML configuration 
file.

The Hyperion security platform supports SiteMinder Policy Server 5.5 
Service Pack 2 and SiteMinder Web Agent 5.5 Service Pack 2 also known as 
SiteMinder Web Agent 5.x QMR 5. 

Note: In this documentation, the terms Security Agent and Web Security Agent 
are interchangeable, and refer to any Web Access Management Solutions provider 
such as SiteMinder.

You can configure SiteMinder to require that users authenticate through 
SiteMinder only, after which they are not required to present credentials again 
when logging in to Hyperion applications.

Installing Hyperion Remote Authentication Module to 
Support UNIX applications

➤ To install a Hyperion Remote Authentication Module in support of UNIX 
applications:

1. On a Windows NT/2000 server, install the Hyperion Remote Authentication 
Module. The installation program, setup.exe, is available on the Hyperion 
Download Center.

2. Download and read the installation and setup instructions provided with the 
Hyperion Remote Authentication Module on the Hyperion Download Center.
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Multiple-Domain Support for NT LAN Manager
The Hyperion Remote Authentication Module also enables Hyperion applications 
to authenticate users belonging to domains that are not trusted by the Hyperion 
application domain. This removes the necessity to establish trust relationships 
between the domains. 

➤ To provide support for NTLM authentication using multiple Windows domains,

1. On a Windows NT/2000 server, install the Hyperion Remote Authentication 
Module. The installation program, setup.exe, is available on the Hyperion 
Download Center.

2. Download and read the installation and setup instructions provided with the 
Hyperion Remote Authentication Module on the Hyperion Download Center.

Required NTLM User Rights
The NTLM user account on which the application server runs requires the 
following access:

● Grant “Access the computer from the network” rights.

● Grant “Act as part of the operating system” rights.

● End users must be domain users rather than local Windows users.

Privileges must be established on the computer running the application server (as opposed 
to the NT domain).

Hyperion Analyzer Installation and External 
Authentication Components

The following external authentication components are installed with Hyperion 
Analyzer:

● A generic CssConfig.xml file is installed in the ..\hyperion\analyzer\conf 
directory.

● Java Cryptography Extension (JCE) archives are installed in the 
..\hyperion\analyzer\css directory.
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Defining Hyperion Analyzer User Groups
Hyperion Analyzer privileges are assigned by user group. All users have the 
privileges of the user groups to which they belong.  The number of user groups 
required is determined by the roles and permissions required for your 
implementation.

➤ To create new Hyperion Analyzer user group profiles in Hyperion Analyzer 
Administration Tools:

1. Take one of the following actions:

● Right-click the User Groups folder and select New User Group.

● From the menu bar, select File > New > New User Group.

An empty user group profile is displayed in the Management panel. The 
General tab is displayed by default.

2. Enter a user group name in the Name field.

3. Optionally, you can enter a user group description in the Description field.

4. Click the Roles tab.

Hyperion Analyzer has four defined roles:

● Administrator - Unrestricted

● Power User

● Interactive User

● Information Consumer - Read-only access

Detailed descriptions of the permissions provided through each of these roles 
is provided by Hyperion Analyzer Administration Tools Online Help.

Note: Assign these roles conservatively. There are fewer consequences for 
expanding permissions than restricting permissions.

5. To assign a role, click the role in the Available panel, then click the right 
arrow button, to move the role definition to the Assigned panel.

The role is assigned to all users of the user group. Permissions are cumulative 
for multiple role selections.

6. Click the Apply button.

7. Click OK.
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The Log panel confirms a successful assignment.

8. Repeat steps 1-7 for each user group.

Editing the CssConfig.xml File
External authentication is managed using a configuration XML file that specifies 
the platforms and authentication providers of your specific implementation. Users 
must establish the components used in support of external authentication, and then 
coordinate them by editing the XML file.

Existing Configuration Files
Before you edit the CssConfig.xml file delivered with Hyperion Analyzer, you 
must determine whether your enterprise has defined an external authentication 
configuration file for previously installed Hyperion products.

Note: If this file already exists, do not overwrite it.

The Hyperion Analyzer external authentication configuration file is called 
CssConfig.xml. Because files can be renamed, you cannot depend on a simple 
file search to determine the existence of an external authentication configuration 
file.

Note: To enable single sign-on where one Hyperion product launches another, you 
must use a single XML configuration file that is shared by both product installations.

Editing the Configuration File
If no other external authentication configuration file exists, you can edit the 
generic CssConfig.xml file installed in the ..\hyperion\analyzer\conf 
directory.

In editing the XML file, you specify the following information:

● The sequential search order for accessing multiple external authentication 
provider types

● The type, name, parameters, and number of external authentication providers

● The duration in minutes that authentication tokens persist when passed to 
Hyperion applications (before timing out)

● Logging parameters
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● Optionally, the Web Access Management Solution used by your 
implementation

➤ To edit the external authentication configuration file, open CssConfig.xml in 
Microsoft WordPad.

Note: The application server must be stopped and restarted to reflect changes in the 
CssConfig.xml file.

Configuring the Provider Search Order
The search order enables the external authentication mechanism to access multiple 
providers in a sequential manner. Search order must be defined even if there is only 
a single authentication provider. In this case, the search order property has a single 
entry.

➤ To define the provider search order:

1. Open CssConfig.xml in Microsoft WordPad.

2. Locate the <searchOrder> tag in the configuration file.

Each supported external authentication provider is listed as an element of the 
search order tag:

<searchOrder>

  <el>ntlmServer</el>

  <el>ldapServer</el>

  <el>msadServer</el>

</searchOrder>

3. Cut and paste the elements, to reorder them.

Providers may be added or removed as needed.

Hyperion recommends placing the provider for most users of Hyperion 
applications first in the search order.

The search order element name must match the name you specify in 
subsequent provider definitions.
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To expedite editing, you can comment out elements using the following 
syntax:

  <!-- el>ldapServer</el -->

4. Add, remove or comment out elements as needed.

5. Replace the text between the <el> and </el> tags with the server configuration 
name. Example:

  <el>MYntlmServer</el>

  <el>MYldapServer</el>

  <el>MYmsadServer</el>

Note: You must use the same server configuration name when you subsequently 
define external authentication provider configurations.

6. To save your changes to the configuration file, select File > Save.

Configuring an NTLM Provider
You must modify the configuration file to support NTLM external authentication 
providers, if you are implementing them.

➤ To define NTLM external authentication providers:

1. Locate the NTLM provider tags in the configuration file.

The NTLM tag is <ntlm name=”ntlmAuth1”>.

2. Replace the name value to reflect the name of the external authentication 
provider. 

Remember that the string value must be inside quotation marks, and must be 
identical to the name specified in the search order tag.

The following parameters can be set for each defined provider. 

● trusted - The trust relationship of this provider

● domain - The NTLM domain against which to authenticate

● maxSize - Maximum allowable number of users or groups returned.
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● remoteServer - For authenticating from UNIX, or for multiple Windows 
domains without trust relationships.

Note: If you support Hyperion applications only on Microsoft Windows 
platforms, delete the content of the <remoteServer> tags, because their 
configuration applies only to support for UNIX clients accessing information 
stored in an NTLM provider.

● location - Location providing the remote RMI authentication for NT

Do not delete parameter values only. In the absence of values, defaults may be 
used. To delete the impact of a parameter, comment it out, or delete the entire 
tag set (from <> to </>).

3. Edit the provider definitions between the <trusted> and </trusted> tags.

If a provider is a trusted provider, leave the value true. A password is not 
present or required in the user authentication token when the value is true. 
Users still must log in with a user name and password, but the password is not 
stored in the token.

If the specified provider is not a trusted provider, replace the value with false. 
A password is required in the user authentication token when the value is false.

If the entire tag is deleted, the default value of true is used.

4. Edit the NTML provider definition between the <domain> and </domain> 
tags.

The NTLM provider is responsible for operations on the specified domain. 
When no value is supplied for the domain element, the NTLM provider 
performs operations on all trusted domains.

5. Edit the user value between the <maxSize> and </maxSize> tags:

● Replace the generic value with the maximum number of entries that can 
be returned in a query.

● If the entire tag is deleted, the default value of 100 is used. Do not delete 
the tag values solely. Setting the value to 0 prevents rows from being 
returned to the application.

6. If you are using the Hyperion Remote Authentication Module (HRAM), edit 
the value between the <location> and </location> tags (nested in the  
<remoteServer> and </remoteServer> tags) to indicate the URL of the 
Hyperion Remote Authentication Module.

<remoteServer>
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          <location>//host:1099/NTLMImpl</location>
</remoteServer>

If this step does not apply to you, delete the contents of the <remoteServer> 
and </remoteServer> tags.

7. To save your changes to the configuration file, select File > Save.

Configuring an LDAP or MSAD Provider
You must modify the configuration file to support LDAP and MSAD external 
authentication providers, if you are implementing them.

➤ To define LDAP and MSAD external authentication providers:

1. Locate the LDAP and MSAD provider tags in the configuration file.

The LDAP tag is <ldap name=”ldapAuth1”>.

The MSAD tag is <msad name=”msadAuth1”>.

2. Replace the name value to reflect the name of the external authentication 
provider. 

Remember that the string value must be inside quotation marks and must be 
identical to the name specified in the search order tag.

The following parameters can be set for each defined provider.

● trusted - The trust relationship of this provider

● url - Provider server identification

● userDN - (Optional) ID of user with directory access

● password - (Optional) Password of user with directory access

● authType - Authentication type

● authProtocol - (Optional) Authentication Protocol

● maxSize - Maximum allowable number of users or groups returned.

● identityAttribute - Attribute which specifies the users identity

● user - Attributes defining user aspects.

Note:         loginAttribute is used to identify the users login name.

● group - Attributes defining group aspects.
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Do not delete parameter values only. In the absence of values, defaults may be 
used. To delete the impact of a parameter, comment it out, or delete the entire 
tag set (from <> to </>).

3. Edit the values between the <trusted> and </trusted> tags:

● If the specified provider is a trusted provider, leave the value true. A 
password is not present or required in the user authentication token, when 
the value is true.

● If the specified provider is not a trusted provider, replace the value with 
false. A password is required in the user authentication token, when the 
value is false.

● If the entire tag is deleted, the default value of true is used.

4. Edit the values between the <url> and </url> tags.

Replace the tag value with the URL of the external authentication provider 
location. You must include the domain component attributes (DCs) in the 
URL; for example:

ldap://ldap_server:389/DC=company,DC=com

Note: Ensure that there are no empty spaces in the URL.

5. Edit the values between the <usderDN> and </userDN> tags and between the  
<password> and </password> tags:

● Replace the generic values with information from valid user account with 
read-only access to the directory stores.

● If you want to provide anonymous access, delete both tag definitions. Do 
not delete the tag values solely.

6. Edit the user values between the <maxSize> and </maxSize> tags:

Replace the generic value with the maximum number of entries that can be 
returned in a query.

If the entire tag is deleted, the default value of 100 is used. Do not delete the 
tag values solely. Setting the value to 0, enables a result set size of unlimited. 
This is not advisable, as extremely large result sets quickly consume memory 
allocations.

7. Edit the user <authProtocol> and </authProtocol> tags.
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● Replace the generic value with additional security protocols you are using 
to secure data transmission to and from the external authentication 
provider.

● The only valid value for this tag is ssl.

● If you are not using Secure Sockets Layer, delete the tags completely.

8. If you are using Secure Sockets Layer, also complete the following tasks:

● On the directory server, ensure that a certificate is installed and available.

● On the Java Virtual Machine that runs your application, create a certificate 
database if one does not exist.

● On the Java Virtual Machine that runs your application, trust the 
Certificate Authority (CA) that issues the server certificate.

The security platform uses the LDAP service provider from SUN to 
authenticate users stored externally in an LDAP-compatible directory. The 
LDAP service provider runs on the Java Virtual Machine for your application. 
When SSL is used as the secure medium to connect to the directory server, the 
security platform LDAP service provider uses Java Secure Socket Extension 
software for SSL support.

9. Edit the user values between the <identityAttribute> and 
</identityAttribute> tags.

Replace the generic value with the unique identifier attribute of the directory. 
The attribute may be the DN, or a custom attribute such as employee_ID. 
When the identityAttribute tags are deleted the default value is dn.

10. Edit the user values between the <url> and </url> tags:

● Replace ou=People with the directory server branch that contains user 
entries. For example (if users are stored in a directory named People):

<user>
  <url>ou=People</url>
</user>

● The user url property is relative to the URL specified for the provider. If 
you want the provider to search the whole directory, delete the <url> and 
</url> tags. Do not delete the tag values alone.

11. Edit the user values between the <loginAttribute> and </loginAttribute> 
tags.
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Replace the generic value with the unique entry attribute of the directory. The 
attribute may be part of the DN, such as cn or uid, or a custom attribute such 
as employee_id. When the loginAttribute tags are deleted, the default is cn.

For example, if users use the common name attribute and are identified by cn=
UserName, the following syntax is used:

<user>
  <loginAttribute>cn</loginAttribute>
</user>

The sample above is correct if all user names are identified by cn=UserName.

This example highlights a subset of the DN. However, the loginAttribute 
property can instead refer to an attribute under the directory node for the user. 
For example, loginAttribute can point to uid.

12. Edit the user values between the <fnAttribute> and </fnAttribute> tags.

Replace the generic value with the attribute associated with first-name entries 
in the directory. If the <fnAttribute> </fnAttribute> tags and their contents are 
deleted, the default value for the first-name attribute is givenname.

13. Edit the user values between the <snAttribute> and </snAttribute> tags.

Replace the generic value with the attribute associated with last-name entries 
in the LDAP directory. If the <snAttribute></snAttribute> tags and their 
contents are deleted, the default value for the last-name attribute is sn.

14. Edit the user values between the <emailAttribute> and </emailAttribute> 
tags.

Replace the generic value with the attribute mapped to e-mail addresses that 
is stored in your corporate directory.

If the <emailAttribute> </emailAttribute> tags and their contents are deleted, 
the default value is mail.

15. Edit the user values between the <objectclass> and </objectclass> tags.

You may add <entry></entry> tags and values if your corporate directory 
schema requires specialized object classes to describe users, and those object 
classes are not present in the existing entries.

The default user object classes for LDAP are person, organizationalPerson, 
and inetOrgPerson.

The default user object classes for Active Directory are person, 
organizationalPerson, and user.
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16. Edit the group values between the <url> and </url> tags.

Replace ou=Groups with the directory server branch that contains group 
entries. For example (if users are stored in a directory named Groups):

<group>
  <url>ou=Groups</url>
</group>

The user url property is relative to the URL specified for the provider. If you 
want the provider to search the whole directory, delete the <url></url> tags. 
Do not delete the tag values solely.

17. Edit the group values between the <nameAttribute> and </nameAttribute> 
tags.

Replace the generic value with the attribute in the corporate directory through 
which a group entry can be discovered. The default value is cn if the 
<nameAttribute> section is deleted.

For example (if group names containing the relevant user entries are using the 
Common Name attribute):

<group>
  <nameAttribute>cn</nameAttribute>
</group>

18. Edit the group values between the <objectclass> and </objectclass> tags.

You may add <entry></entry> tags and values if your corporate directory 
schema requires specialized object classes to describe groups, and those object 
classes are not present in the existing entries.

The default group object classes for LDAP are 
groupofuniquenames?uniquemember and groupOfNames?member.

The default group object class for Active Directory is group?member.

For additional entries you make, the <entry> tag values must be of the format 
ObjectClassName?AttributeName

For example: where group is the name of the objectClass and member is the 
attribute that holds the distinguished Name of the member of this group.

<group>
  <entry>group?member</entry>
</group>

19. To save your changes to the configuration file, select File > Save.
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Configuring Token Timeout
When an externally authenticated user logs in to a Hyperion application, a token is 
generated to contain the logon credentials. You can configure the token to expire 
after a specified number of minutes instead of the default of 480 minutes.

➤ To define the length of time a token remains valid:

1. Locate the <token> tag in the configuration file.

2. Enter the number of minutes required to pass before a user is prompted to 
authenticate again between the <timeout> and </timeout> tags, as in this 
example:

<timeout>60</timeout>

3. To save your changes to the configuration file, select File > Save.

Configuring Preferred Logging Priority

➤ To configure the error level setting for applications supporting external 
authentication:

1. Locate the <logger> tag in the configuration file.

2. Edit the values between the <priority> and </priority> tags to specify the 
level of authentication-related error messages that you want the application to 
log.

The following values are cumulative and include the error messages of the 
subordinate error levels.

● DEBUG - Include all information for the purposes of debugging.

● INFO - Include status information for select operations and requests.

● WARN - Include only cautionary information for select operations and 
requests.

● ERROR - Include only errors pertaining to failed operations and requests.

● FATAL - Include only errors that result in disconnection.

3. To save your changes to the configuration file, select File > Save.
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Configuring for SiteMinder Single Sign-On

➤ To enable single sign-on to web-based Hyperion applications through SiteMinder: 

1. Locate the end of the configuration file, after the <logger></logger> section 
but before the line containing </css>.

2. Add the following information (indicated by bold) to The Security Agent 
configuration is applicable only to web-based Hyperion applications.

    <logger>
      <priority>FATAL</priority> 
    </logger>
    <securityAgent name="NETEGRITY"/>
  </css>

3. To save your changes to the configuration file, select File > Save.

4. The SiteMinder administrator must also configure a "response" that adds a 
custom HTTP header. This HTTP header makes a login name available to 
Hyperion application web resources. The header must include the parameter 
HYPLOGIN, and the value of the login name of the authenticated user.

For example, if you use an LDAP directory and cn is the login name attribute 
in the configuration file, then the HYPLOGIN header should carry the cn value 
of the LDAP authenticated user. SiteMinder administrators can also configure 
the header to SM_USERLOGINNAME, the user ID specified by the user during 
log on.

For more information, see the "Responses and Response Groups" section of 
the Netegrity Policy Design Guide.

5. Because all implementations do not use Web Access Management Solutions 
such as Netegrity SiteMinder, you must edit the Analyzer.jsp and the 
Administrator.jsp files.  Two jsp parameters have been commented out in each 
file, and must be uncommented before SiteMinder can be used. Search for the 
following parameters, remove only the comment marks (<%-- and --%>), and 
save the jsp files.

<%--          <param name = securityAgentToken value ="<%= 
com.hyperion.analyzer.utils.general.HYAURLParamHandler.g
etSecurityAgentTokenParam(request, application) %>"> --%>

<%--          <param name = siteMinderSession value ="<%= 
com.hyperion.analyzer.utils.general.HYAURLParamHandler.g
etSiteMinderSession(request, response) %>"> --%>
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Copying Archives to the Application Server JRE

➤ Copy the following Java Cryptography Extension (JCE) archives from the 
..\hyperion\analyzer\css directory to the application server Java Runtime 
Environment \lib\ext directory:

● jce1_2_2.jar

● local_policy.jar

● sunjce_provider.jar

● US_export_policy.jar

Note: If these files already exist at this location, do not overwrite them.

Restarting the Application Server

➤ To reflect changes to the CssConfig.xml file, stop and restart the application server.

Specifying the Configuration File Location
Because paths for supported application servers vary, you must specify the path to 
the edited CssConfig.xml file.

➤ To specify the CssConfig.xml file path:

1. Launch Hyperion Analyzer Administration Tools.

2. Select Edit > Authentication Services.

The Authentication Services dialog box is displayed. It features a General tab 
and three authentication method tabs.

3. Select the General tab.

Notice that inside the Select Domain Types group that the Analyzer check box 
is selected. Notice also that the checkbox is not selectable. This ensures that 
Analyzer authentication is always available.

The Essbase check box may or may not be selected, depending on your 
implementation.

4. Select the External check box.

This selection enables the External tab.
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5. Select a default domain type by clicking an option button in the Default 
Domain Type group.

● If you want external authentication to serve as the default authentication 
domain, click the External option button in the Default Domain Type 
group. This sets external authentication as the default in the Login dialog 
box. You must also specify the a default authentication server on the 
External tab.

● If you want Analyzer to serve as the default authentication domain, click 
the Analyzer option button.

6. Select the External tab.

7. Click the Set Configuration File button.

The External Authentication dialog box is displayed.

8. Enter the fully qualified path to the edited CssConfig.xml file that you 
copied to the ..\hyperion\analyzer\conf application server directory.

9. Click OK.

The specified path is displayed in the External tab Configuration File field.

10. From the Default Domain Server drop down list box, select an external 
authentication server as the default.

This setting, in conjunction with the Default Domain Type selection on the 
General tab, sets a specific external authentication provider as the default in 
the Login dialog box.

Note: This procedure is completed, but do not close the Authentication Services dialog 
box yet.  Keep it open for the next procedure.

Mapping Groups to User Groups
Externally authenticated users must be mapped to Hyperion Analyzer user groups 
so that Hyperion Analyzer can appropriately control use and access to the 
repository.

➤ To map defined directory server groups to Hyperion Analyzer groups, perform the 
following steps:

1. On the External tab of the Authentication Services dialog box, select an 
external authentication provider from the Group Mappings Server Name drop 
down list box.
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This selection points the Group Mappings table to the external authentication 
providers specified by the CssConfig.xml file.

The directory server groups for the specified provider display on the left side 
of the table.

2. Take one of the following actions:

● Click the Mapped Analyzer Groups cell to the right of a Directory 
Server Groups cell, and select a defined Hyperion Analyzer user group 
from the drop-down list box.

● Right-click the Mapped Analyzer Groups cell to the right of a Directory 
Server Groups cell, and select Map to Group and a defined Hyperion 
Analyzer group.

Your selection is displayed in the Mapped Analyzer Groups cell.

3. Repeat steps 1 and 2 until every directory server group is mapped to a 
Hyperion Analyzer user group.

4. If applicable, click the Group Mappings Server Name drop-down list box, 
select a different external authentication provider, and repeat steps 1 through 
3.

5. When all groups for all external authentication providers have been mapped to 
Hyperion Analyzer user groups, click OK.

Secure Socket Layer
Hyperion Analyzer supports the SSL 3.0 security protocol. The SSL record 
protocol encapsulates other protocols that enable client-server authentication and 
establish encrypted data transfer.
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3

Chapter

3
Administration Tools 
Overview

This chapter discusses the following topics:

● Hyperion Analyzer Administration Tools Interface

● Application Window Title Bar

● Menu Bar

● Navigation Panel

● Management Panel

● Log Panel

● Managing Roles

● Assigning Roles to Users

● Removing Roles from Users

● Assigning Roles to User Groups

Hyperion Analyzer Administration Tools 
Interface

The Administration Tools interface is composed of the following components:

● Application Window Title Bar

● Menu Bar

● Navigation Panel

● Management Panel

● Log Panel
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Application Window Title Bar
The application window contains all interface components.  It features a title bar 
with Minimize, Restore and Close buttons.  The title bar displays the current 
application name and features a right-click menu.

Menu Bar
The Menu bar is directly below the Application Window Title bar.  The menu bar 
organizes and provides access to principal Administration Tools tasks.

Table 1: Administration Tools Menu Bar

Command Sub-menu Description

File

Login/Logout Connects to or disconnects 
from the Hyperion Analyzer 
repository.

Search...

Search Next

Import Imports an aru XML file to 
automate the creation and 
deletion of Hyperion Analyzer 
users, user groups, and 
database connections.

Export Exports Hyperion Analyzer 
users, user groups, and 
database connections to an an 
aru XML file.

New

     User Creates an empty user profile.

     User Group Creates an empty user group 
profile.

     Hyperion Essbase Database
     Connection

Creates a new Essbase 
database connection.
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     Hyperion Financial
     Management Database
      Connection

Creates a new Hyperion 
Financial Management 
Database Connection.

     Relational Database Connection Creates a new relational 
database connection.

Exit Quits the Administration Tools 
applet.

Edit

Authentication Services... Displays the Authentication 
Services dialog box, enabling 
you to specify authentication 
methods and parameters.

Hyperion Hub... Displays the Hyperion Hub 
dialog box, enabling you to 
configure a Hyperion Hub 
server to work with Hyperion 
Analzyer.

Directory Protocol... Displays the Directory 
Protocol dialog box, enabling 
you to register integrated 
Hyperion applications and 
tools with the Hyperion Hub 
server.  Registration of this 
kind supports Related Content 
functionality.

Mail Server Displays the Mail Server 
dialog box, enabling you to 
specify a mail server for 
e-mail functionality.

Help

About Hyperion Analyzer Displays the Hyperion 
Analyzer About dialog box 
that provides licensing and 
verioning information.

Table 1: Administration Tools Menu Bar

Command Sub-menu Description
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Navigation Panel
The navigation panel, on the left side of the Administration Tools interface, 
features and interactive array of folders.  Folders are node trees that organize and 
control the following repository information:

● Users

● Roles

● User Groups

● Database Connections

● Report Groups

➤ To expand and collapse folder node trees, double click the folder icon or name.

➤ To create a new node in a folder, right-click the folder and select New.

➤ To refresh the navigation panel display, right-click a folder and select Refresh.

Nodes

Each folder contains nodes corresponding to repository information. The 
Management panel, to the right, always displays an editing interface for the 
currently selected node.

Contents and Index Displays Hyperion Analyzer 
Administration Tools Online 
Help (this guide).

Hyperion on the Web Opens a Web browser and 
displays the Hyperion Web 
site.

Information Map Displays the Hyperion 
Analyzer Information Map, 
containing links to the entire 
Hyperion Analyzer 
documentation set.

Table 1: Administration Tools Menu Bar

Command Sub-menu Description
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➤ To select a node, click the node name.

➤ To delete a node, right-click the node name and select Delete.

➤ To refresh the navigation panel display, right-click a folder and select Refresh.

User nodes contain two additional options:

➤ To set user preferences for a specific user, right-click the user node and select User 
Preferences.

➤ To copy a user profile, right-click the user node and select Clone User.

Cloning user profiles expedites the process of creating new users with identical 
properties.

Default Nodes

In the Roles folder there are four default roles:

● Administrator

● Information Consumer

● Interactive User

● Power User

For more information, see “Managing Roles” on page 59.

In the User Groups folder there is a default Administrators user group node.

In the User folder there is a default Administrator node.

Note: Hyperion Analyzer is delivered with a defined user ID, Administrator, and 
password, password. If you edit the Administrator user profile, do not forget the 
Administrator password. Loss of the Administrator password prevents administration 
until another user with an Administrator role privileges resets the password.  For more 
information, see “Lockout Recovery” on page 28.

Searching for Nodes
In large implementations, you may find it easier to search for specific nodes, than 
to locate them manually.
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➤ To search for a specific node:

1. Start Hyperion Analyzer Administration Tools.

2. From the Menu bar select File > Search.

The Search dialog box is displayed.

3. Enter a search text string in the Find text box.

4. Select node type checkboxes in the Search for group box.

5. Select a search option from the Option option button group.

6. Click OK.

The search engine locates the first node that satisfies the search criteria, makes 
it the current node and displays the corresponding Management panel. When 
no node fulfills the search criteria, the Search Results message box is 
displayed, saying “No Items Found.”

7. To continue searching using the same search criteria, select File > Search 
Next.

Table 2: Administration Tools Search Dialog Box

Search Criteria Option Description

Find The text string for the search function.

Search for...

User Searches user nodes.

Database Searches database connection nodes.

User Group Searches user group nodes.

Report Group Searches report group nodes.

Option

Whole Searches for the whole member name or 
alias.

Substring Searches for the first, last, or middle 
part of the member, in the order entered 
in the member text box.
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Management Panel
The Management Panel is on the right side of the Administration Tools interface.  
It is context-sensitive to the currently selected node, and features tab groups that 
organize node properties.

Log Panel
The Log Panel, at the bottom of the Administration Tools interface, displays 
client-server communication messages between the Administration Tools client 
and the Hyperion Analyzer Analysis Server.

Managing Roles
Use of Hyperion Analyzer is controlled by Roles. Roles give or withhold 
permission to perform Hyperion Analyzer tasks.

Roles can be assigned to both users and user groups, and the resulting permissions 
are cumulative.  The following conventions indicate the source of the role and its 
permissions:

● Bolded roles have been assiged directly to both the user, and to a user group 
to which it belongs.

● Italicized roles have been assigned indirectly through a user group profile.

● Plain Text roles have been assigned directly to the user profile only.

Permissions

Three kinds of permission can be assigned to a role:

Beginning Searches for the start of the member 
string.

Ending Searches for the end of the member 
string.

Table 2: Administration Tools Search Dialog Box

Search Criteria Option Description
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Object Type Permissions - Object type permissions enable users to manipulate all 
objects of a particualar type:  report, report group, database connection, user, user 
group, or role.  Object type permissions can be assigned independently of one 
another.

Instance Permissions - Instance permissions enable user to manipulate specific 
named objects. Administrators can assign Read, Write, Delete and Create 
permissions to specific report groups for each user, for example.

Interface-based Permissions - Interface-based permissions enable or disable 
Hyperion Analyzer functionality.  Administrators can grant or restrict use of the 
following functionality:

● Analysis Tools

● Calculations

● Cube Navigator

● Custom Report Designer

● Dimension Browser

● Edit Data mode

● Personal Variables

● Point of View

● Restrict Data

● Retrieve Only Top/Bottom

● Save/Save As

● Select Database Connection and Connections User Preferences

● Show Hide Only

● Sorting

● Traffic Lighting

● User Preferences
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Default Roles and Permissions

Hyperion Analyzer is delivered with four predefined roles:

Table 3: Default Roles and Permissions

Role
Permission 
Type Value Permission

Information 
Consumer

Object Reports
Report Groups

Read Only
Read Only

Instance None

Interface-based Custom Report Designer
New
Save/Save As

Disabled

Interactive User

Object Reports
Report Groups
Database Connections

ReadOnly
Read Only
Read Only

Instance User ID-created Read
Write
Delete
Create

Interface-based Custom Report Designer Disabled

Power User

Object Reports
Report Groups
Database Connections

Read
Write
Delete
Create

Instance Power User-created

Interface-based No restrictions

Administrator
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Assigning Roles to Users

➤ To assign a role to a specific user or users:

1. Start the Hyperion Analyzer Administration Tools client.

2. Expand the Roles folder node tree by clicking the plus sign (+).

3. Select a role node.

The Management Panel displays the role’s tab group.

4. Click the Users tab.

The Users tab features an Available and an Assigned panel.

5. Do one of the following actions:

● Click a user name in the Available panel.

● To select multiple users in a series in the Available panel, press shift and 
click the first user name in the series, and the last user name in the series.  
The first user name, the last user name and all user names in between are 
highlighted and selected.

● Press Ctrl and click to select multiple users in the Available panel. Only 
the highlighted user names are selected.

6. Click the right green arrow, to move the selection to the Assigned panel.

7. Click Apply.

Roles have not been assigned until the Apply button is clicked and the Log 
panel confirms success.

Object No restrictions Read
Write
Delete
Create

Instance Administrator-created

Interface-based No restrictions

Table 3: Default Roles and Permissions

Role
Permission 
Type Value Permission
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Removing Roles from Users

➤ To remove a role from a specific user or users:

1. Start the Hyperion Analyzer Administration Tools client.

2. Expand the Roles folder node tree by clicking the plus sign (+).

3. Select a role node.

The Management Panel displays the role’s tab group.

4. Click the Users tab.

The Users tab features an Available and an Assigned panel.

5. Do one of the following actions:

● Click a user name in the Assigned panel.

● To select multiple users in a series in the Assigned panel, press shift and 
click the first user name in the series, and the last user name in the series.  
The first user name, the last user name and all user names in between are 
highlighted and selected.

● Press Ctrl and click to select multiple users in the Assigned panel. Only 
the highlighted user names are selected.

6. Click the left green arrow, to move the selection back to the Available panel.

7. Click Apply.

Roles have not been removed until the Apply button is clicked and the Log 
panel confirms success.

Assigning Roles to User Groups

➤ To assign a role to a user group:

1. Start the Hyperion Analyzer Administration Tools client.

2. Expand the Roles folder node tree by clicking the plus sign (+).

3. Select a role node.

The Management Panel displays the role’s tab group.

4. Click the User Groups tab.

The Users Groups tab features an Available and an Assigned panel.
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5. Do one of the following actions:

● Click a user group name in the Available panel.

● To select multiple user groups in a series in the Available panel, Press 
shift and click the first usergroup name in the series, and the last user 
group name in the series.  The first user group name, the last user group 
name and all user group names in between are highlighted and selected.

● Press Ctrl and click to select multiple user groups in the Available panel. 
Only the highlighted user names are selected.

6. Click the right green arrow, to move the selection to the Assigned panel.

7. Click Apply.

Roles have not been assigned until the Apply button is clicked and the Log 
panel confirms success.
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4

Chapter

4
Managing Users

This chapter discusses the following topics:

● Creating Users

● Editing Users

● Deleting Users

● Assigning Users Roles

● Assigning Users to User Groups

● Assigning Database Connections to Users

● Assigning Report Groups to Users

● Assigning User Preferences to Users

User Profiles

User profiles are created for every Hyperion Analyzer user.  Anyone with 
permission can create user profiles and use them to do the following tasks:

● Transparently process multiple database log ons

● Define groups of users

● Expedite report group distributions

● Coordinate User Preferences

Naming Conventions

Hyperion Analyzer user profiles now support the period (.), the underscore (_) and 
the at sign (@), so that e-mail addresses can be used as user names and user IDs.
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User IDs with spaces ( ) cannot be defined in Hyperion Analyzer, but user IDs 
defined previously in Hyperion Essbase and Hyperion Financial Management that 
have spaces will be recognized by Hyperion Analyzer.

Creating Users
Users with privileges have two options for creating new user profiles with 
Administration Tools:

● Creating New Users from scratch

● Cloning New Users from existing user profiles

User Profile Creation and Authentication

Hyperion Analyzer user profiles are used by the Analyzer authentication method. 
Hyperion Analyzer user profiles are also created from Essbase authentication users 
and externally authentication users, when they first log on to Hyperion Analyzer. 
Roles and permissions for Essbase authenticated and externally authenticated 
users are determined first, by the user groups to which users belong.

Note: Please note that when Essbase authentication and external authentication are 
disabled, or when Essbase authenticated users and externally authenticated users are 
deleted from external repositories, the Hyperion Analyzer user profiles created for these 
users persist. There is no substitute for user management using Administration Tools.

Hyperion Analyzer Batch Import/Export Utility via API Toolkit

The new batch import/export utility enables administrators to import reports, 
report groups, user IDs, point of view definitions and personal variable definitions. 
For more information, see the Hyperion Analyzer API Toolkit Developer’s Guide.

Creating New Users

➤ To create a new user from scratch:

1. Start Hyperion Analyzer Administration Tools

2. Do one of the following tasks:

● Right-click the Users folder and select New User.

● From the Menu bar, select File > New > User.
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An empty user profile is displayed in the Management panel. The General tab 
is displayed by default.

3. Enter the user’s full name in the Name text area.

4. Enter the user ID in the User ID text area.

5. Enter a password in the Password text area.

6. Enter the same password in the Confirm Password text area.

7. Optional: To prompt the user to change their password when they next log on, 
click the corresponding check box.

Administrators have the option of completing additional tasks before clicking 
the Apply button.

● Assigning Users Roles

● Assigning Users to User Groups

● Assigning Database Connections to Users

● Assigning Report Groups to Users

● Assigning User Preferences to Users

8. Click the Apply button.

A user profile has not been created until the Apply button has been clicked and 
the Log panel confirms success.

Cloning New Users

➤ To clone a new user from an existing user:

1. Start Hyperion Analyzer Administration Tools

2. To expand the Users folder node tree, click the Users plus sign (+).

3. Right-click a user node to duplicate and select Clone User.

An empty user profile is displayed in the Management panel. The General tab 
is displayed by default, but the other tabs contain the same properties as the 
selected user node.

4. Enter the user’s full name in the Name text area.

5. Enter the user ID in the User ID text area.

6. Enter a password in the Password text area.
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7. Enter the same password in the Confirm Password text area.

8. Optional: To prompt the user to change their password when they next log on, 
click the corresponding check box.

Administrators have the option of completing additional tasks before clicking 
the Apply button.

● Assigning Users Roles

● Assigning Users to User Groups

● Assigning Database Connections to Users

● Assigning Report Groups to Users

● Assigning User Preferences to Users

9. Click the Apply button.

A user profile has not been created until the Apply button has been clicked and 
the Log panel confirms success.

Editing Users
Users with privileges can change user profiles as needed.

➤ To edit an existing user profile:

1. Start Hyperion Analyzer Administration Tools

2. To expand the Users folder node tree, click the Users plus sign (+).

3. Select a user node.

The user profile is displayed in the Management panel. There are five tabs: 
General, User Groups, Report Groups, Databases, and Roles.

4. Click the General tab to make it current.

5. Enter the user’s full name in the Name text area.

6. Enter the user ID in the User ID text area.

7. Enter a password in the Password text area.

8. Enter the same password in the Confirm Password text area.

9. Optional: To prompt the user to change their password when they next log on, 
click the corresponding check box.



Deleting Users

4

■ 69Hyperion Analyzer Release 7.0 Administrator’s Guide

Administrators have the option of completing additional tasks before clicking 
the Apply button.

● Assigning Users Roles

● Assigning Users to User Groups

● Assigning Database Connections to Users

● Assigning Report Groups to Users

● Assigning User Preferences to Users

10. Click the Apply button.

A user profile has not been created until the Apply button has been clicked and 
the Log panel confirms success.

Deleting Users
Users with privileges can delete user profiles as needed.  After it has been deleted, 
a user profile cannot be recovered.

➤ To delete a user profile:

1. Start Hyperion Analyzer Administration Tools

2. To expand the Users folder node tree, click the Users plus sign (+).

3. Right-click a user node to delete, and select Delete User.

The Delete User dialog box is displayed and requires that you confirm deletion 
of the user profile.

4. Click OK to delete the user profile.

The user profile is deleted and the Log panel reports user ID deletion.

Assigning Users Roles
For more information on roles and role conventions, see “Managing Roles” on 
page 59.
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➤ To assign a role to a user:

1. Expand the Users folder node tree by clicking the plus sign (+).

2. Select a user node.

The Management Panel displays the user’s tab group.

3. Click the Roles tab.

The Roles tab features an Available and an Assigned panel.

4. Do one of the following actions:

● Click a role in the Available panel.

● To select multiple roles in a series in the Available panel, press shift and 
click the first role in the series, and the last role in the series.  The first role, 
the last role and all roles in between are highlighted and selected.

● Press Ctrl and click to select multiple roles in the Available panel. Only 
the highlighted roles are selected.

5. Click the right green arrow, to move the selection to the Assigned panel.

Roles can be assigned to both users and user groups, and the resulting 
permissions are cumulative.  The following conventions indicate the source of 
the role and its permissions:

● Bolded roles have been assiged directly to both the user, and to a user 
group to which it belongs.

● Italicized roles have been assigned indirectly through a user group profile.

● Plain Text roles have been assigned directly to the user profile only.

Note therefore, that to control all access to Hyperion Analyzer both user roles 
and user group roles must be edited.  For more information, see “Assigning 
Roles to User Groups” on page 63.

6. Click Apply.

Roles have not been assigned until the Apply button is clicked and the Log 
panel confirms success.

Assigning Users to User Groups
Users with privileges can assign users to user groups, using both the Users node 
tree and the User Groups node tree.
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➤ To assign user group membership to a user:

1. Expand the Users folder node tree by clicking the plus sign (+).

2. Select a user node.

The Management Panel displays the user’s tab group.

3. Click the User Groups tab.

The User Groups tab features an Available and an Assigned panel.

4. Do one of the following actions:

● Click a user group name in the Available panel.

● To select multiple user group names in a series in the Available panel, 
press shift and click the first user group name in the series, and the last 
user group name in the series.  The first user group name, the last user 
group name and all user group names in between are highlighted and 
selected.

● Press Ctrl and click to select multiple user group names in the Available 
panel. Only the highlighted user group names are selected.

5. Click the right green arrow, to move the selection to the Assigned panel.

6. Click Apply.

User group membership has not been assigned until the Apply button is 
clicked and the Log panel confirms success.

Assigning Database Connections to Users
Users with privileges can assign database connections to users, using both the 
Users node tree and the Databases node tree.

➤ To assign a database connection to a user:

1. Expand the Users folder node tree by clicking the plus sign (+).

2. Select a user node.

The Management Panel displays the user’s tab group.

3. Click the Databases tab.

The Databases tab features an Available and an Assigned panel.
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4. Do one of the following actions:

● Click a database connection name in the Available panel.

● To select multiple database connection names in a series in the Available 
panel, press shift and click the first database connection name in the 
series, and the last database connection name in the series.  The first 
database connection name, the last database connection name and all 
database connection names in between are highlighted and selected.

● Press Ctrl and click to select multiple database connection names in the 
Available panel. Only the highlighted database connection names are 
selected.

5. Click the right green arrow, to move the selection to the Assigned panel.

Administrators have the option of completing additional tasks before clicking 
the Apply button.

6. Optional: To set an alias table for a selected Assigned database connection, 
click the Set Alias button. The Set Alias Table dialog box is displayed, 
prompting the user to select the alias table from the drop down list box and 
click OK.

7. Optional: To specify the login method used when the current user connects to 
the database, perform one of the following tasks:

● Select the Use Analyzer Login option button. This option will attempt to 
connect to the database connection using the user ID and password 
specified on the General tab.

● Select the Prompt for Login option button. This option will prompt the 
user to enter a valid user ID and password, before connecting to the 
database.

● Select the Define Login option button.  This option displays the Login 
Information dialog box, enabling you to enter a valid user ID and 
password for the database connection, if it varies from the Analyzer Login 
parameters.

8. Optional: To change the login parameters used by the Define Login option 
button, click the Change Login button and enter new parameter values.

9. Click Apply.

Database Connections have not been assigned until the Apply button is clicked 
and the Log panel confirms success.
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Assigning Report Groups to Users
Users with privileges can assign report group access to users, using both the Users 
node tree and the Report Groups node tree.  For more information, see .

➤ To define report group access to a user:

1. Expand the Users folder node tree by clicking the plus sign (+).

2. Select a user node.

The Management Panel displays the user’s tab group.

3. Click the Report Groups tab.

The Report Groups tab features an Available and an Assigned panel.

4. Do one of the following actions:

● Click a report group name in the Available panel.

● To select multiple report group names in a series in the Available panel, 
press shift and click the first report group name in the series, and the last 
report group name in the series.  The first report group name, the last 
report group name and all report group names in between are highlighted 
and selected.

● Press Ctrl and click to select multiple report group names in the Available 
panel. Only the highlighted report group names are selected.

5. Optional:  You can set instance permissions for the entire selection by clicking 
one of the option buttons in the Permissions group box: Read, Update, Delete, 
and Owner.

If no option is elected the user receives Read Only access by default. Note that 
previous permission elections stay with each report group as they are moved 
back and forth between the Available and Assigned panels.

6. Click the right green arrow, to move the selection to the Assigned panel.

7. Click Apply.

Report group access is not assigned until the Apply button is clicked and the 
Log panel confirms success.
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Assigning User Preferences to Users
Administrators can customize the Hyperion Analyzer display and behavior using 
user preferences.  These settings are saved as user profile properties, and can be 
customized for each user.  Users can subsequently fine-tune their own user 
preferences using the Hyperion Analyzer Java Web Client.

For a complete description of user preferences, see Appendix D, “User 
Preferences”.

User Preferences and Formatting Options

There are identical formatting options and user preferences. User preferences are 
global settings applied to all new reports. User Preferences, however, can be 
overridden by database connection formatting and report-based formatting.

Order of Formatting Precedence

1. Formatting options saved with reports

2. Formatting options saved with the database connection

3. Formatting options specified in the User Preferences dialog box

Note: Some user preferences may take effect only when reports are reloaded.

Accessing User Preferences

➤ To display the User Preferences dialog box using Administration Tools, right-click 
a user node and select User Preferences.

Editing User Preferences

➤ To edit user preferences, navigate using the navigation panel links and tabs, set 
parameters, click Apply, and then OK.



■ 75Hyperion Analyzer Release 7.0 Administrator’s Guide

5

Chapter

5
Managing User Groups

This chapter discusses the following topics:

● Creating Users Groups

● Editing Users Groups

● Deleting Users Groups

● Assigning Users Groups Roles

● Assigning Users to User Groups

● Assigning Database Connections to Users Groups

● Assigning Report Groups to User Groups

User Group Profiles

User groups are used to manage users collectively.  User groups also expedite the 
distribution and control of Hyperion Analyzer content.

Naming Conventions

Hyperion Analyzer user group profiles now support the period (.), the underscore 
(_) and the at sign (@), so that e-mail addresses can be used as user group names.

Creating Users Groups

➤ To create a new user group:

1. Start Hyperion Analyzer Administration Tools

2. Do one of the following tasks:
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● Right-click the User Groups folder and select New User Group.

● From the Menu bar, select File > New > User Group.

An empty user group profile is displayed in the Management panel. The 
General tab is displayed by default.

3. Enter a user group name in the Name text area.

4. Optional:  Enter a description in the Description text area.

Administrators have the option of completing additional tasks before clicking 
the Apply button.

● Assigning Users to User Groups

● Assigning Report Groups to User Groups

● Assigning Database Connections to Users Groups

● Assigning Users Groups Roles

5. Click the Apply button.

A user group profile has not been created until the Apply button has been 
clicked and the Log panel confirms success.

Editing Users Groups
Users with privileges can change user profiles as needed.

➤ To edit an existing user profile:

1. Start Hyperion Analyzer Administration Tools

2. To expand the User Groups folder node tree, click the User Groups plus sign 
(+).

3. Select a user group node.

The user group profile is displayed in the Management panel. There are five 
tabs: General, Users, Report Groups, Databases, and Roles.

4. Click the General tab to make it current.

5. Enter a new user group name in the Name text area.

Administrators have the option of completing additional tasks before clicking 
the Apply button.
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● Assigning Users to User Groups

● Assigning Report Groups to User Groups

● Assigning Database Connections to Users Groups

● Assigning Users Groups Roles

6. Click the Apply button.

A user group profile has not been created until the Apply button has been 
clicked and the Log panel confirms success.

Deleting Users Groups
Users with privileges can delete user group profiles as needed.  After it has been 
deleted, a user group cannot be recovered.

➤ To delete a user group:

1. Start Hyperion Analyzer Administration Tools

2. To expand the User Groups folder node tree, click the User Groups plus sign 
(+).

3. Right-click a user group node to delete, and select Delete User Group.

The Delete User Group dialog box is displayed and requires that you confirm 
deletion of the user group.

4. Click OK to delete the user group.

The user group is deleted and the Log panel reports user group deletion.

Assigning Users Groups Roles
For more information on roles and role conventions, see “Managing Roles” on 
page 59.

➤ To assign a role to a user group:

1. Expand the User Groups folder node tree by clicking the plus sign (+).

2. Select a user group node.

The Management Panel displays the user group’s tab group.
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3. Click the Roles tab.

The Roles tab features an Available and an Assigned panel.

4. Do one of the following actions:

● Click a role in the Available panel.

● To select multiple roles in a series in the Available panel, press shift and 
click the first role in the series, and the last role in the series.  The first role, 
the last role and all roles in between are highlighted and selected.

● Press Ctrl and click to select multiple roles in the Available panel. Only 
the highlighted roles are selected.

5. Click the right green arrow, to move the selection to the Assigned panel.

Roles can be assigned to both users and user groups, and the resulting 
permissions are cumulative.  The following conventions indicate the source of 
the role and its permissions:

● Bolded roles have been assiged directly to both the user, and to a user 
group to which it belongs.

● Italicized roles have been assigned indirectly through a user group profile.

● Plain Text roles have been assigned directly to the user profile only.

Note therefore, that to control all access to Hyperion Analyzer both user roles 
and user group roles must be edited.  For more information, see “Assigning 
Roles to User Groups” on page 63.

6. Click Apply.

Roles have not been assigned until the Apply button is clicked and the Log 
panel confirms success.

Assigning Users to User Groups
Users with privileges can assign users to user groups, using both the Users node 
tree and the User Groups node tree.

➤ To assign users to a user group:

1. Expand the User Groups folder node tree by clicking the plus sign (+).

2. Select a user group node.



Assigning Database Connections to Users Groups

5

■ 79Hyperion Analyzer Release 7.0 Administrator’s Guide

The Management Panel displays the user group’s tab group.

3. Click the Users tab.

The Users tab features an Available and an Assigned panel.

4. Do one of the following actions:

● Click a user name in the Available panel.

● To select multiple user names in a series in the Available panel, press shift 
and click the first user name in the series, and the last user name in the 
series.  The first user name, the last user name and all user names in 
between are highlighted and selected.

● Press Ctrl and click to select multiple user names in the Available panel. 
Only the highlighted user names are selected.

5. Click the right green arrow, to move the selection to the Assigned panel.

6. Click Apply.

User group membership has not been assigned until the Apply button is 
clicked and the Log panel confirms success.

Assigning Database Connections to Users 
Groups

Users with privileges can assign database connections to user groups, using both 
the User Groups node tree and the Databases node tree.

➤ To assign a database connection to a user group:

1. Expand the User Groups folder node tree by clicking the plus sign (+).

2. Select a user group node.

The Management Panel displays the user group’s tab group.

3. Click the Databases tab.

The Databases tab features an Available and an Assigned panel.

4. Do one of the following actions:

● Click a database connection name in the Available panel.
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● To select multiple database connection names in a series in the Available 
panel, press shift and click the first database connection name in the 
series, and the last database connection name in the series.  The first 
database connection name, the last database connection name and all 
database connection names in between are highlighted and selected.

● Press Ctrl and click to select multiple database connection names in the 
Available panel. Only the highlighted database connection names are 
selected.

5. Click the right green arrow, to move the selection to the Assigned panel.

Because alias tables and user preferences are related, you cannot set alias 
tables for user groups. To enable diverse login methods, user group members 
are prompted to enter a valid user ID and password, before they connecting to 
the database, but alternate login methods can be specified in the user profile.

6. Click Apply.

Database Connections have not been assigned until the Apply button is clicked 
and the Log panel confirms success.

Assigning Report Groups to User Groups
Users with privileges can assign report group access to user groups, using both the 
User Groups node tree and the Report Groups node tree.

➤ To define report group access for a user group:

1. Expand the User Groups folder node tree by clicking the plus sign (+).

2. Select a user group node.

The Management Panel displays the user group’s tab group.

3. Click the Report Groups tab.

The Report Groups tab features an Available and an Assigned panel.

4. Do one of the following actions:

● Click a report group name in the Available panel.
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● To select multiple report group names in a series in the Available panel, 
press shift and click the first report group name in the series, and the last 
report group name in the series.  The first report group name, the last 
report group name and all report group names in between are highlighted 
and selected.

● Press Ctrl and click to select multiple report group names in the Available 
panel. Only the highlighted report group names are selected.

5. Optional:  You can set instance permissions for the entire selection by clicking 
one of the option buttons in the Permissions group box: Read, Update, and 
Delete.

Note: User groups cannot be assigned create privileges, or Owner permisisons.

If no option is elected the user receives Read Only access by default. Note that 
previous permission elections stay with each report group as they are moved 
back and forth between the Available and Assigned panels.

6. Click the right green arrow, to move the selection to the Assigned panel.

7. Click Apply.

Report group access is not assigned until the Apply button is clicked and the 
Log panel confirms success.
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6

Chapter

6
Managing Report Groups

This chapter discusses the following topics:

● Creating Report Groups

● Deleting Report Groups

● Assigning Users Report Group Access

● Assigning User Groups Report Group Access

● Reviewing a list of Reports in a Report Group

Report Groups

Report groups commonly contain reports relating to a single subject or common 
analytical purpose.  Report groups coordinate information, enable specific 
distributions, and enable frequently updated reports to be located easily.  Report 
groups have properties governing their display and use.

Creating Report Groups

➤ To create a new report group:

1. Start Hyperion Analyzer Administration Tools

2. Do one of the following tasks:

● Right-click the Report Groups folder and select New Report Group.

● From the Menu bar, select File > New > Report Group.

An empty report group profile is displayed in the Management panel. The 
General tab is displayed by default. Notice that the General tab is similar to 
the Report Group Properties dialog box in the Java Web Client.
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3. Enter a report group name in the Name text area.

4. Optional:  To hide the report group icon from the desktop, clear the Show on 
Desktop check box, or to display the report group icon on the desktop, select 
the Show on Desktop check box.

5. Optional:  To change the report group icon graphic, click the Select Graphic 
button, navigate to a JPG or GIF file and then click OK.

Note: If no report group icon graphic is specified a generic Hyperion Analyzer 
graphic is used.

Administrators have the option of completing additional tasks before clicking 
the Apply button.

● Assigning Users Report Group Access

● Assigning User Groups Report Group Access

● Reviewing a list of Reports in a Report Group

6. Click the Apply button.

A report group has not been created until the Apply button has been clicked 
and the Log panel confirms success.

Deleting Report Groups
Users with privileges can delete report group as needed.  After deletion, report 
groups cannot be recovered.

➤ To delete a report group:

1. Start Hyperion Analyzer Administration Tools

2. To expand the Report Groups folder node tree, click the Report Groups plus 
sign (+).

3. Right-click a report group node to delete, and select Delete Report Group.

The Delete User Group dialog box is displayed and requires that you confirm 
deletion of the report group.

4. Click OK to delete the report group.

The report group is deleted and the Log panel indicates report group deletion.
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Assigning Users Report Group Access
Users with privileges can grant user four kinds of access to report groups, using 
both the Report Groups node tree and the Users node tree.

➤ To grant a user report group access:

1. Expand the Report Groups folder node tree by clicking the plus sign (+).

2. Select a report group node.

The Management Panel displays the report group’s tab group.

3. Click the Users tab.

The Users tab features an Available and an Assigned panel.

4. Do one of the following actions:

● Click a user name in the Available panel.

● To select multiple user names in a series in the Available panel, press shift 
and click the first user name in the series, and the last user name in the 
series.  The first user name, the last user name and all user names in 
between are highlighted and selected.

● Press Ctrl and click to select multiple user names in the Available panel. 
Only the highlighted user names are selected.

5. Click the right green arrow, to move the selection to the Assigned panel.

6. Click Apply.

User access is not granted until the Apply button is clicked and the Log panel 
confirms success.

Assigning User Groups Report Group Access
Users with privileges can grant user groups three kinds of access to report groups, 
using both the Report Groups node tree and the User Groups node tree.

➤ To grant a user group report group access:

1. Expand the Report Groups folder node tree by clicking the plus sign (+).

2. Select a report group node.

The Management Panel displays the report group’s tab group.
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3. Click the User Groups tab.

The User Groups tab features an Available and an Assigned panel.

4. Do one of the following actions:

● Click a user group name in the Available panel.

● To select multiple user group names in a series in the Available panel, 
press shift and click the first user group name in the series, and the last 
user group name in the series.  The first user group name, the last user 
group name and all user group names in between are highlighted and 
selected.

● Press Ctrl and click to select multiple user group names in the Available 
panel. Only the highlighted user group names are selected.

5. Click the right green arrow, to move the selection to the Assigned panel.

6. Click Apply.

User group membership has not been assigned until the Apply button is 
clicked and the Log panel confirms success.

Reviewing a list of Reports in a Report Group

➤ To review a list of reports in a report group:

1. Expand the Report Groups folder node tree by clicking the plus sign (+).

2. Select a report group node.

The Management Panel displays the report group’s tab group.

3. Click the Reports tab.

The Reports in Report Group panel list the reports in the selected report 
group.
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7

Chapter

7
Managing Database 
Connections

This chapter contains the following information:

● About Database Connections

● Creating a Hyperion Essbase Database Connection in Administration Tools

● About Hyperion Financial Management Database Connections

● Creating a Hyperion Financial Mangement Database Connection in 
Administration Tools

● About Relational Access

● About Relational Database Connections

● Creating Relational Database Connections

● Assigning Database Connections to Users

● Assigning Database Connections to Users Groups

● Integrating OLAP and Relational Data

● Creating Relational Drill-Through

● About Measures Formatting

● Creating Measures Formatting Definitions

● About Alias Tables

● Setting Alias Tables

About Database Connections
Servers typically use the server name, application name, and database name in the 
creation of a unique identifiers. The nature of these components makes database 
references less portable.
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Hyperion Analyzer uses user-friendly database aliases instead of long identifiers. 
In addition to being easier to remember and more economical to employ, database 
connection names enable the database to be maintained on multiple servers.

Users can manage their own database connections with the Hyperion Analyzer 
Java Web Client and the Administration Tools Client. While the Java Web Client 
enables users to create, edit, and delete their own database connections, the 
Administration Tools Client enables management of all database connections.

Hyperion Analyzer provides several easy-to-use interfaces for creating and 
managing database connections.

The database connection name of a report is always displayed in the Java Web 
Client Information panel.

The Information panel features two database connection segments:

● The Information panel Database segment displays the database name for the 
current report.

● The Database User Name segment displays the user ID by which access to the 
database has been gained. Access is set by means of the database connection.

Three Kinds of Database Connections

Hyperion Analyzer enables you to create database connections to Essbase, 
Hyperion Financial Management, and relational databases.  Each of these data 
sources has specific requirements and features.

Personal and Global Database Connections

Hyperion Analyzer users can connect to databases with connections they 
personally created or connections to which they have access that were created by 
the administrator.

Users can always set and edit database connection properties for their own 
database connections, but they cannot reconfigure the properties for database 
connections created for groups of users.

About Database Connection Properties

OLAP database connections feature properties that customize and control use of 
database connections:

● User-friendly naming
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● Integrating OLAP and Relational Data

● About Measures Formatting

● About Alias Tables

Users can configure, edit, remove, and override database connections and database 
connection properties on a report-by-report basis.

Java Web Client users can always set and edit database connection properties for 
their own database connections, but they cannot reconfigure the properties for 
database connections created for groups of users by an Administrator.

In the Java Web Client, a disabled Database Connection Properties dialog box tab 
indicates that the database connection is global in nature. Users must recreate it as 
a personal database connection to set different database connection properties.

Users creating reports to be shared with others should use global database 
connections. Other users cannot display the report without logging on to the 
personal database connection data source.

Note: If you change the Server Name, Application Name, or Database Name 
parameter values on the Database Connection Properties General tab, you cannot load 
reports created using different parameter values. A better practice is to create a new 
database connection with the desired parameter values.

Controlling the Result Set

For more information on controlling the size of the query result set, see the 
Hyperion Analyzer Administrator’s Guide, Configuration Options, 
Analyzer.properties File.

Creating a Hyperion Essbase Database 
Connection in Administration Tools

Users must have a valid Essbase user ID and password and be authorized to 
configure database connections.

Configuring a new Essbase database connection requires the user to select Essbase 
as the database, log on Essbase, and then select an existing application database.
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➤ To configure an Essbase database connection:

1. Start Hyperion Analyzer Administration Tools.

2. Take one of the following actions:

● On the Menu bar, select File > New > Hyperion Essbase Database 
Connection.

● Right-click the Databases folder node tree and select New > Hyperion 
Essbase Database Connection.

● Click the Add New button on the Connections User Preferences panel. 
When the Select Database Type dialog box is displayed, select Essbase, 
and Click OK.

The Hyperion Essbase Login box is displayed.

3. Enter a valid Essbase server name, user ID and password, and Click OK.

The List Databases dialog box is displayed.

4. Select an enabled database from the list and click the green selection arrow.

5. Click OK.

In the Navigation panel, the new Essbase database connection is displayed as 
a node in the Databases folder node tree. A default name is assigned.

6. Optional: Click the General tab, and enter a user-friendly name in the 
Database Connection Name text area.

7. Click the Apply button.

The database connection name has not been changed until the Apply button is 
clicked and the Log panel confirms success.

Administrators have the option of completing these additional tasks:

● Assigning Database Connections to Users

● Assigning Database Connections to Users Groups

● Creating Relational Drill-Through

● Creating Measures Formatting Definitions

● Setting Alias Tables
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About Hyperion Financial Management 
Database Connections

Before you can use Hyperion Financial Management as a data source, you must 
install the Hyperion Financial Management client on the Hyperion Analyzer 
Analysis Server using the following procedures:

● Installing the Hyperion Financial Management Client on the Hyperion 
Analyzer Analysis Server

● Verifying DCOM Settings on the Client

Installing the Hyperion Financial Management Client on 
the Hyperion Analyzer Analysis Server

➤ To install Hyperion Financial Management on the client tier:

1. Take one of the following actions:

● If you have a Hyperion Financial Management CD, insert the CD into 
your CD-ROM drive.

● If you downloaded the Hyperion Financial Management software from 
the Download Center, navigate to the directory where you downloaded the 
installation program.

2. Select File > Run or Start > Run, then type the following command:

Drive\folder\ SETUP.EXE.

3. From the Welcome to Hyperion Financial Management dialog box, click 
Next.

4. From the Select a Setup Procedure dialog box, click Client.

5. If you are installing Hyperion Financial Management for the first time, the 
system prompts you to select a destination folder and a program folder:

a. Select a destination folder, then click Next.

b. Select a program folder, then click Next.

6. Review the current settings for components to be installed, then click Next to 
continue the installation or click Back to change any settings.

7. If prompted, select whether to restart your computer at this time, then click 
Finish to complete the setup.



92 ■

Managing Database Connections

Hyperion Analyzer Release 7.0 Administrator’s Guide

Verifying DCOM Settings on the Client
After you set up the client workstation, you must verify the DCOM settings.

➤ To verify the DCOM settings:

1. From the Microsoft Windows Desktop, select Start > Run.

2. In the Open text box, type dcomcnfg.exe.

3. Select the Default Properties tab.

4. Select the Enable Distributed COM on This Computer check box if it not 
already selected.

Note: Hyperion Financial Management ignores the other settings on the Default 
Properties tab.

5. If it is not already set, set the Default Authentication Level to None.

6. If you changed the Default Authentication Level, reboot your computer.

Verifying Communications between the Application Server 
and Client

After you set up the application server and the client workstation, you must make 
sure that communications between the server and client are working properly:

● Make sure that the user logged on to the application server has administrative 
rights to the Microsoft Windows server.

● Check the Distributed Component Object Model (DCOM) configuration on 
both the application server and the client workstation. The complete DCOM 
configuration must be set on the application server. The Default 
Authentication Level must be set to None on the client workstation. After you 
configure DCOM, you must reboot the computers for the settings to take 
effect. For instructions, see "Configuring DCOM Security" in the Hyperion 
Financial Management Administrator’s Guide.

● To confirm communications between the application server and client, you 
must register the application server at the client workstation. For instructions, 
see the steps for registering a server in "Creating a Test Application on the 
Desktop" in the Hyperion Financial Management User’s Guide
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Restart the Hyperion Analyzer Analysis Server

After installing the Hyperion Financial Management client, restart the Hyperion 
Analyzer Analysis Server to expedite the initialization of ADM components.

Microsoft Windows NT Authentication

CAUTION: If you are using Microsoft Windows NT Server with Hyperion 
Financial Management on the Web, you must format Windows using NTFS. 
For more information on the Windows NTFS configuration, see your system 
administrator.

Creating a Hyperion Financial Mangement 
Database Connection in Administration Tools

Users must have a valid Hyperion Financial Management user ID and password, 
and be authorized to configure database connections.

➤ To configure a Hyperion Financial Management database connection:

1. Start Hyperion Analyzer Administration Tools.

2. Take one of the following actions:

● On the Menu bar, select File > New > Hyperion Financial Management 
Database Connection.

● Right-click the Databases folder node tree and select New > Hyperion 
Financial Management Database Connection.

● Click the Add New button on the Connections User Preferences panel. 
When the Select Database Type dialog box is displayed, select Hyperion 
Financial Management, and Click OK.

The Hyperion Financial Management Login dialog box is displayed.

3. Enter a valid Hyperion Financial Management server name, user ID and 
password and Click OK.

The List Applications dialog box is displayed.

4. Select an enabled database from the list and click the green selection arrow.
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5. Click OK.

In the Navigation panel, the new Hyperion Financial Management database 
connection is displayed as a node in the Databases folder node tree. A default 
name is assigned.

6. Optional: Click the General tab, and enter a user-friendly name in the 
Database Connection Name text area.

7. Click the Apply button.

The database connection name has not been changed until the Apply button is 
clicked and the Log panel confirms success.

Administrators have the option of completing these additional tasks:

● Assigning Database Connections to Users

● Assigning Database Connections to Users Groups

● Creating Relational Drill-Through

● Creating Measures Formatting Definitions

About Relational Access
Hyperion Analyzer can access both OLAP and supported relational databases. 
There are five methods for accessing relational data from the Hyperion Analyzer 
client:

Custom Report SQL Spreadsheet 

SQL Spreadsheet objects represent relational data sources as a spreadsheet, using 
standard SQL syntax queries.

Relational Drill-through

Hyperion Analyzer users can construct seamless liaisons between OLAP data and 
relational data sources. This navigation from OLAP to relational data is typically 
called "relational drill-through." After being configured, users can navigate from 
the dimension bottom (level 0) of the OLAP database and drill down to specified 
relational data.
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Hyperion Analyzer stores relational drill-through definitions as database 
connection properties of an Essbase database connection. Users can define their 
own Select statements and clauses as part of the drill-through definition. The query 
result set is presented in the format of the SQL Spreadsheet described above.

Defining a Relational Database Connection

Hyperion Analyzer provides users with an easy-to-use graphical interface for 
defining Relational Database Connections. Users are prompted to specify a 
relational database type and login credentials, select a relational table, and define 
the properties of the database connection and cube.

Hyperion Analyzer clients query the specified relational data source, aggregate the 
result set, and express data in the format of an OLAP cube.

EIS Drill-through

EIS Drill-through is a server-based form of relational drill-through. Like 
conventional relational drill-through, users can construct seamless liaisons 
between OLAP data and relational data sources. Unlike conventional relational 
drill-through, users can drill to the relational report from any intersection in the 
Hyperion Analyzer report.

Your Essbase Administrator must establish EIS drill-through reports. The 
relational query is stored as Intersection specific meta data, and flagged with a 
Linked Reporting Object indicator. When users double-click flagged cells, the 
OLAP report navigates to the specified relational report.

Hyperion Analyzer Repository

Access to the Hyperion Analyzer repository is the only mandatory form of 
relational database access. The repository centrally stores Hyperion Analyzer 
system data, user IDs, user preferences, and report definitions in relational 
database tables. Without access to the repository, you cannot save any form of 
Hyperion Analyzer information. Hyperion Analyzer System Administrators 
establishes access to the Hyperion Analyzer repository during installation.
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System Requirements

System Requirements vary for relational access methods, and the user and system 
administrator must establish and configure supported RDBMS. See the Hyperion 
Analyzer Installation Guide for a complete description of relational system 
requirements.

Controlling the Size of the Query Result Set

Query governors vary for relational access methods.

Custom report SQL spreadsheets and relational drill-through methods enable users 
to declare query governors in the course of creating the SQL query or relational 
drill-through definition.

When you drill from OLAP to relational data, passing only the drilled OLAP 
dimension member to the relational data source may result in a large query result 
set. To focus and diminish the query result set, users have the option of passing the 
page dimensions and filter dimensions specified in the OLAP report.

Other relational access methods rely on the Analyzer.properties File to limit the 
query result set.

For more information on controlling the size of the query result set, see the 
Hyperion Analyzer Administrator’s Guide, Configuration Options, 
Analyzer.properties File.

About Relational Database Connections
This section contains the following information:

● Installing and Configuring JDBC Drivers

● Retrieving Relational Tables

● Defining the Relational Cube

● Creating Relational Database Connections
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Installing and Configuring JDBC Drivers
The first Relational Database Connection Wizard panel, Configure JDBC Drivers, 
requires that the user specify a supported relational database, edit the database 
connection string, and provide database login credentials.

Table 1: Configure JDBC Driver Dialog Box

Text box or Control Description

Driver Type Selects one of the supported relational databases:

• IBM DB2 7.2 Personal Edition

• IBM DB2 7.2 fp7 and 8.1 fp2 Workgroup and 
Enterprise Edition

• Microsoft SQL Server 2000 sp3

• Oracle 8.1.7 and 9.2.1

• Teradata 4.1

JDBC Driver The Java Database Connectivity Driver for the 
selected relational database is automatically 
displayed in this text box.

Database Connection String A sample database connection string syntax is 
provided in this text box. Users must edit the 
string so that it specifies their RDBMS computer 
name and database name.

JDBC Username Indicate a valid user name for the relational 
database. Important! Hyperion Analyzer requires 
this text box to be populated. Users cannot create a 
relational database connection without specifying 
a user name and password.

JDBC Password Indicate a valid password for the user name. 
Important! Hyperion Analyzer requires this text 
box to be populated. Users cannot create a 
relational database connection without specifying 
a user name and password.

Test Connection Click this button to test the relational connection 
before proceeding. If the connection is successful 
a message box reading "Connection Succeeded" is 
displayed.
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Important Notes on JDBC Drivers

The JDBC driver connects the application server hosting Hyperion Analyzer and 
the relational database, not the client computer. Users must ensure that the 
application server is able to connect.

Hyperion Analyzer currently supplies all the drivers that Hyperion supports.

IBM DB2 is release specific. Hyperion provides the JDBC driver for IBM DB2 7. 
The DB2java.zip client drivers must match the DB2java.zip archive on the IBM 
DB2 database server. Caution: Be extremely careful when copying files from the 
RDBMS server to the Hyperion Analyzer install directory! There are extreme 
consequences if you overwrite the application server local DB2 files used to access 
configuration information.

The Teradata 4.1 Connection string features four bracketed JDBC connection 
string parameters. Brackets and parameter names must be replaced with valid 
values.

JDBC driver archives must be explicitly referenced by file name within the 
classpath of the  webapp application server.

Users cannot create a relational database connection without specifying the user 
name and password used to validate access.

Table 2: Connection String Parameters

Parameters Description

{host-name} Server domain name

{port} TCPIP port number

{DSN} Data source name

{database name} A specific database name
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Retrieving Relational Tables

Defining the Relational Cube
The third Relational Database Connection Wizard panel, Relational Cube Editor, 
diagrams the relational cube as a node tree.

The second relational database connection wizard panel, Select Fact Table, 
provides filters for locating a fact table by schema and finally table name.

Table 3: Select Fact Table Dialog Box

Text box or Control Description

Select Table group box

Schema Filter The Schema filter prompts the user to select a 
schema type from the corresponding drop-down 
list box, to narrow the list of relational tables.

Table Type Filter The Table Type filter prompts the user to select a 
table filter from the corresponding drop-down list 
box, to narrow the list of relational tables.

Retrieve Table List Button This button retrieves the list of relational tables.

Table 4: Relational Cube Editor Dialog Box

Default Node Right-Click Menu Description

Relational Cube

Rename Cube Right-click the Relational Cube node 
and select Rename Cube to specify the 
relational database connection name.

Dimensions

Add Dimension Right-click the Dimensions node and 
select Add Dimension to create a new 
dimension.

Defined 
Dimension
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Add Generation Right-click a defined dimension node 
and select Add Generation to specify a 
relational columns as a dimension 
generation.

Rename Dimension Right-click a defined dimension node 
and select Rename Dimension to 
specify a new name for the dimension.

Delete Dimension Right-click a defined dimension node 
and select Delete Dimension to remove 
the dimension from the node hierarchy.

Preview Right-click a defined dimension node 
and select Preview to display a node tree 
of the selected dimension hierarchy.

Defined 
Generation

Edit Generation Right-click a defined generation node 
and select Edit Generation to change 
properties for that generation.

Rename Generation Right-click a defined generation node 
and select Rename Generation to 
specify a new name for that generation.

Delete Generation Right-click a defined generation node 
and select Delete Generation to remove 
that generation from the node hierarchy.

Move Up Right-click a defined generation node 
and select Move Up to move that 
generation up in the node hierarchy.

Move Down Right-click a defined generation node 
and select Move Down to move that 
generation down in the node hierarchy.

Preview Right-click a defined generation node 
and select Preview to display a node tree 
of the selected dimension hierarchy.

Table 4: Relational Cube Editor Dialog Box

Default Node Right-Click Menu Description
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Important Notes on Relational Table Properties

To protect existing open reports and to expedite network traffic and server 
resources, there is only one cached JDBC connection per user per relational 
database connection. Therefore your edits to relational database connections do 
not take effect until you log off Hyperion Analyzer and log back on.

Measures

Edit Measures Right-click the Measures node and 
select Edit Measures to specify columns 
as measures.

Rename Right-click the Measures node and 
select Rename to specify a different 
name for the measures dimension.

Preview Right-click a defined measures node 
and select Preview to display a node tree 
of the selected dimension hierarchy.

Defined Measure

Rename Member Right-click a defined measure and select 
Rename Member to specify a new name 
for the measure.

Delete Measure Right-click a defined measure and select 
Delete Measure to remove the measure 
from the node hierarchy.

Preview Right-click a defined measures node 
and select Preview to display a node tree 
of the selected dimension hierarchy.

Properties Displays the properties of the currently 
selected node.

Table 4: Relational Cube Editor Dialog Box

Default Node Right-Click Menu Description
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Creating Relational Database Connections

➤ To create a relational database connection:

1. Start Hyperion Analyzer Administration Tools.

2. Take one of the following actions:

● On the Menu bar, select File > New > Relational Database Connection.

● Right-click the Databases folder node tree and select New > Relational 
Database Connection.

● Click the Add New button on the Connections User Preferences panel. 
When the Select Database Type dialog box is displayed, select 
Relational, and Click OK.

The Configure JDBC Driver dialog box is displayed.  Hyperion Analyzer 
supports relational database connectivity for four JDBC Drivers.  If you 
require alternate relational connectivity methods, see “About Relational 
Access” on page 94.

3. Select one of the following supported JDBC drivers from the Driver Type 
drop-down list.

● IBM DB2

● Microsoft SQL Server

● Oracle

● Teradata

Your JDBC driver selection populates the Database Connection String text 
area with a relational database connection string.

4. Replace bracketed variables in the string with valid values.

Depending on the driver type, there are variables for host name, database 
name, port, and DSN.  You must replace both the brackets and the variable.

5. Enter a valid JDBC user name in the JDBC Username text box.

6. Enter a valid password for the user name in the JDBC Password text box.

7. Click the Test Connection button to verify relational database connectivity.

If the connection fails, repeat steps 2 through 6 until you can establish a 
succesful relational database connectivity.  Be sure you have removed the 
brackets from the string variables.
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8. When you have a successful relational connection, close the Test Connection 
message and click OK to proceed to the next wizard dialog box.

The Select Fact Table dialog box requires you to select a relational fact table 
from a list. Schema filters and table type filters are available to narrow long 
lists of tables.

Note: Before you can use a schema filter, it must be mapped to the RDBMS 
database username used to log on to the database. This username is specified on 
the previous wizard dialog box, Configure JDBC Drivers.

9. Select a schema from the Schema Filter drop down list.

10. Select a table type from the Table Type Filter drop down list.

11. Click the Retrieve Table List button to query the relational database for 
tables meeting filter requirements, and display the result set in the panel.

Clicking the Retrieve Table List button, 

An understanding of the relational database is required to select the fact table.  
You may need to ask the relational database administrator to identify the fact 
table.  The fact table must contain at least one column of numeric data that can 
be used as a measures dimension.

12. Select a table to be used as the fact table from the table result set, and click 
OK.

The Relational Cube Editor dialog box diagrams the relational cube as a 
node tree in the same manner that the Dimension Browser presents OLAP 
cubes. Properties of the selected node display in the Properties panel at the 
bottom of the dialog box. Click to select a node. Double-click to expand and 
collapse nodes. Right-click to edit dimensions and measures.

13. Right-click the Measures node and select Edit Measures.

The Measure Editor dialog box is displayed. It enables you to define 
relational columns as measures by moving them from the Available Columns 
list panel to the Measures Members list panel.  In this dialog box you can also 
rename the measures dimension, specify the default dimension, add measures 
to the cube, and specify aggregation methods for measures dimensions.

14. Select a column from the Available Columns list panel that has a numeric 
data type, and then click the right arrow (>) button to move the column to the 
Measure Members list panel.



104 ■

Managing Database Connections

Hyperion Analyzer Release 7.0 Administrator’s Guide

Note that the selected measure has been designated as the default measure 
dimensions.

15. Optional:  When there is more than one measure in the Measure Members 
list panel, you can specify the measure to be used as the default measure, by 
clicking an option button in the Default column.

16. Optional:  To change the name of the measure, click the Member Name text 
area, and type a new name. Member names must be unique to each other and 
the name of the measures dimension for SQL parsing to be successful.

17. Optional: To indicate a different aggregation method for a member, click the 
Aggregation Type text area and select from the following fixed aggregation 
methods.  When no aggregation type is specified Sum is used by default:

● Sum

● Count

● Min

● Max

● Avg

18. When you have specified all the fact table columns to use as measures, click 
OK.

The Relational Cube Editor is displayed. Note that the Measures node can 
be expanded to display the new measures dimension you defined.

19. Right-click the Dimensions node and select Add Dimension.

The New Dimension Name dialog box is displayed.

20. Enter a name for the dimension you would like to define, and click OK.

The Generation Editor dialog box is displayed. It enables you to define an 
OLAP generation for the dimension, to name the generation, to indicate the ID 
and alias tables used for return values, and to relate the dimension back to the 
fact table.

21. Enter a name for this generation of the dimension hierarchy in the Generation 
Name text box.

Note that the Select Member ID and Description Columns group box 
displays the fact table by default.

22. To narrow the list of tables available for selection, select a filter from the Table 
Type drop-down list.
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23. Select a table from the Table drop-down list.

24. Indicate the column to be used for ID aliases in the top Column drop-down 
list.

25. Indicate the column to be used for Descriptions aliases in the bottom Column 
drop-down list.

By identifying columns that tables have in common, you relate the defined 
dimension generation back to the fact table. Typically, several sets of common 
columns are used to identify a circuitous path back to the fact table.

You may need to ask the relational database administrator for a description of 
relational tables and their columns to discern tables that have common 
columns.

Start by identifying tables that have columns in common with the table you 
specified for your dimension generation. Then find tables that have columns 
in common with the fact table. Determine if any tables that have common 
columns with the dimension generation also share common columns with the 
fact table.  If they do, then your relationship is mapped.  If not, you must 
continue comparing columns until you can map a bridge between the 
dimension generation and the fact table.

Note that the Define Fact Table Mappings group box displays the dimension 
you just defined and the fact table by default. Unless they share a common 
column, you must select a Table Type filter, a table, and the same column as 
the dimension generation.  If they do share a common column, you need only 
indicate that column in the Column drop down list at right.

When a table and column are selected on the right, a new line is added to the 
Define Fact Table Mappings group box below until the dimension 
generation and fact table relationship is mapped.

Keep the following considerations in mind as you make your selections.

● Question marks (?) indicate unspecified columns.

● Left and right Column drop-down lists must display common columns.

● Each Define Fact Table Mappings line should display different column 
sets than the line above.

● To improve performance, specify as few column sets as is possible.
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26. In the Define Fact Table Mappings group box, select a table from the Table 
drop down list at right that has the same column as the Column drop down list 
on the left.

The specified table and column display on a line below.

27. Select the same Column drop-down list on the right as is specified in the 
Column drop-down list on the left.

28. Repeat steps 26 and 27 until you have mapped a relationship between the 
dimension generation and the fact table, then click OK.

The Relational Cube Editor is the current dialog box again. Note that the 
Dimension generation and Measures nodes can be expanded, by clicking the 
plus sign (+), to display the relational cube structure.

29. Optional:  To add generations to the same dimension, right-click the 
dimension name and select Add Generation. The Generation Editor is 
displayed again. Repeat steps 21-28.

30. Optional:  To reorder the generations in the dimension hierarchy, right-click 
a generation name and select Move Up or Move Down. The generation node 
moves in the specified direction in the dimension hierarchy.

31. Optional:  To add dimensions to the same relational cube, right-click the 
Dimensions node and select Add Dimension. Repeat steps 19-28.

32. When all measures, dimensions, and generations have been defined and 
ordered, click the Relational Cube Editor OK button.

The Administration Tools Navigation panel is displayed with the relational 
database connection node. Note that the Mangement panel General tab 
features three buttons.

The Modify JDBC Connection button enables you to completely redefine the 
relational database connection, beginning with the Configure JDBC Driver 
dialog box.

The Modify Fact Table button enables you to select a new fact table and define 
a new relational cube using the current JDBC connection string.

The Modify Cube button enables you to redefine the relational measures and 
dimensions for the current JDBC connection string and selected fact table. The 
Relational Cube Editor also enables you to rename the relational cube.
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Assigning Database Connections to Users
Users with privileges can assign database connections to users, using both the 
Users node tree and the Databases node tree.

➤ To assign a database connection to a user:

1. Expand the Databases folder node tree by clicking the plus sign (+).

2. Select a database connection node.

The Management Panel displays the tab group of the database connection.

3. Click the Users tab.

The Users tab features an Available and an Assigned panel.

4. Do one of the following actions:

● Click a user name in the Available panel.

● To select multiple user names in a series in the Available panel, press shift 
and click the first user name in the series, and the last user name in the 
series.  The first user name, the last user name and all user names in 
between are highlighted and selected.

● Press Ctrl and click to select multiple user names in the Available panel. 
Only the highlighted user names are selected.

5. Click the right green arrow, to move the selection to the Assigned panel.

Administrators have the option of completing additional tasks before clicking 
the Apply button.

6. Optional: To set an alias table for a selected Assigned database connection, 
click the Set Alias button. The Set Alias Table dialog box is displayed, 
prompting the user to select the alias table from the drop down list box and 
click OK.

7. Optional: To specify the login method used when the current user connects to 
the database, perform one of the following tasks:

● Select the Use Analyzer Login option button. This option will attempt to 
connect to the database connection using the user ID and password 
specified on the General tab.
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● Select the Prompt for Login option button. This option will prompt the 
user to enter a valid user ID and password, before connecting to the 
database.

● Select the Define Login option button.  This option displays the Login 
Information dialog box, enabling you to enter a valid user ID and 
password for the database connection, if it varies from the Analyzer Login 
parameters.

8. Optional: To change the login parameters used by the Define Login option 
button, click the Change Login button and enter new parameter values.

9. Click Apply.

Database Connections have not been assigned until the Apply button is clicked 
and the Log panel confirms success.

Assigning Database Connections to Users 
Groups

Users with privileges can assign database connections to user groups, using both 
the User Groups node tree and the Databases node tree.

➤ To assign a database connection to a user group:

1. Expand the Databases folder node tree by clicking the plus sign (+).

2. Select a database connection node.

The Management Panel displays the tab group of the database connection.

3. Click the User Groups tab.

The User Groups tab features an Available and an Assigned panel.

4. Do one of the following actions:

● Click a user group name in the Available panel.

● To select multiple user group names in a series in the Available panel, 
press shift and click the first user group name in the series, and the last 
user group name in the series.  The first user group name, the last user 
group name and all user group names in between are highlighted and 
selected.



Integrating OLAP and Relational Data

7

■ 109Hyperion Analyzer Release 7.0 Administrator’s Guide

● Press Ctrl and click to select multiple user group names in the Available 
panel. Only the highlighted user group names are selected.

5. Click the right green arrow, to move the selection to the Assigned panel.

Because alias tables and user preferences are related, you cannot set alias 
tables for user groups. To enable diverse login methods, user group members 
are prompted to enter a valid user ID and password, before they connecting to 
the database, but alternate login methods can be specified in the user profile.

6. Click Apply.

Database Connections have not been assigned until the Apply button is clicked 
and the Log panel confirms success.

Integrating OLAP and Relational Data
Because Hyperion Analyzer can access both OLAP and supported relational 
databases, users can construct seamless liaisons between OLAP data and relational 
data sources. This navigation from OLAP to relational data is typically called 
relational drill-through.

Relational drill-through is configured as a database connection property of an 
OLAP database connection.

After relational drill-through is configured, users can navigate from the dimension 
bottom (level 0) of the OLAP database and drill down to specified relational data.

Relational drill-through is a client-based integration solution comparable to the 
server-based Essbase Integration Services (EIS) drill-through.

The Relational Drill-Through dialog box is a graphical user interface for creating 
SQL relational database queries. Users can use complex SQL syntax to specify 
table joins, and select and order by clauses.

Note: In order to support a broad array of JDBC relational data sources, relational 
drill-through does not support queries by levels, generations, or previously selected 
members.

Relational Drill-through Process Overview

Upon accessing the Database Connection Properties dialog box, users complete 
the following tasks in the creation of relational drill-through navigation:
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1. Define a relational database connection.

2. Indicate the relational database table name.

3. Update the Columns list.

4. Map relational columns to dimensions in the OLAP database.

5. Indicate whether to pass filter dimensions or page dimensions and a row limit 
(if any).

6. Click Apply.

For instructions for creating relational drill-through navigation, see “Creating 
Relational Drill-Through” on page 110.

Controlling the Size of the Query Result Set

Query governors vary for relational access methods.

Custom report SQL spreadsheets and relational drill-through methods enable users 
to declare query governors in the course of creating the SQL query or relational 
drill-through definition.

When you drill from OLAP to relational data, passing only the drilled OLAP 
dimension member to the relational data source may result in a large query result 
set. To focus and diminish the query result set, users have the option of passing the 
page dimensions and filter dimensions specified in the OLAP report.

Other relational access methods rely on the Analyzer.properties File to limit the 
query result set.

For more information on controlling the size of the query result set, see the 
Hyperion Analyzer Administrator’s Guide, Configuration Options, 
Analyzer.properties File.

Creating Relational Drill-Through
Users with privileges can create new relational drill-through connections as a 
database connection property of an Essbase or Hyperion Financial Management 
database connection, using the Administration Tools Management panel, or 
Connections User Preferences, Database Connection Properties.

Users must know the name of the relational database table that they intend to 
access before they begin.



Creating Relational Drill-Through

7

■ 111Hyperion Analyzer Release 7.0 Administrator’s Guide

➤ To create a new relational drill-through connection:

1. Start Hyperion Analyzer Administration Tools.

2. Expand the Databases folder node tree by clicking the plus sign (+).

3. Select a database connection node.

The Management Panel displays the tab group of the database connection.

4. Click the General tab.

The General tab features a Relational Drill-through group box.  If no 
drill-through definition is defined an Add button is displayed.  Database 
connections with drill-through definitions feature dynamic Delete and Modify 
buttons.

5. Click the Add button.

The Configure JDBC Driver dialog box is displayed.  Hyperion Analyzer 
supports relational database connectivity for JDBC Drivers.

6. Select one of the following supported JDBC drivers from the Driver Type 
drop-down list.

● IBM DB2

● Microsoft SQL Server

● Oracle

● Teradata

Your JDBC driver selection populates the Database Connection String text 
area with a relational database connection string.

7. Replace bracketed variables in the string with valid values.

Depending on the driver type, there are variables for host name, database 
name, port, and DSN.  You must replace both the brackets and the variable.

8. Enter a valid JDBC user name in the JDBC Username text box.

9. Enter a valid password for the user name in the JDBC Password text box.

10. Click the Test Connection button to verify relational database connectivity.

If the connection fails, repeat steps 6 through 10 until you can establish a 
succesful relational database connectivity.  Be sure you have removed the 
brackets from the string variables.
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11. When you have a successful relational connection, close the Test Connection 
message and click OK to proceed to the Modify Relational Drill-through 
Connection dialog box.

12. Enter a relational database table name in the From text box.

13. Click the Update Columns button.

Column names for the specified table are displayed in the Column Name and 
Related Dimension panel at the bottom of the dialog box.

14. Designate the OLAP dimensions from which you connect to these table 
columns. To do this, you must understand the relationships between OLAP 
and relational data.

15. Click a cell in the Related Dimension column opposite a relational column 
name that you would like to connect to OLAP data.

The clicked cell presents a drop-down list box with the dimension list of the 
OLAP database connection.

16. Click to select an OLAP dimension.

Repeat the process of mapping relational database columns and OLAP 
dimensions until your mappings are complete.

17. Optional:

Take one or more of these additional actions:

● Click the Pass Pages check box to maintain the current OLAP page 
dimensions as you drill into relational data.

● Click the Pass Filters check box to maintain the current OLAP filter 
dimensions as you drill into relational data.

● Set row limits for the query result set in the "Max rows to return" text box. 
This protects server and network resources from being consumed 
unintentionally by very large query result sets.

● Specify SQL Select, Where, and Order By clauses in the corresponding 
text boxes to narrow the relational query result set.

18. Click OK.
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About Measures Formatting
The General tab of a database connection profile contains a Formatting group box 
with a Format button that enables you to globally format one dimension used by 
an OLAP database connection. This global formatting, called measures 
formatting, includes leading and trailing characters, numeric formatting of 
numeric dimension values, and header and data formatting.

Measures formatting options differ from those of data formatting and Default 
Formatting user preferences. The scope of the formatting depends on the source of 
the formatting definition.

Creating Measures Formatting Definitions
Database connection properties can be accessed in both the Hyperion Analyzer 
Java Web Client and the Hyperion Analyzer Administration Tools client.  Database 
connection properties can be set using the Management panel of a database 
connection node, or through Connections User Preferences.

➤ To set dimension member metadata formatting on a database connection:

1. Start Hyperion Analyzer Administration Tools.

2. Expand the Databases folder node tree by clicking the plus sign (+).

3. Select a database connection node.

The Management Panel displays the tab group of the database connection.

4. Click the General tab.

The General tab features a Formatting group box.

5. Select the Format button.

The Formatting dialog box is displayed.

6. Select a dimension from the list panel.

7. Click the Format button.

The Measures Formatting dialog box is displayed.

8. Select the dimension members to which measures formatting is applied.

● To expand the tree view panel to the left, click the plus sign.

● To make explicit member selections, select member names.
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● To select multiple members, press the Ctrl Key and select member names.

● To select a series of members Press the Shirt Key and select the first and 
last members of the series.

● To select all displayed members Press Ctrl+A and select a member.

● To make dynamic member selections Use the Advanced Member 
Selection drop-down list box.

9. Set measures formatting options.

10. Click the Apply Formatting to Member(s) button.

Measures Formatting Dialog Box

Table 5: Measures Formatting Options Overview

Display Data Options Description

Leading and Trailing Sets the representation of negative data values.

Currency Symbol Inserts the following currency formatting symbols 
into the Positive Prefix and Negative Prefix text 
boxes: Dollar ($), Cents (¢), Pound (£), Euro(E), 
Deutschmark (DM), Franc (F), and Yen (¥).

Positive Prefix Enter data to be added before positive values.

Positive Suffix Enter data to be added after positive values.

Negative Prefix Enter character to precede negative numeric values. 
Caution: The minus sign (-) is the default prefix. 
Deleting the default prefix without replacing it causes 
negative values to be displayed positively.

Negative Suffix Enter data to be added after negative values.

Numeric Formatting

Grouped Thousands check 
box

Groups numeric digits in thousands.

Minimum Decimals: Sets the minimum number of digits used to display 
data.

Maximum Decimals: Sets the maximum number of digits used to display 
data.



About Alias Tables

7

■ 115Hyperion Analyzer Release 7.0 Administrator’s Guide

Creating Dynamic Measures Formatting

Users have the option of defining measures formatting using either an explicit 
member selection or advanced member selection. Using advanced member 
selection makes the measures formatting dynamic. As members are added deleted 
and changed in the database, the formatting maintains itself and does not become 
obsolete.

➤ To create a dynamic measures formatting definition, use the Advanced Member 
Selection drop-down list box.

About Alias Tables
Alias tables are database tables that store aliases, or alternate description labels, for 
dimensions or members.

Only Hyperion Essbase enables administrators to define multiple alias tables. 
Hyperion Analyzer enables you to specify which alias table to use. The alias table 
selection is saved as a database connection property.

Hyperion Analyzer Administrators can specify a default alias table for global 
database connections using Hyperion Analyzer Administration Tools. You can 
specify default alias tables for your personal database connections, using the Set 
Alias Table dialog box.

Advanced Member 
Selection

Drop-down List Box Displays the Advanced Member Selection menu, 
enabling users to define dynamic measures 
formatting.

Header Font Displays the Font Properties dialog box.

Data Font Displays the Font Properties dialog box.

Apply Formatting to 
Member(s)

Applies measures formatting settings to the database 
connection definition.

Remove Formatting from 
Member(s)

Removes measures formatting settings from the 
database connection definition.

Table 5: Measures Formatting Options Overview
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Label Mode

Label mode enables you to select whether a dimension member is listed by ID 
number, description, or both.  Label mode options are data-source-specific, and 
can be set for database connections, specific reports, and specific dimensions.

Although the label mode indicates whether the description or ID number is used, 
it is the database alias table that provides the displayed value.

You can set a default label mode before opening a report by clicking the Set Alias 
Table button on a database connection node Users tab.

You can also set a default label mode before querying the data source using Cube 
Navigator options, and after querying using Data Display options on the Main 
Display panel right-click menu.

You can specify which description label to use in specific dimensions, using 
Dimension Browser and using Data Display options on the Main Display panel 
right-click menu.

Setting Alias Tables

➤ To specify a default alias table for a database connection:

1. Start Hyperion Analyzer Administration Tools.

2. Expand the Databases folder node tree by clicking the plus sign (+).

3. Select a database connection node.

The Management Panel displays the tab group of the database connection.

4. Click the Users tab.

5. Select at least one Assigned user name.

6. Click the Set Alias Table button.

The Set Alias Table dialog box is displayed.

7. Select an alias table from the drop-down list box and Click OK.

Whenever the specified database connection is used, the selected label mode 
is also used. Subsequent label mode selections made in the Cube Navigator or 
the Dimension Browser overwrite these default settings.
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8

Chapter

8
Optimizing Hyperion Analyzer

Hyperion Analyzer Analysis Server Console

Prerequisites for Starting

Before you can start, an administrator must provide you with the uniform resource 
locator (URL) of the Hyperion Analyzer Java Web Client launch page, and your 
computer must satisfy any System Requirements.

Logging On to the Hyperion Analyzer Analysis Server 
Console

➤ To start the Hyperion Analyzer Analysis Server Console:

1. Start a supported Web browser.

2. Select File > Open from the menu.

3. Enter the URL of the Hyperion Analyzer launch page, and press Enter.

4. Click the link launching Hyperion Analzyer Analysis Server Console.

The Hyperion Analyzer Analysis Server Console application window is 
displayed, and then the Login dialog box is displayed.

5. Enter a valid user ID and Password in the Login dialog box.

Note: Hyperion Analyzer is delivered with a defined user ID, Administrator, and 
password, password. If you edit the Administrator user profile, do not forget the 
Administrator password. Loss of the Administrator password prevents 
administration until another user with an Administrator role privileges resets the 
password.
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6. If prompted with a Domain drop down list box, select an authentication 
method.

Analyzer authentication is the default authentication method.  Essbase and 
external authentication may also be available.

7. Click OK.

Analysis Server Console Interface
The Hyperion Analyzer Analysis Server Console interface is composed of two 
panels. The System Status Panel contains statistical fields and controls. The User 
Sessions Panel contains session status information and controls.
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System Status Panel

User Sessions Panel

Table 1: Analysis Server Console System Status Panel

Control Description

Show/Hide (at the far right) Expand or collapse the System Status panel in the 
console interface.

Current User Sessions The number of current sessions.

Disconnect users idle for 
more than n minutes.

Disconnect sessions idel for more than the number 
of minutes (10-1000) specified by the 
corresponding field.

Maximum User Sessions The maximum number of concurrent users since 
the last refresh.

Refresh Statistics Interval Set the time interval for automatic refresh of the 
display.

Submit Applies changes to settings.

Table 2: Analysis Server Console User Sessions Panel

Control Description

Show/Hide (at the far right) Expand or collapse the User Sessions panel in the 
console interface.

Session ID A unique session identifier generated by the 
application server.

User The Hyperion Analyzer user ID.

Client ID The IP address or HTML client sessinos for the 
client application.

Total Requests The number of client requests generated by the 
session.

Average Response The cumulative response time divided by the 
number of requests, in seconds.

Login Time The date and time that the sessino was 
instantiated.

Kill Check box Manually ends the selected session.
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Managing Memory Allocation
Hyperion Analyzer relies on the Java Virtual Machine (JVM) to manage memory 
allocation in conjunction with the operating system.

The JVM monitors increasing and decreasing memory allocation, to determine the 
memory required to satisfy application needs and simultaneously minimize JVM 
requests to the operating system.  As the number of instantiated application objects 
grows and diminishes, the JVM requests that the operating system allocate and 
free memory proportionally.  The JVM may therefore not immediately release 
allocated memory, to maintain the amount typically required by the Hyperion 
Analyzer application.

Kill Message The text message displayed to the client when kill 
is executed.

Submit Applies changes to setttings.

Table 2: Analysis Server Console User Sessions Panel

Control Description
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9

Chapter

9
Configuration and Integration 
Options

This chapter contains the following information:

● Configuring Hyperion Hub

● Registering Hyperion Analyzer with Hyperion Hub

● Analyzer.Properties File

● Editing the Analyzer.properties File

● Configuring Different Java Plug-in Versions

Configuring Hyperion Hub
Hyperion Hub allows for the syncronization of business hierarchies, the storage 
and versioning of these hierarchies and the integration of data across Hyperion’s 
Business Performance Management applications.

To share Hyperion Analyzer content with other Hyperion Analyzer environments, 
you can import and export Hyperion Analyzer Reports and Report Group 
definitions to and from a configured Hyperion Hub server.

➤ To configure Hyperion Analyzer with Hyperion Hub:

1. Start Hyperion Analyzer Administration Tools.

2. From the Menu bar, select Edit > Hyperion Hub.

The Hyperion Hub dialog box is displayed.

3. Enter a server name in the Server Name text box.

4. Specify a port number in the Port text box.

5. Enter a valid Hyperion Hub user name and password in the Login 
Information group box.
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6. Click OK.

Registering Hyperion Analyzer with Hyperion 
Hub

Administrators must register Hyperion applications available to Hyperion 
Analyzer users through the Related Content feature. Hyperion Analyzer can be 
registered through both the Analyzer.Properties File and the Hyperion Hub server, 
but external authentication is required to use Hyperion Hub.

➤ To register Hyperion Analyzer with Hyperion Hub:

1. Start Hyperion Analyzer Administration Tools.

2. From the Menu bar, select Edit > Directory Protocol.

The Directory Protocol dialog box is displayed.

3. Select the Register with Hyperion Hub check box at the bottom left.

4. Optional: Enter a user-friendly name in the Alias text box.

5. Click OK.

Configuring a Mail Server for Hyperion Analyzer

➤ To configure a mail server for Hyperion Analyzer:

1. Start Hyperion Analyzer Administration Tools

2. From the Menu bar, select Edit > Mail Server.

The Mail Server dialog box is displayed.

3. Enter a mail server name in the text box, and click OK.

Analyzer.Properties File
The Analyzer.properties file contains variables controlling Hyperion 
Analyzer functionality.  Administrators must modify the file to support of their 
specific implementations.



Editing the Analyzer.properties File

9

■ 123Hyperion Analyzer Release 7.0 Administrator’s Guide

Those using the Apache Tomcat 4.0.1 application server can find the 
Analyzer.properties file at this location:

C:\Hyperion\analyzer\catalina\webapps\Analyzer7_Server\WEB-INF\
conf

Those using the IBM WebSphere application servers can find the 
Analyzer.properties file at this location:

C:\Hyperion\appserver\hosts\default_host\Analyzer7_Server\Analy
zer6\classes

Editing the Analyzer.properties File
You can edit the Analyzer.properties file for the following purposes:

● Controlling the Result Set

● Updating the License Key Without Reinstalling

● Identifying Integrated Hyperion Applications for Hyperion Analyzer

● Configuring Essbase XTD Deployment Services

● Formatting Data Value Tool Tips

● Resolving Hyperion Essbase Subscriptions in Hyperion Analyzer

● Configuring External Authentication with Hyperion Essbase

● Setting Hyperion Analyzer to Log Queries

● Configuring Microsoft Excel to Support Hyperion Analyzer

Controlling the Result Set
Users and system administrators can set row limits to control the size of both the 
relational and OLAP query result set.  This protects server and network resources 
from being consumed unintentionally by very large query result sets.

The Relational Drill-through dialog box features a Max rows to return field that 
controls the number of rows returned during relational drill-through.

Other OLAP and relational row limits must be set in the Analyzer.properties 
file.  The path to this text file varies by application server configuration.

The Analyzer.properties file contains variables controlling the query result 
set in terms of rows:
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● MaxDataCellLimit controls OLAP database connection query result set size.

● MaxJdbcCellCount controls relational database connection query result set 
size.

They are set by default as follows:

MaxDataCellLimit=50000

MaxJdbcCellCount=50000

➤ To change the upper limit of query result set size:

1. Stop the application server.

2. Edit the variables in a text editor and save your changes.

3. Restart the application server.

Updating the License Key Without Reinstalling
You can update the number of licensed users or transition from evaluation to 
licensed use of Hyperion Analyzer without reinstalling the entire application suite.

Users receive new license keys from Hyperion by contacting customer support.  
For Web-based support, or to see complete information on available support 
options, visit the Hyperion Web site at www.Hyperion.com 

The Analyzer.properties file contains variables controlling licensed use of 
Hyperion Analyzer:

● SingleUser-LicenseKey- Indicates an individual license key.

● LicenseKey- Indicates group license keys.

● LicenseKeyVersion=Analyzer6 - Indicates the Hyperion Analyzer release 
number.

➤ To change the license key information:

1. Stop the application server.

2. Edit the variables in a text editor and save your changes.

3. Restart the application server.



Editing the Analyzer.properties File

9

■ 125Hyperion Analyzer Release 7.0 Administrator’s Guide

Identifying Integrated Hyperion Applications for Hyperion 
Analyzer

Administrators must register Hyperion applications available to Hyperion 
Analyzer users through the Related Content feature. Hyperion applications can be 
registered through both the Analyzer.properties file and the Hyperion Hub 
server, but external authentication is required to use Hyperion Hub.

The Analyzer.properties file contains two variables enabling integrated 
Hyperion applications in Hyperion Analyzer:

● RelatedContent.Server.Name.0=<ServerDisplayName>

● RelatedContent.Server.URL.0=<TargetURL>

ServerDisplayName is the string value that is displayed in the Add Related Content 
dialog box.

TargetURL is the uniform resource locator used to launch the integrated Hyperion 
application.  The TargetURL must be in the following format:

http://<hostname:port>/<webAppURL>?<Application-specific parameters>

The application-specific parameters are defined by individual integrated 
applications.  The following are examples of application-specific parameters:

Hyperion Analyzer

sso_username=
$SSO_USERNAME$&sso_password$SSO_PASSWORD$&sso_token=
$SSO_TOKEN$

Hyperion Reports

sso_username=$SSO_USERNAME$&sso_password=$SSO_PASSWORD$

Hyperion Q&R

sso_token=$SSO_TOKEN$&AUTH_TYPE=secLDAP&APS_NAME=
hipserver3&path=%2f
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Hyperion Central

sso_token=$SSO_TOKEN$&path=%2f

Note: Replacement tags are used within the application-specific parameters so that 
user authentication information can be passed in a consistent way.  Available 
replacement tags are as follows:

● $SSO_USERNAME$

● $SSO_PASSWORD$

● $SSO_TOKEN$

Hyperion Integrated Application Definition Examples
Notice the sequential numbering of definitions using a zero-based index.

RelatedContent.Server.Name.0=Hyperion Analyzer
RelatedContent.Server.URL.0=
http://server1/Analyzer7_Server/DirectoryServlet?sso_username=
$SSO_USERNAME$&sso_password$SSO_PASSWORD$&sso_token=$SSO_TOKEN$
RelatedContent.Server.Name.1=Hyperion Reports
RelatedContent.Server.URL.1=
http://server2:8200/Reports/HRRepositoryXML.jsp?sso_username=
$SSO_USERNAME$&sso_password$SSO_PASSWORD$&sso_token=$SSO_TOKEN$

External Authentication Requirements for Hyperion 
Integrated Applications
Hyperion integrated applications accessed through the Related Content feature 
require external authentication implementation.  In addition, the external 
authentication configuration files must have identical entries for the external 
authentication provider.

In short, all applications must authenticate users using the same configuration file, 
or, in the case of multiple configuration files, the authentication provider entries 
must be identical.

Configuring Essbase XTD Deployment Services
The Analyzer.properties file supports variables enabling Essbase XTD 
Deployment Services.  This service enables access to clustered Essbase server 
configurations.
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A cluster of Essbase servers is a set of servers running on different computers (or 
different CPUs, on multiprocessor systems) that run copies of the same Essbase 
application, a single Essbase server that runs replicas of the same application, or a 
combination of both.

Download and read the Essbase XTD Deployment Services Installation Guide for 
complete information on installing, configuring and using this service.
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Table 1: EDS Variables

Variable Description

UseEES A value of true prompts ADM to use Essbase XTD 
Deployment Services to access Essbase; A value of 
false enables ADM to use the default JNI driver.

EESDriverName Specifies the Essbase XTD Deployment Services 
driver to ADM.  Do not modify this variable from the 
value adm:thin:com.hyperion.ap.ees.EESHssDriver.

EESServerName Specifies the server running Essbase XTD 
Deployment Services.

EESLocale Specifies the locale for Essbase XTD Deployment 
Services.

EESDomain Specifies the domain for Essbase XTD Deployment 
Services.  Do not modify this variable.

EESORBType Specifies the valid ORB type for Essbase XTD 
Deployment Services.  Only TCPIP is supported.

EESPort Specifies the Essbase XTD Deployment Services 
communication port.  Specify a currently unused 
port.
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EESUseConnPool

EESConnPerOp

Specifies the method ADM uses for Essbase XTD 
Deployment Services connection pooling.

A connection pool is a set of login sessions from 
Essbase XTD Deployment Services to an Essbase 
server.  Essbase XTD Deployment Services uses a 
connection pool to process requests for Essbase 
services.  There are three valid combinations of these 
properties:

EESUseConnPool=false  EESConnPerOp is 
ignored.

In this configuration, EES will not use any 
connection pooling.

EESUseConnPool=true  EESConnPerOp=false

Connection pooling is used, and the connection is 
held from the time the cube view is opened until it is 
closed.

EESUseConnPool=true  EESConnPerOp=true

Connection pooling is used, and the connection is 
released immediately after each operation.

EESUseCluster A value of true enables Essbase XTD Deployment 
Services to use available Essbase cluster.

EESUseReportOption This property should be set to true only if you are 
using Microsoft's Java Virtual Machine.

Variable Description
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Note: The username and password used by the ADM-Essbase XTD Deployment 
Services driver must be valid on both the Essbase XTD Deployment Services server 
and the Essbase server.

Note: ChangePassword and SetPassword server actions attempt to modify both 
Essbase XTD Deployment Services and Essbase OLAP server passwords.  To be 
successful, the following properties must be set correctly:  
olap.server.autoChangePassword=true.  Also the administrator user ID specified by the 
EDS_ES_HOME/bin directory (olap.server.admin.name=admin) must be different than 
the user ID being passed by the action.

Note: Two archives installed with Essbase XTD Deployment Services must be defined 
in the Hyperion Analyzer classpath:  ess_es_server.jar and ess_japi.jar.

Note: Hyperion does not recommend implementing Essbase XTD Deployment 
Services in conjunction with AIX platforms.

Formatting Data Value Tool Tips
The Analyzer.properties file contains a variable controlling the format of 
data value tool tips.  Tool tips display as small boxes over data cells when the 
cursor triggers a float over event.

When the variable FormatToolTips=’true’, the tool tip displays the data value 
in scientific notation unformatted to up 1E7.  When the variable 
FormatToolTips=’false’ or is not specified in the Analyzer.properties 
file, the tool tip displays the data value in the same format as the spreadsheet grid.

Resolving Hyperion Essbase Subscriptions in Hyperion 
Analyzer

Administrators can set the Analyzer.properties file variable 
FastResolveEssbaseSubscriptions=true to realize a Hyperion Analyzer 
performance improvement, as long as they are not conducting Hybrid analysis. 
Setting to true indicates use of Essbase pass-thru methods to generate dimension 
member lists fo subscription controls. Since there is no way for Hyperion Analyzer 
to detect Hybrid Analysis the variable is set to false by default.

FastResolveEssbaseSubscriptions=false indicates to use standard 
Essbase resolve member methods to generate a dimension member lists for 
subscription controls.
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Configuring External Authentication with Hyperion 
Essbase

Setting the Analyzer.properties file variable EnableEssbaseCSS=true 
indicates that Hyperion Analyzer should pass the authentication token generated 
during external authentication to Hyperion Essbase.  This enables Hyperion 
Analyzer users to connect to Essbase without an additional log on.

Because not all implementations employ external authentication, the variable is set 
to false by default, indicating that Hyperion Analzyer should use the name and 
password encapsulated in the token to log on to Hyperion Essbase.

An exception to this behavior surrounds use of a trusted external authentication 
token by Hyperion Analyzer.  In this case, no password is provided and the user 
will be prompted to log on again.

For more information on external authentication, see Chapter 2, “Managing 
Security and Access.”

Setting Hyperion Analyzer to Log Queries
Setting the Analyzer.properties file variable LogQueries=true redirects 
the ALE query report and Essbase report specification created by ADM to the 
Hyperion Analyzer output log.  This variable is set to false by default, to minimize 
the amount of logged information.

Configuring Microsoft Excel to Support Hyperion Analyzer
The Analyzer.properties file variable ExcelPath indicates where Hyperion 
Analyzer should search for the Microsoft Excel executable file, used in 
conjunction with the Java Web Client’s Export to Excel feature.

ExcelPath=C:\\My_Excel_Path\\Excel.exe;
C:\\Your_Excel_Path\\Excel.exe

Configuring Different Java Plug-in Versions
The Hyperion Analyzer Java Web Client and Administration Tools Client are 
configured to use the Sun Java Plug-in 1.3.1_09.  Administrators can update the 
Sun Java Plug-in versions by editing the Analyzer.jsp and Administrator.jsp files 
static versioning statement. This mandates the loading of the specified version of 
the Sun Java plug-in.



132 ■

Configuration and Integration Options

Hyperion Analyzer Release 7.0 Administrator’s Guide

➤ To edit the Analyzer.jsp and Administrator.jsp static versioning statement, perform 
the following tasks:

1. Open the Analyzer.jsp file using a text editor.

2. Search for the static versioning statement class ID, clsid:.

The current class ID value is as follows:

clsid:CAFEEFAC-0013-0001-0004-ABCDEFFEDCBA

3. Edit the clsid value, to the desired Sun Java Plug-in version.

Alphabetic characters at the beginning and end of the string are set by Sun. Do 
not change these characters. The first two sets of numeric digits indicate the 
Sun Java Plug-in version.  The third set of numeric digits indicates the patch 
number.  For example, the clsid value for the 1.3.1_10 Sun Java Plug-in is as 
follows:

clsid:CAFEEFAC-0013-0001-0010-ABCDEFFEDCBA

4. Save your changes to the jsp file.

5. Repeat all of these steps for the Administrator.jsp file.
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10

Chapter

10
Hyperion Analyzer Utilities

Hyperion Analyzer 5.0.3 Migration Utility
Because Hyperion Analyzer has been completely re-architected, it is necessary for 
Hyperion Analyzer 5.0.3 users to migrate reports, report groups and system 
information to the current Hyperion Analyzer release.

Because the re-architecture of Hyperion Analyzer is a paradigm shift in 
technology, quality, scalability, and usability, the migration process is in fact a 
conversion of release 5.0.3 database tables to a new release 7.0 database table 
design.

The migration process is, therefore, not a one-to-one migration of 5.0.3 data into 
7.0 data. It is instead an attempt to port as much 5.0.3 data to the new 7.0 format 
as is possible. Items that cannot be converted automatically are recorded and 
reported in a conversion log.

Users can review conversion logs in the course of migration, or scroll to the bottom 
of text editors displaying ARD and ARG output files.

Two Kinds of Conversion
Two separate conversion utilities are provided to migrate different database table 
sets:

● The AdminMigrate.exe conversion utility is a Release 5.0.3 
Administration Tools client with a migration menu bar. It is used to migrate 
Hyperion Analyzer 5.0.3 administrative database tables to the Release 7.0 
table design.
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● The AnalyzerMigrate.exe conversion utility is a release 5.0.3 Windows 
client with a migration menu bar. It is used to migrate Hyperion Analyzer 5.0.3 
database tables to the Release 7.0 table design.

Note: Hyperion recommends migrating administrative database tables before 
migrating Hyperion Analyzer database tables.

 Overview of the Migration Process
The migration process consists of the following steps:

1. Maintain installations of Hyperion Analyzer 5.0.3 and 7.0 releases.

2. Save the conversion utilities, AdminMigrate.exe and 
AnalyzerMigrate.exe to the Applications subdirectory of the 
Hyperion Analyzer 5.0.3 directory.

3. Double-click to start the AdminMigrate.exe conversion utility.

4. Convert the following items to their corresponding export file.

5. Import the export file to the Release 7.0 repository.

6. Repeat the process with the AnalyzerMigrate.exe conversion utility.

Although Report Groups are imported directly into the repository, reports are not 
saved to the repository until users execute the Save command. Reports and report 
groups are not shared to other users until report group properties are set to share 
Analyzer content with selected user groups.

The Import command amends existing Release 7.0 database repository. It does not 
overwrite the repository.

Table i: Conversion Utility Process

Conversion Utility Purpose Export File Suffix

AdminMigrate.exe Migrate a user User ID ARU

Migrate all users User ID ARU

AnalyzerMigrate.exe Migrate a view Report ARD

Migrate a view 
group

Report Group ARG
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Converting Release 5.0.3 Users to Release 7.0 Users
Before you can migrate Hyperion Analyzer administrative data you must save the 
AdminMigrate.exe file to the Applications subdirectory of the Hyperion 
Analyzer 5.0.3 directory. Users also must have access to their Hyperion Analyzer 
5.0.3 repository.

➤ To start the AdminMigrate.exe conversion utility:

1. Open Windows Explorer.

2. Double-click  AdminMigrate.exe (in the Applications subdirectory of 
the Hyperion Analyzer 5.0.3 directory).

The Hyperion Analyzer 5.0.3 Administration Tools toolbar is displayed.

3. Click the Manage toolbar button.

The Management window is displayed.

➤ To convert Hyperion Analyzer 5.0.3 users to a Hyperion Analyzer 7.0 users export 
file ARU file:

1. Click Migrate on the menu bar, and select one of the following commands:

● Migrate All Users - Converts all user IDs in the repository. After selecting 
this option proceed to step 4.

● Migrate A User - Converts specific users.

The Users dialog box is displayed.

2. Select a user ID from the drop-down list box.

3. Click OK.

The Save As dialog box is displayed. The converted users are saved to an ARU 
export file.

4. Navigate to a location in which you would like to save the ARU export file.

5. Enter a name for the ARU export file.

6. Click OK.

Conversion log messages, if any, display in the Migration Errors dialog box. 
You can review these messages now, or refer to them later, by opening the 
ARU file in a text editor.

7. To close the Migration Errors dialog box, click OK .
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➤ To import a Hyperion Analyzer 7.0 users export ARU file:

1. From the Hyperion Analyzer launch page, start Hyperion Analyzer 7.0 
Administration Tools.

2. From the Menu Bar select File > Import.

The Open dialog box is displayed.

3. Enter the location and file name of the exported ARU file.

4. Click OK.

The users are saved to the repository.

Converting a View to a Report

Note: Before you can migrate Hyperion Analyzer data you must save the 
AnalyzerMigrate.exe file to the Applications subdirectory of the Hyperion 
Analyzer 5.0.3 directory. Users also must have access to their Hyperion Analyzer 5.0.3 
repository.

➤ To start the AnalyzerMigrate.exe conversion utility:

1. Open Windows Explorer.

2. Double-click AnalyzerMigrate.exe in the Applications subdirectory 
of the Hyperion Analyzer 5.0.3 directory.

A Hyperion Analyzer 5.0.3 Windows client with a special Migration menu bar 
is displayed.

➤ To convert a Hyperion Analyzer 5.0.3 view to a Hyperion Analyzer 7.0 export 
ARD file:

1. Click Migrate on the menu bar, and select Migrate a View.

The Hyperion Analyzer 5.0.3 View Manager is displayed.

2. Select the view group tab of the view that you wish to convert.

3. Select the view name of the view that you wish to convert.

4. Click OK.

The Save As dialog box is displayed. This dialog box will save the converted 
view to an .ARD export file.

5. Navigate to a location in which you would like to save the .ARD export file.
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6. Enter a name for the .ARD export file.

7. Click the Save As dialog box OK button.

Conversion log messages, if any, will display in the Migration Errors dialog 
box. You can review these messages now, or refer to them later, by reviewing 
the .ARD file in a text editor. Click OK to dismiss the Migration Errors dialog 
box.

The Information dialog box displays the following message when conversion 
is complete:

“Finished migrating view <<view name>> into <<pathname>> 
<<filename.ard>>.”

8. Click OK.

➤ To import a Hyperion Analyzer 7.0 export ARD file:

1. From the Hyperion Analyzer launch page, start the Hyperion Analyzer 7.0 
Java Web Client.

2. From the Menu Bar select File | Import | Report.

The Open dialog box is displayed.

3. Enter the location and filename of the exported ARD file.

4. Click OK.

The Map Connection dialog box is displayed.

5. Select a database connection from the Exported Connection list, and then 
select the database connection to use in the Available Database Connections 
list.

6. Click the Map It! button.

The mapped database connection is displayed in the Mapped Connections list. 

7. Repeat steps 5 and 6 until all database connections in the report have been 
mapped to available database connections.

8. When all database connections have been mapped, click OK.
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Converting View Groups to Report Groups

Note: Before you can migrate Hyperion Analyzer data, you must save the 
AnalyzerMigrate.exe file to the Applications subdirectory of the Hyperion 
Analyzer 5.0.3 directory. Users also must have access to the Hyperion Analyzer 5.0.3 
repository.

➤ To start the AnalyzerMigrate.exe conversion utility:

1. Open Windows Explorer.

2. Double-click AnalyzerMigrate.exe in the Applications subdirectory 
of the Hyperion Analyzer 5.0.3 directory.

A Hyperion Analyzer 5.0.3 Windows client with a Migration menu bar is 
displayed.

➤ To convert a Hyperion Analyzer 5.0.3 view group to a Hyperion Analyzer 7.0 
report group export ARG file:

1. Click Migrate on the menu bar, and select Migrate a Group.

The Select Hyperion Analyzer Desktop Group dialog box is displayed.

2. Select a view group from the drop-down list box.

3. Click OK.

The Save As dialog box is displayed.

4. Navigate to a location in which you would like to save the ARG export file.

5. Enter a name for the ARG export file.

6. Click OK.

Conversion log messages, if any, display in the Migration Errors dialog box. 
You can review these messages now, or refer to them later, by opening the 
ARG file in a text editor

7. To close the Migration Errors dialog box, click OK.

The Information dialog box displays the following message when conversion 
is complete:

“Finished migrating view group <<view group name>> into 
<<pathname>> <<filename.arg>>.”

8. Click OK.
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➤ To import a Hyperion Analyzer 7.0 report group export ARG file:

1. From the Hyperion Analyzer launch page, start the Hyperion Analyzer 7.0 
Java Web Client.

2. From the menu bar select File > Import > Report Group.

The Open dialog box is displayed.

3. Enter the location and name of the exported ARG file.

4. Click OK.

The Map Connection dialog box is displayed.

5. Select a database connection from the Exported Connection list, and then 
select the database connection to use in the Available Database Connections 
list.

6. Click the Map It! button.

The mapped database connection is displayed in the Mapped Connections list. 

7. Repeat steps 5 and 6 until all database connections in the report have been 
mapped to available database connections.

8. When all database connections have been mapped, click OK.

The Specify Report Group Name dialog box is displayed.

9. Enter a name for the Release 7.0 report group, and click OK.

The report group is saved to the repository.

Conversion Exceptions
Because the migration process is not a one-to-one migration of Release 5.0.3 data 
into Release 7.0 database tables, some Release 5.0.3 data cannot be converted. 
Items that cannot be converted automatically are recorded and reported in a 
conversion log.

Users can review conversion logs in the course of migration, or they can scroll to 
the bottom of text editors displaying ARD and ARG output files.

Because of the diverse use of Hyperion Analyzer, every foreseeable exception 
cannot be addressed, but a summary of common conversion exceptions follows:
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{system} and defaultuser Do Not Migrate
The Release 5.0.3 user ID {system} was used to share content with all users in the 
Hyperion Analyzer system. Because of security considerations, there is no 
equivalency in Hyperion Analyzer 7.0. Users and administrators must now 
explicitly share report groups with user group members.

Owning and Sharing
Owning and Sharing properties do not migrate. Hyperion Analyzer 7.0 reports and 
report groups are not shared with other users until report group properties are set 
to share Hyperion Analyzer content with selected user groups.

Linked Views Must Be Converted Together in a View 
Group
Views that are linked must be placed in the same view group and migrated 
together. Linked reports that are migrated individually are converted without links.

Unique Member and Calculation Names
Users who give calculation definitions the same name as dimension members may 
encounter conversion errors. To avoid this, give calculation definitions unique 
names.

No Defaults for Custom Report Selection Controls
Hyperion Analyzer 5 Custom Report selection controls (radio button group, tab 
set, list box, and slider bar) do not convert with default settings. This means that 
when custom reports are displayed, the selection control member selections are not 
applied to the corresponding data objects until focus is given to the specific 
controls. When conversion is complete, the report can be saved with new default 
settings.

Named Report Startup Options
Named Report Startup Options specified in the User Preferences dialog box do not 
migrate. Before you can access a report of this sort after migration, the report must 
be assigned to a user group using the Administration Tools client.
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Common Conversion Exceptions

 

Reports

Unable to find axis.

Unable to find dimension.

Unable to find member.

Unable to migrate view.

Unable to export database information.

Unable to migrate Hyperion Essbase ParentFirst setting.

Unable to migrate image.

Unable to load pinboard.

Unable to migrate calculation.

Unable to migrate Sort first X members.

Unable to migrate data formatting for technical reasons (HYADTOFormatFont has 
serialization).

Unable to migrate Show/Hides on ranges of values.

Unable to find axis for Show/Hide.

Unable to migrate drill link to executable.

Unable to migrate relational or MS views.

Custom Reports

Unable to migrate label alignment.

Unable to migrate panel border width.

Unable to migrate panel caption.

Unable to migrate panel font.

Unable to migrate radio group caption.

Unable to migrate radio group hint.

Unable to migrate radio group color.
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Hyperion Analyzer Import/Export Utility
Authorized users can create and delete user IDs and user group profiles by 
importing a valid aru XML file. Import functionality is also integral to migrating 
Hyperion Analyzer 5.0.3 users to Release 7.0.

Import Process Order
The XML file is processed in the following order:

1. Delete users.

2. Delete user groups.

3. Create user groups.

4. Create users.

5. Delete personal variable definitions.

6. Create personal variable definitions.

7. Delete POV definitions.

8. Create POV definitions.

Unable to migrate radio group font.

Unable to migrate service tab order.

Unable to migrate service tab stop.

Unable to migrate service hint.

Unable to migrate tab set hint.

Unable to migrate tab set font.

Unable to migrate combo box hint.

Unable to migrate combo box font.

Unable to migrate form due to incomplete loading.

Unable to find component.

Custom Reports
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Importing an .ARU XML file
The ARU xml file can be imported from Hyperion Analyzer Administration Tools, 
or the command line.

➤ To import and execute an XML file using Administration Tools:

1. Select File > Import from the Administration Tools menu bar.

The Open dialog box is displayed.

2. Navigate to the ARU file and select it.

3. Click OK.

The file is imported and processed.

➤ To import and execute an XML file using the command line, enter the following 
text at the command line for the Hyperion Analyzer drive:

Admin.bat [filename.aru] [user_ID] [Password]

XML File Format Example
The following is a sample XML import file:

1)  <?xml version="1.0" encoding="UTF-8"?>

2)  <AnalyzerAdmin>

3)  <CreateUserGroups>

4)  <DefaultRole Name="Interactive User"/>

5)  <DefaultRole Name="Information Consumer"/>

6)  <UserGroup Name="GroupA" Description="Some Description"/>

7)  <UserGroup Name="GroupB" Description="Another Description">

8)  <Role Name="Power User"/>

9)  </UserGroup>

10)  <UserGroup Name="GroupC"/>

11)  </CreateUserGroups>

12)  <CreateUsers Password="Pwd" ChangePwd="true" 
TemplateProperties="User50">

13)  <DefaultUserGroup Name="GroupA"/>

14)  <DefaultRole Name="Power User"/>
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15)  <User LoginID="User1" Name="TestName"/>

16)  <User LoginID="User2" Password="Pwds" ChangePwd="false"/>

17)  <User LoginID="User3" TemplateProperties="User27">

18)  <UserGroup Name="Administrators"/>

19)  <Role Name="Power User"/>

20)  </User>

21)  </CreateUsers>

22)  <DeleteUsers>

23)  <User LoginID="OldUser1"/>

24)  <User LoginID="OldUser2"/>

25)  </DeleteUsers>

26)  <DeleteUserGroups>

27)  <UserGroup Name="OldGroup1"/>

28)  <UserGroup Name="OldGroup2"/>

29)  </DeleteUserGroups>

30)  <ModifyUsers>

31)  <User LoginID="Administrator">

32)  <AddPersonalVariable Name="MarketPV" Database=
"localhost:Sample:Basic" Dimension="Market">

33)  <Member Name="Market" SelectionMode="CHILDREN"/>

34)  <Member Name="East" SelectionMode="CHILDREN"/>

35)  </AddPersonalVariable>

36)  <AddPersonalVariable Name="YearPV" Database=
"localhost:Sample:Basic" Dimension="Year">

37)  <Member Name="Qtr4" SelectionMode="PREVIOUS" PreviousCount=
"2"/>

38)  </AddPersonalVariable>

39)  <AddPointOfView Name="BatchPOV" Database=
"localhost:Sample:Basic" Active="True">

40)  <AxisSelections Axis="Columns">

41)  <Dimension Name="Market">

42)  <Member Name="East"/>

43)  <Member Name="West" SelectionMode="CHILDREN"/>
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44)  </Dimension>

45)  <Dimension Name="Product">

46)  <Member Name="Product" SelectionMode="CHILDREN"/>

47)  </Dimension>

48)  </AxisSelections>

49)  <AxisSelections Axis="Rows">

50)  <Dimension Name="Year">

51)  <Member Name="Year" SelectionMode="CHILDREN"/>

52)  </Dimension>

53)  </AxisSelections>

54)  <AxisSelections Axis="Pages">

55)  <Dimension Name="Scenario">

56)  <Member Name="Scenario" SelectionMode="CHILDREN"/>

57)  </Dimension>

58)  </AxisSelections>

59)  </AddPointOfView>

60)  <RemovePersonalVariable Name="YearPV" Database=
"localhost:Sample:Basic"/>

61)  <RemovePointOfView Name="AnotherPOV" Database=
"localhost:Sample:Basic"/>

62)  </User>

63)  <User LoginID="TestUser">

64)  <RemovePointOfView Name="TestPOV" Database=
"localhost:Demo:Basic"/>

65)  </User>

66)  </ModifyUsers>

67)  </AnalyzerAdmin>

XML File Format Explanation
The following is a line-by-line description of the example XML file in the 
preceding topic:

1) Identifies the XML version and character encoding of the XML file. This must 
be the first line of all ARU import files.
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2) Identifies Hyperion Analyzer Administration Tool as the target application. This 
must be the second line of all ARU import files.

3) Begins the request to create one or more user groups.

4,5) Identifies the roles to be assigned to each newly created user group in the 
CreateUserGroups request.

6,7) Identifies the user groups to be created. The Name property must be a unique 
group name. The description property is optional.

8) Identifies a role to be assigned to GroupB in addition to the default roles defined 
in lines 4 and 5.

9) Ends the definition of GroupB.

10) Identifies a third user group to be created.

11) Ends the CreateUserGroups request.

12) Begins a request to create one or more users. A default password of “Pwd” is 
assigned to each new user who does not specifically identify a password. When the 
default password is omitted, a password must be given in each specific user. New 
users are required to change their passwords upon login unless the value of 
ChangePwd is overridden in a specific user definition. Each new user is assigned 
the same user properties as the existing User50 user. TemplateProperties are 
optional.

13) Identifies the default user group that will be assigned to each new user within 
the CreateUsers request. You can specify multiple user groups by adding 
DefaultUserGroup lines.

14) Identifies the default role that will be assigned to each newly created user 
within the “CreateUsers” request. Multiple roles may be specified by adding 
additional DefaultRole lines.

15) Identifies the new user to be created. The LoginID must uniquely identify the 
new user.  Name is an optional property.

16) Identifies another new user and overrides the default password information 
provided on line 12.

17) Identifies another new user and overrides the user properties information 
provided on line 12. This user has the same properties as the existing User27 user.

18) Identifies the user group to be assigned to User3 in addition to the default 
group defined in line 13. 
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19) Identifies the role to be assigned to User3 in addition to the default role defined 
in line 14.

20) Ends the User3 definition.

21) Ends the create users request.

22) Begins the delete users request.

23,24) Identifies the users to be deleted.

25) Ends the delete users request.

26) Begins the delete user groups request.

27,28) Identifies the user groups to be deleted.

29) Ends the delete user groups request.

30) Begins a request to modify one or more user accounts. The only supported 
account modifications using the import functionality are adding/deleting points of 
view and adding/deleting personal variables.

31) Identifies the user whose account is being modified.

32) Begins the request to create a new personal variable. The personal variable 
name, database name, and the database dimension name to which the variable 
applies must be provided. If a personal variable of the same name already exists 
for the database. The operation is aborted. The personal variable is applied to all 
global and personal databases with the specified name.

33,34) Identify the members within the dimension that make up the personal 
variable, as well as the selection mode for each member. Valid selection modes are 
MEMBER, CHILDREN, DESCENDANT, PARENT, ANCESTOR, SIBLING, 
DIMBOTTOM, DIMTOP, LEVEL, GENERATION, and PREVIOUS. The default 
selection mode is MEMBER.

35) Ends the add personal variable request.

36) Begins the new request to create a personal variable.

37) Identifies the member with a selection mode of PREVIOUS. In this instance, 
a previous count must be provided to identify the number of previous members 
included with this member.

38) Ends the add personal variable request.
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39) Begins the request to create a new point of view. The point of view name, and 
database name must be provided. The user may indicate whether this point of view 
should be active. The default active value is False. If a point of view of the same 
name already exists for the database. The operation is aborted. The point of view 
is applied to all global and personal databases with the specified name.

40) Identifies the axis to which the following dimension selections are to be 
applied. Valid axes are Rows, Columns, Pages, and Filters. The default axis is 
Filters.

41) Identifies dimension to be placed on the axis.

42,43) Identify the members within the specified dimension to be placed on the 
axis. The valid selection modes are the same as those identified on lines 33 and 34. 
Note that on line 42 the default selection mode is MEMBER.

44) Ends the dimension specification.

45-47) Identify another list of members to be place on the axis identified on line 
41.

48) Ends the selection of members for the axis.

49-58) Identify the members to be included on two more axes.

59) Ends the point of view definition.

60) Request to delete the personal variable named YearPV, which is defined 
against database localhost:Sample:Basic.

61) Request to delete the point of view named AnotherPOV which is defined 
against database localhost:Sample:Basic.

62) Ends the modifications to the specified user.

63-65) Modifications of another user account.

66) Ends the modify user request.

67) Ends the Administrator requests.

Importing Authenticated Users
With the advent of the new Hyperion Analyzer authentication methods, 
administrators have the option of importing users and specifying the authentication 
methods used to validate them during logon.
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To enable this functionality, administrators must enter fully qualified usernames in 
their XML files, as in the following example:

12) <CreateUsers Password="Pwd" ChangePwd="true" 
TemplateProperties="User50">

13)  <DefaultUserGroup Name="GroupA"/>

14)  <DefaultRole Name="Power User"/>

15)  <User LoginID="June" Name="TestName"/>

16)  <User LoginID="Essbase\Nikko" Password="Pwds" ChangePwd=
"false"/>

17)  <User LoginID="External:ntlmSvrname\Franz" 
TemplateProperties="User27">

18)  <UserGroup Name="Administrators"/>

19)  <Role Name="Power User"/>

20)  </User>

21)  </CreateUsers>

On line 15, in the absence of any authentication method, June is authenticated 
using by default Hyperion Analyzer authentication.

On line 16, by declaring Essbase authentication and a backslash (\), the user ID 
Nikko is created and authenticated using the defined Essbase authentication server.

On line 17: By declaring the external authentication method and the external 
authentication provider (separated by a colon (:) and followed by a backslash (\)), 
the user ID Franz is created and authenticated using the specified external 
authentication provider.

Note: Before you can import authenticated users, all authentication methods must be 
implemented. See Chapter 4, “Managing Security and Access” for more information.

Exporting an .ARU XML File
Administrators have the same options for exporting Hyperion Analyzer repository 
information.

➤ To export an .aru XML file using Administration Tools:

1. Select File > Export from the Administration Tools menu bar.

The Open dialog box is displayed.

2. Navigate to an output location for the ARU file.
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3. Click OK.

The file is exported to the specified location.

Web Publishing Batch Utility
Hyperion Analyzer enables users to convert a currently displayed report, or and 
entire report group to HTML, by specifying JSP templates.

This Web publishing process can also be automated using a command line batch 
utility that converts report groups to HTML as scheduled.

Prerequisites for Web Publishing

Hyperion Analyzer Standalone (Windows) Client
Administrators are required to install a license of the Hyperion Analyzer 
stand-alone client on a Windows client computer.

Report Properties
Report properties can be defined that direct Web publishing. When no report 
properties are set, default values are used.

Accessing Report Properties

➤ To access the report properties dialog box, take one of the following actions:

● Right-click the Report Tabs bar and select Properties.

● Click the toolbar Open button, to display Report Manager, and then select 
Properties from the report name right-click menu.

The Report Properties dialog box is displayed.

JSP Templates
Hyperion Analyzer converts reports to Web pages using predefined Java Server 
Page (JSP) templates.
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All templates must be located in your application server’s Web publishing template 
subdirectory, wp_templates.

When no JSP template file is specified, Hyperion Analyzer defaults to the 
report_publish.jsp template in the \webapps\Analyzer7_Server
\templates subdirectory.

Note: BEA WebLogic 6.1 users defining custom templates must save their templates 
to the wp_templates directory inside the ear file.  After the custom templates have been 
saved to the Analyzer7_Server\wp_templates directory, the ear must be rebuilt and 
posted to the application server.  The wp_output directory is not affected, nor is this a 
problem in WebLogic 7.2.

Publish To
HTML output location is defined by the Publish To report property.

When using the batch utility, the default output file, Publish To, is the application 
server’s Web publishing output subdirectory, wp_output.

Creating the Web Publishing XML File
Users are required to define a XML files that specify the parameters and arguments 
used to automate Web publishing.

The following code is an example of a Web publishing XML file:

1 <?xml version="1.0" encoding="UTF-8" ?>

2 <AnalyzerExport>

3 <ExportItem URL=
"http://localhost/Analyzer7_Server/Dispatcher" UserName=
"system" Password="password"  GroupName="systemGroup" 
ReportName="" Overwrite="" />

4 </AnalyzerExport>

Web Publishing XML File Explanation
The following is a line-by-line description of the example file in the preceding 
topic:

1) Identifies the XML version and the character encoding of the XML file. This 
must be the first line of all Web publishing files.

2) Indicates the start of a Web publishing declaration.
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3) Identifies the subject to be exported to HTML using the following attributes:

● URL - the fully qualified path to the Dispatcher in the web app directory

● UserName - A valid Hyperion Analyzer user ID

● Password - A valid password for the user ID

● GroupName - The name of the Hyperion Analyzer report group 
containing the reports to be exported as HTML

● ReportName - The name of the report to be exported as HTML

Note: In the absence of a specified ReportName attribute, the entire report group is 
exported as HTML.

4) Indicates the end of a Web publishing declaration.

Locating the Web Publishing XML File
The Web publishing XML file must be accessible to the installed Hyperion 
Analyzer stand-alone (Windows) client.

Running the Web Publishing Batch Utility

➤ To export the items specified by the Web Publishing XML file using the command 
line, type the following text at the command line of the Hyperion Analyzer drive:

BatchExport.bat [filename.xml]

AnalyzerCredential.jsp
You can generate time-limited login credentials that enable users to go directly to 
a Hyperion Analyzer Web Client, without sending unencrypted login information 
between the client and server.

To do this, pass a user ID and password to the AnalyzerCredential.jsp page.  The 
AnalyzerCredential.jsp page generates time-limited credentials that can be used to 
authenticate the user to one of the following:

● The Java Web Client (Analyzer.jsp) UserCredential applet parameter

● The HTML Web Client (login.jsp) UserCredential query parameter (action=
login).
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The credential token is returned in encrypted form and expires by default in five 
minutes.  Expiration and length of time can be controlled by parameters in the 
AnalyzerCredential.jsp file.

The AnalyzerCredential.jsp is typically installed below the Web app directory:

Analyzer7_Server/AnalyzerCredential.jsp

Hyperion Analyzer Configuration Test Servlet
Use the Hyperion Analyzer Configuration Test Servlet to diagnose and resolve 
connectivity issues. To start the servlet, start a Web browser and replace 
“index.html” in the path to the Hyperion Analyzer launch page with “Config.”  The 
servlet displays links that centrally report environmental variables and 
Analyzer.properties file parameters, and test connectivity to the class 
factory, the Hyperion Analyzer repository, the external authentication 
configuration file, and the Essbase ADM driver.

➤ To launch the Configuration Test Servlet:

1. Open a browser window and type the following URL.

http://<hostname>/Analyzer7_Server/Config

The Configuration Test Servlet allows you to access the following information and 
tests:

● List Environment Variables – Displays the environment variables from the 
server.

● View Analyzer Property Files – Displays repository information from the 
classes.xml, Xml.properties, and Analyzer.properties files. 

● Class Factory Test – Tests the classes.xml file.

● Repository Test – Retrieves information from the repository based upon the 
user ID defined.

● External Authentication Test – Tests external authentication and single 
sign-on.

● ADM Essbase Test – Provides login information and allows you to test your 
connectivity to Essbase. 

To access each of the above pages, click the corresponding link.
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Environment Variables
The List Environment Variables page displays Java System Properties and System 
Environment Variables. You can use this page to view specific system properties 
which include, user.name, java.class.path, java.home, HYPERION_HOME, 
LOGONSERVER, and CLASSPATH.

Figure 1:  Environment Variables



Hyperion Analyzer Configuration Test Servlet

10

■ 155Hyperion Analyzer Release 7.0 Administrator’s Guide

Tip: You can use the browser’s Back button or the Available Tests link at the bottom 
of the page to return to the Configuration Test Servlet home page.

Viewing Analyzer.properties Parameters
The Analyzer Property Files page displays the physical location and links to access 
the Classes.xml, Xml.properties, and Analyzer.properties pages.

➤ To view a file, click the corresponding link.

For example, if you want to view the installation license key, you can view the 
Analyzer.properties file.

Testing the Class Factory
The Class Factory Test page tests the Classes.xml file. The last line of the page 
indicates whether the test executed successfully or failed. If the class factory test 
failed, a stack trace displays to help you troubleshoot the problem.

Testing the Repository
The Repository Test page retrieves information from the repository using the 
defined user ID and tests the repository connection. This test is extremely helpful 
to troubleshoot issues with connectivity. The last line of the page indicates whether 
the test executed successfully or failed. If the test failed, a stack trace displays to 
help you troubleshoot the problem. 

Testing External Authentication
The Test External Authentication page allows you to test the external 
authentication and single sign-on. Similar to the other testing pages, if the test fails, 
a stack trace is provided to help you troubleshoot the problem. 

Testing ADM Essbase
The ADM Essbase Configuration page provides the following information:

● ADM Environment Variables

● ADM Property File Locations

● ADM Jar Locations
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● Version Information

● Essbase Login Information 

You can use this page to login to Essbase and test your connectivity. 

Tip: To view the ADM Property files, click a property link.

➤ To login and test your Essbase connectivity:

1. Scroll to the bottom of the page and type:

● The name of the Essbase server

● Your Essbase user name

● Your Essbase password

2. Click Show Details.

3. Click Submit Query.
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Appendix

A
Customizing HTML Web 
Content

HTML Web Client Templates
Templates are composed of conventional HTML and Hyperion Analyzer tags and 
actions. The following templates are used by the HTML Web Client:

● about.jsp

● analyze.jsp

● changepwd.jsp

● dblogin.jsp

● desktop.jsp

● dimbrowser.jsp

● edit.jsp

● error.jsp

● frame.jsp

● loggedout.jsp

● login.jsp

● newreport.jsp

● print.jsp

● relatedcontent.jsp

● report_publish.jsp

● report.jsp

● reportlist.jsp

● saveas.jsp



158 ■

Customizing HTML Web Content

Hyperion Analyzer Release 7.0 Administrator’s Guide

Custom Templates
After custom templates are created, you can pre-compile them to enhance 
performance. Save the templates with other JSPs in the appropriate application 
server directory. In addition, some application servers require the JSPs be 
registered in the web.xml file. See your application server documentation to 
determine the requirement. This task is reserved for advanced users familiar with 
their application servers, because there are considerable differences between the 
supported application servers.

Template Tags
Template tags are parsed sequentially. To differentiate Hyperion Analyzer tags 
from HTML tags, the start and end tags are identified by the following syntax:

<hya: is the start of the tag and /> is the close of the tag.

For example:

<hya:TagName attribute1=”value1”, attribute2=”value2”, 
atrribute3=”value3”/>

Following are the Hyperion Analyzer template tags and their descriptions.

<hya:About/>

Returns the release number with copyright and server information, usually 
displayed in the Hyperion Analyzer About dialog box.

<hya:AllowActions/>

Enables drilling or advanced member selection. The absence of this tag disables 
drilling in the Hyperion Analyzer HTML Web Client.

<hya:Analyze/>

Returns a URL to launch the Java Client.

<hya:AuthServerList/>

Returns an HTML combo box that lists the available authentication servers.
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<hya:CalcList/>

Returns to the Hyperion Analyzer HTML Web Client a list of available server 
calculations. These calculations are used to reconsolidate the database after edits 
have been posted.

Sample

<SELECT>

<OPTION>Default</OPTION>

</SELECT>

<hya:CancelDBLogin/>

Returns a URL to cancel the database logon template.

<hya:CancelEdit/>

Returns a URL containing the actions to terminate the Edit Data mode without 
posting edits to the database.

<hya:CancelSave/>

Returns a URL to cancel the Save As template without saving the report.

<hya:CellBGColor/>

Defines the color of the cell background at the specified row and column.

Attributes

<hya:CellFGColor/>

Defines the color of the foreground text at the specified row and column.

Value Description

datasource The data source name, or query definition name.  It can be 
identified in the tree view of Design Report mode

row The integer representing a specified table row

column The integer representing a specified table column
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Attributes

<hya:CellValue/>

Returns the value of the cell at the specified row and column 

Attributes

<hya:DataPost/>

Appends the end of a Grid tag output data cell with the supplied data string.

Example

<hya:DataPost value=”</strong>”/>

Attributes

string: data

<hya:DataPre/>

Precedes a Grid tag output data cell with the supplied data string.

Attributes

string: data

Example

<hya:DataPre value=”<strong>”/>

Value Description

datasource The database connection name

row The integer representing a specified table row

column The integer representing a specified table column

Value Description

datasource The database connection name

row The integer representing a specified table row
column The integer representing a specified table column
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<hya:DataTD/>

Appends the <TD> HTML tag of a Grid tag output data cell with the supplied 
attribute string. Used to modify <TD> tag attributes for color, alignment, and other 
attributes. String data must specify valid HTML attributes for the <TD> tag, or the 
Web browser cannot render the cells.

Attributes

string: data

Example

<hya:DataTD value=”align=’right’”/>

<hya:DBList/>

Returns a combo box list of available database connections in the New Report 
template.

<hya:DBMessage/>

Returns status messages generated by the database.

<hya:DBName/>

Returns the database ID.

<hya:Desktop/>

Returns an HTML version of the Hyperion Analyzer HTML Web Client Desktop.

<hya:DimBrowserCurrentMember/>

Returns the member name of the current selected member in the Dimension 
Browser.

<hya:DimBrowserDefaultLabelMode/>

Returns a string for the default label mode of the selected dimension.
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String Values

Descriptions

IDs

Both - Descriptions and IDs

<hya:DimBrowserDimName/>

Returns the dimension name in the Dimension Browser.

<hya:DimBrowserEvent/>

Returns a URL to the server that indicates a Dimension Browser event.

Values

● UseDefault

● UseAlias

● UseID

● UseBoth

● Remove

● RemoveAll

● Apply

● Cancel

Example

<hya:DimBrowserEvent event=”UseDefault”/>

<hya:DimBrowserLabelMode/>

Returns the current Label Mode string.

Attribute Description

event The name of a defined Dimension Browser event.
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Value

0 - use id

1 - use alias

2 - use default

3 - use both

<hya:DimBrowserModeMenu/>

Returns an HTML table of the Selection Mode List that contains the following 
HTML anchors:

● Search

● Move Up

● Move Down

● Remove

<hya:DimBrowserSelectionList/>

Returns the HTML table that contains the member selections defined for the 
dimension being browsed.

<hya:DimBrowserShowModeMenu/>

Returns:

true - The Dimension Browser Mode Menu is displayed.

false - The Dimension Browser Mode Menu is hidden.

<hya:DimBrowserShowSearchDialog/>

Returns:

true - The Search Dialog table is displayed.

false - The Search Dialog table is hidden.
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<hya:DimBrowserTree/>

Returns the HTML table of the hierarchical tree of members for the selected 
dimension. Members that are selected in the tree are displayed in the Selection 
List.

<hya:DisplayTypes/>

Returns a list of available display types for the Hyperion Analyzer HTML Web 
Client.

Example

<SELECT>

<OPTION>Spreadsheet</OPTION>

<OPTION>Bar Chart</OPTION>

</SELECT>

<hya:DisplayObject/>

Returns the HTML of the current data object. Data objects are report components 
that represent the data source as a spreadsheet, chart, or pinboard. Custom reports 
and horizontal and vertical combination reports can contain more than one data 
object.

<hya:DrillOptions/>

Returns a list of available Hyperion Analyzer HTML Web Client drill options, 
including the option to display the Dimension Browser for the currently selected 
dimension.

Example

<SELECT>

<OPTION>Drill Down</OPTION>

<OPTION>Drill Up</OPTION>

<OPTION>Drill To Top</OPTION>

<OPTION>Browse</OPTION>

</SELECT>
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<hya:EditData/>

Returns the URL to initiate the Edit Data Mode of the current data object of the 
current report.

<hya:Filters/>

Returns a list of filter dimensions for the current data object of the current report.

<hya:GetProperty/>

Returns the true or false state of the defined attribute value.

Attributes

name: indicates the value for which the GetProperty tag is obtaining the state.

Value Description

showInfo Returns the true or false display state of Information panel.

showFilters Returns the true or false display state of filters.

showFonts Returns true when Hyperion Analyzer style fonts are in use or 
false when the template style fonts are in use.

showMultiPage Returns true when multiple page dimensions are separated into 
individual drop down list boxes and false when page dimensions 
are aggregated.

isSaveAllowed Returns true when the current report can be saved.

isReportLoaded Returns true when the current report is loaded.

isEditAllowed Returns  true when the current report can enter Edit mode.

isEssbase Returns true when the current data object in a report uses a 
Hyperion Essbase database connection.

isRelational Returns true when the current data object in a report uses a 
relational database connection.

isHFM Returns true when the current data object in a report uses a 
Hyperion Financial Management database connection.

isDrillThru Returns true when the current data object is a drill-through report.

isViewLoaded Returns true when there is a current data object, or in other words 
has been loaded.

isSQLView Returns true when the current data object is a custom report SQL 
spreadsheet component.
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<hya:Grid/>

Returns an HTML grid for the current page of the current data object of the current 
report.

<hya:HeadPost/>

Appends the end of a Grid tag output header cell with the supplied data string.

Example

<hya:HeadPost value=”</strong>”/>

Attributes

string: data

<hya:HeadPre/>

Precedes a Grid tag output header cell with the supplied data string.

Attributes

string: data

Example

<hya:HeadPre value=”<strong>”/>

<hya:HeadTD/>

Appends the <TD> HTML tag of a Grid tag output header cell with the supplied 
attribute string. Used to modify <TD> tag attributes for color, alignment, and other 
attributes. String data must specify valid HTML attributes for the <TD> tag, or the 
Web browser cannot render the cells.

Attributes

string:data
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Example

<hya:HeadTD value=”align=’right’“/>

<hya:Home/>

Returns the URL of the Hyperion Analyzer home page.

<hya:InfoAcross/>

Returns the Information panel Across axis segment.

<hya:InfoDatabase/>

Returns the Information panel Databases segment.

<hya:InfoDown/>

Returns the Information panel Down axis segment.

<hya:InfoFilters/>

Returns the Information panel Filters axis segment.

<hya:InfoPages/>

Returns the Information panel Pages axis segment.

<hya:InfoPanel/>

Returns the Hyperion Analyzer HTML Web Client Information panel.

<hya:InfoRestrict/>

Returns the Information panel Restrict Data segment.

<hya:InfoSort/>

Returns the Information panel Sort segment.
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<hya:InfoTopBottom/>

Returns the Information panel Retrieve Only Top/Bottom segment.

<hya:InfoTrafficLight/>

Returns the Information panel Traffic Lighting segment.

<hya:InfoUser/>

Returns the Information panel User segment.

<hya:LayoutList/>

Returns a drop down list box listing layout options: spreadsheet, chart, vertical 
combination, and horizontal combination.

<hya:LinkTo/>

Launches the current report in the specified value of the Type attribute.

Attributes

type

Values

JavaClient

HTMLClient

<hya:Logout/>

Returns the URL to log off the user.

<hya:Message/>

Returns any status messages generated by the program. The tag returns only errors 
generated by tags placed sequentially before it in the template.



Template Tags

■ 169Hyperion Analyzer Release 7.0 Administrator’s Guide

<hya:NewReport/>

Returns a URL to initiate creating a new report.

<hya:NextPage/>

Returns a URL to go to the next page in the page series of the current data object.

<hya:NextReport/>

Returns a URL to go to the next report in the current report group.

<hya:PageCount/>

Returns the number of pages in the current data object of the current report.

<hya:PageNumber/>

Returns the page number of the current page in the current data object of the 
current report.

<hya:Pages/>

Returns a list of all the pages in the current data object of the current report.

Example

<SELECT>

<OPTION>East</OPTION>

<OPTION>West</OPTION>

</SELECT>

<hya:Password/>

Returns the user password.
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<hya:PostLogin/>

When a URL is interrupted by authentication methods, an action and its 
parameters from the URL are encapsulated as the value of a PostLogin variable in 
the login page. When the user is authenticated, the action is passed on for 
execution.

<hya:PreviousPage/>

Returns an HTML version of the previous page in the page series of the current 
data object.

<hya:PreviousReport/>

Returns an HTML version of the previous report in the current report group.

<hya:Print/>

Returns the URL of the Web browser print template displaying the current data 
object. This can be used as print preview functionality that supports printing 
through the Web browser.

<hya:RefreshEdits/>

Returns the URL to reload the data for the current grid. Often used with Edit Data 
mode HTML controls that reload the current grid with the last saved values.

<hya:RelatedContent/>

Returns the HTML node tree of related contents for the selected data cell. 

<hya:Reload/>

Returns the URL to reload the current report. Often used for HTML controls that 
reload the current report per the last save.

<hya:Report/>

Returns an HTML version of the current report.
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<hya:ReportDescription/>

Returns the report description.

Example

Profit Report for the Eastern Region

<hya:ReportGroupList/>

Returns a combo box list of report group names to which a user has access.

<hya:ReportGroup/>

Returns the name of the current report group.

<hya:ReportHeight/>

Returns the height of the current report in pixels.

<hya:ReportManager/>

Returns the Hyperion Analyzer HTML Web Client Report Manager as an 
expandable and collapsible node tree.

<hya:ReportName/>

Returns the name of the current report.

<hya:ReportSize/>

Changes the current report height and width.

Example

<hya:ReportSize height=”480” width=”640”/>

Attributes

height- The height of the report in pixels, with 
the value equal to an integer in a string

width- The width of the report in pixels
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<hya:ReportState/>

Returns the state of the current report in a string so that the Java Web client 
displays the report in the same state as the HTML Web client.

<hya:ReportWidth/>

Returns the width of the current report in pixels.

<hya:Res/>

Gets a string value from a language-based resource property file.

Attribute

id - Maps the property name to a property value in a property file

<hya:Save/>

Returns a URL to execute to save the current report.

<hya:Script/>

Returns the Java Script necessary to handle interactive requests such as user 
actions and page navigation.

<hya:ServletURL/>

Returns the URL of the Hyperion Analyzer HTML Web Client servlet engine.

<hya:SetParam/>

Returns a URL to indicate an action for setting parameters.

<hya:ShowAbout/>

Returns the URL to show the About dialog box.

<hya:ShowReportManager/>

Returns the URL to show the Report Manager.
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<hya:ShowSaveAs/>

Returns a URL to show the Save As dialog box.

<hya:Startup/>

Returns the URL to do what the Startup User Preferences is set to do. For example 
load a report, load a specific report group, and so on.

<hya:ToggleFilters/>

Returns a URL to toggle Filters on or off.

<hya:ToggleInfo/>

Returns the URL to toggle the Web Client Information panel.

<hya:ToggleMultiPage/>

Returns the URL that toggles the Hyperion Analyzer HTML Web Client Page 
Control panel between multiple and aggregated page combo boxes.

<hya:ToggleStyle/>

Returns the URL that toggles between different Hyperion Analyzer HTML Web 
Client grid style.

<hya:UserCredential/>

Returns a string containing information used to authenticate the user.

<hya:UserID/>

Returns the name of the user.

<hya:Version/>

Returns the <major>.<minor>release number of Hyperion Analyzer. 
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<hya:WebAppURL/>

Returns the URL of the Hyperion Analyzer Web application.

Example

http://<servername>/Analyzer7_Server/

Template Tag Styles
Custom HTML styles have been defined to speed development. Styles have been 
separated into three groups:

● Template styles

● List template styles

● About styles

Use these styles in cascading style sheets, or declare them in line as needed.

Example

.gridOddRow{background-color:#A6C9C9;}

Template Tag Styles List
The following tables list and describe the each of the following template tag styles.

Table 1: HTML Client Template Style Tags

Style Description

gridEvenRow Formats even numbered rows.

gridOddRow Formats odd numbered rows.

gridData Formats grid data cells.

gridNegData Formats data cells with negative values.

gridColHeader Formats column headers.

gridRowHeader Formats row headers.

gridRowTitle Formats the upper-left of grid row titles.
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HTML Web Client Actions
Web developers can customize Hyperion Analyzer HTML behavior by including 
actions and their parameters in URLs pointing to the Hyperion Analyzer HTML 
Web Client. Such an URL would consist of the elements described in the following 
table:

infoHeader Formats the Information panel headers.

infoData Formats Information panel data.

Table 2: HTML Client List Template Style Tags

Style Description

groupStyle Formats report group lists.

viewStyle Formats report lists.

highlightStyle Formats selected report groups with highlighting.

Table 3: HTML Client About Style Tags

Style Description

version Formats Hyperion Analyzer release information.

copyright Formats Hyperion Analyzer copyright information.

server Formats server information.

warning Formats warning information.

Table 1: HTML Client Template Style Tags

Style Description
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Note: HTML actions and their parameters are delimited by the ampersand (&) 
character. The ampersand character is typically omitted directly following the question 
mark (?) delimiter to avoid confusion and redundancy.

Using Actions
HTML actions are commands to the HTML Web Client included in the URL.

Example

To Log on to Hyperion Analyzer:

http://[ServerName]/[PathName]? Action=login&userid=
[UserID]&password=[Password] 

Because URLs do not accommodate empty spaces, users are reminded to use 
“%20” to represent the spaces in strings.

Actions List

Action
Indicates the action to perform. Following are the HTML actions available for your 
use.

Table 4: Hyperion Analyzer HTML Web Client URL Components

URL Element Description

http:// Protocol

ServerName The name of the server hosting the Hyperion 
Analyzer HTML Web Client.

PathName The Path to Hyperion Analyzer HTML Web Client 
servlet engine.

? The required question mark (?) delimiter.

SID Secondary ID. The established session handle.
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About
Returns Hyperion Analyzer HTML Web Client About dialog box information.

Analyze
Loads the Analyze template (the Java Client launch page.)

CancelDBLogin
Cancels the database logon.

CancelEdit
Cancels the Edit Data mode.

Note: This action requires that the user understand the process of initiating and ending 
Edit Data mode. Edits can be applied only to the current page of the current data object.

CancelSave
Cancels the SaveAs action and returns to the current report template.

ChangePassword
Changes the Hyperion Analyzer password for the current user ID.

Parameters

password - the current password

newpassword - A new password

DBLogin
Logs the user on to the specified database.

Parameters

dbname- The database ID

dbuserid- A valid user ID for the specified database
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Desktop
Displays the Hyperion Analyzer Desktop template.

DimBrowser
Displays the Dimension Browser template, if there are available values for the 
events parameters they are displayed in the Dimension Browser.

DrillCell
Displays the Related Content template of the specified view for the specified row 
and column.

dbpassword- The password for the user ID

saveuid- Indicates whether to save the login information for 
future use. Values of “1” or “True” indicate to save.

Parameters

view- Indicates the specific data object on the report that is 
displayed in the DimBrowser. 

dimension- Indicates the dimension that is displayed in the 
DimBrowser.

event- Indicates any event sent to the DimBrowser template in 
a URL that updates the template. For a list of events see 
the <hya:DimBrowserEvent/> tag.

Parameter

view- Indicates the specific data object on the report where the 
Related Content identifier is located.

row- The integer representing a specified table row.

col- The integer representing a specified table column.

Parameters
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DrillDown
Drills down on the specified dimension member of the specified data object.

DrillUp
Drills up on the specified dimension member of the specified data object.

DrillToTop
Drills to the top member of the specified dimension member of the specified data 
object.

Parameter

view- Indicates the specific data object in the report where 
drilling takes place. Data object names are listed in the 
Tree View panel when the Hyperion Analyzer Java Web 
Client is in Design Report mode.

dimension- Indicates the dimension on which to drill.

member- Indicates the dimension member on which to drill.

Parameters

view- Indicates the specific data object on the report where 
drilling takes place. Data object names are listed in the 
Tree View panel when the Hyperion Analyzer Java Web 
Client is in Design Report mode.

dimension- Indicates the dimension on which to drill.

member- Indicates the dimension member on which to drill.

Parameters

view- Indicates the specific data object in the report where 
drilling takes place. Data object names are listed in the 
Tree View panel when the Hyperion Analyzer Java Web 
Client is in Design Report mode.

dimension- Indicates the dimension on which to drill.

member- Indicates the dimension member on which to drill.
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EditData
Initiates the Edit Data mode, enabling users to change data and send new values 
back to the database.

Note: This action requires that the user understand the process of initiating and ending 
Edit Data mode. Edits can only be applied to the current page of the current data object.

ExportToHtml
Exports the current report to HTML using the specified parameters. This action is 
used to support batch export.

FocusDisplayObject
Sets the current data object of the current report.

Parameter

view -       The specific data object on the report to receive focus. Data object names 
are listed in the Tree View panel when the Hyperion Analyzer Java Web 
Client is in Design Report mode.

Home
Displays the Hyperion Analyzer Desktop.

LoadGroup
Loads the specified report group.

Parameter

group - The ID of the report group

Parameters

groupname- The name of the report group in which the report is 
stored.

reportname- The name of the report to export.
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LoadReport
Loads the specified report.

Parameter

name - The name of the report

group - The name of the report group containing the report

Login
Logs in to the Hyperion Analyzer Analysis Server, starts the Hyperion Analyzer 
HTML Web Client and displays the defined Startup page.

Example:

http://[ServerName]/[PathName]?Action=login&userid=
[UserID]&password=[Password]&postlogin=loadreport&group=
[groupname]&name=[reportname]

Logout
Terminates the session specified by the SID number.

Parameters

userid A valid Hyperion Analyzer user ID

password The password for the user ID

postlogin An optional parameter indicating an action to be 
executed following login, specified in the login URL. 
You must also provide the required parameters for the 
executed action.
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MoveDim
Relocates the dimension on the specified axis and position to another axis and 
position.

NewDispType
Changes the current data object to the specified display type. Data objects with a 
chart display type also require a dispsubtype, or chart type, to be defined.

Parameter

disptype - The display type of the current data object:

dispsubtype - The chart type of a chart:

Parameters

axisto- Indicates the destination axis to which the dimension is 
moved:
1 - column axis
2 - row axis
3 - page axis
4 - filter axis

posto- Indicates the position on the specified axis the 
dimension takes. Uses a zero-based index. Zero (0) is 
the first position.

dimension- Indicates the dimension to move, and thereby its current 
axis and position.

disptype Display Type Value

0 Default

1 Spreadsheet

2 Chart

3 Pinboard

dispsubtype Chart Type Value

1 Chart Type Values

2 Vertical Bar Chart

3 Line Chart
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NewPage
Displays a specified page using its page number in the page series.

Parameter

pageno - The page number of the specified page. Uses a zero-based index.

NewReport
When the action is used without parameters, it displays the New Report template. 
When the following parameters are provided the new report is created.

4 Pie Chart

5 Quadrant Chart

6 Area Chart

7 Multi-type Chart (Unsupported)

8 Marks Chart

12 Spline Chart (Unsupported)

13 Curved Area Chart (Unsupported)

14 Pareto Chart

17 Bubble Chart

20 Horizontal Bar Chart

21 User's Default Chart Type (User Preferences)

22 Last Selected Chart Type (Unsupported)

23 Box Plot Chart (Box and Whiskers) (Unsupported)

Parameters

dbid- the index of an existing database connection

layout- One of the following layout types:
1 - spreadsheet
2 - chart
3 - vertical combo
4 - horizontal combo

dispsubtype Chart Type Value
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NextReport
Returns the next report in the report group.

PrevReport
Returns the previous report in the report group.

Print
Returns the URL of the Web browser print template displaying the current data 
object. This can be used as print preview functionality that supports printing 
through the Web browser.

RefreshEdits
Reset the Edit Data mode cells to their last saved values.

Reload
Reloads the current report in the report template.

ReloadData
Reloads data values in the current data object of the current report.

ReportManager
Returns the HTML Web Client Report Manager node tree. The tree contains nodes 
representing reports and report groups.

RunCalc
Reconsolidates the Hyperion Essbase database after changes have been posted.

Parameter

calcname -      The name of the Hyperion Essbase server calc used to reconsolidate 
the database
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Save
Saves the current report.

SaveAs
Saves the current report with another report name. The current report parameters 
that are not changed, are retained for the new report.

SaveAsPage
Displays the Save As template.

SendData
Posts Edit Data mode changes to the Hyperion Essbase database.

Note: This action requires that the user understand the process of initiating and ending 
Edit Data mode. Edits can only be applied to the current page of the current data object.

Posting is achieved on a cell-by-cell basis, with all cell values being sent. Each 
posting must be in the following format:

rrrrcccc=n

Where n is the value located at row rrrr and column cccc.

Example

To send a spreadsheet with two rows, one column, and the values 5 and 10, the 
action is entered:

&action=senddata&00010001=5&00020001=10

Parameters

newgroup- A new report group name

newname- A new report name

newdesc- A new report description
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SetAliasController
Specifies the alias controller custom report component and the alias table of the 
current database connection from which to derive a description label.

SetDim
Selects the specified dimension member and related dimension members defined 
by an Advanced Member Selection mode.

Parameters

acname- The name of the alias controller custom report 
component

acitem- The name of the alias table, from which the description 
label is derived.

Parameters

view- The specific data object on the report. Data object names are 
listed in the Tree View panel when the Hyperion Analyzer Java 
Web Client is in Design Report mode.

dimension- The dimension

member- The dimension member

mode- The Advanced Member Selection mode:
0 - Select Member
1 - Also Select Children
2 - Also Select Descendants
3 - Also Select Parent
4 - Also Select Ancestors
5 - Also Select Siblings
6 - Also Select Dim Bottom
7 - Also Select Dim Top
8 - Also Select Level
9 - Also Select Generation
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SetParam
Updates the server with parameter values to set current and subsequent report 
widths and height. The values of the parameters are stored in memory for the 
duration of the user session.

SetServiceDispatcher
Executes the action of the services control specified by the following parameters. 
Currently requires an internal services dispatcher ID number.

Note: This action does not support the following features: Logging off, User 
Preferences, Report Manager, Launch Executable, Print Screen, or Print Current 
Report.

Parameter

sdname - The services dispatcher ID number

SetSubscriptionController
Executes the selection action of the subscription control specified by the following 
parameters. Currently requires an internal subscription controller ID number.

Parameters

reportwidth- The new width of the report

reportheight- the new height of the report

Parameters

sctype- A string indicating the type of subscription control:

• radio

• combobox

• button

• checkbox

• multilevel

• sqlcombobox

scname- An internal subscription controller id number
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Startup
Executes actions defined by the Startup User Preferences. For example: load a 
report, load a specific report group, and so forth.

ToggleFilters
Shows or hides Filters in the interface.

ToggleInfo
Shows and hides the Information panel.

ToggleMultiPage
Toggles the Page Control panel between multiple and aggregated page combo 
boxes.

ToggleStyle
Toggles between the grid styles.

Samples
The following topics provide sample templates, tags, and actions that you can 
model in the creation of your own HTML content.

scitem- The control text. The scitem parameter is different for each of the 
four supported subscription controller types:

• Check boxes and radio buttons - The control text

• Combo box - The zero-based index of the menu series

• Button - The text label

scselected- (Check box only) True if the check-box is selected; false if it is not.

Parameters
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Using Actions to Retrieve Information
Hyperion Analyzer provides a technique for gathering information from returned 
HTML headers.

➤ To log on to Hyperion Analyzer, type this URL:

http://[ServerName]/[PathName]?Action=login&userid=
[UserID]&password=[Password]

➤ To log on to a specific report of a specific Hyperion Analyzer session, type this 
URL:

http://[ServerName]/[PathName]?SID=[Session Handle]&Action=
loadreport&group=[Group Name]&name=[Report Title]

Portal
By adding the portal=1 parameter to the end of the Login or LoadReport actions, 
users can retrieve additional information in the HTTP response header.

Using portal at the end of a Login action returns the Login Status and user SID 
(“X-Login-Status”, “X-Login-SID”, X-SSO-Login-status) in the response header. 
The Login Status indicates the success of the logon effort:

1 - Success

-1 - Error

-2 - Change Password

-3 - Logon failed with token

The X-SSO-Login-Error returns an error code if external authentication is 
configured and then a logon fails.

The user SID, or session ID, is the session handle number.

➤ To retrieve the Login Status and SID, type this URL:

http://[ServerName]/[PathName]?Action=login&userid=
[UserID]&password=[Password]&portal=1

If you logged on using the portal mode, you can use the LoadReport action to 
return the names of all the data sources (“X-Datasource-Names”) and data source 
types (“X-Datasource-Types”) for all the data objects on the report (in the response 
header).
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➤ To retrieve the data source names of specific report of a specific Hyperion 
Analyzer session, when you have logged on using the portal parameter, type this 
URL:

http://[ServerName]/[PathName]?SID=[Session Handle]&Action=
loadreport&group=[Group Name]&name=[Report Title]
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Appendix

B
Applet Parameters

There are two kinds of applet parameters:

● Applet modifiers define the applet to the browser. The World Wide Web 
Consortium codifies applet modifiers.

● Applet parameters pass values to the applet. Applet parameters are 
applet-specific.

Table 1: Applet Modifiers

Applet Modifiers Modifier Description

WIDTH Amount of horizontal space used by applet. The 
WIDTH modifier allows expression in terms of a 
percentage.

HEIGHT Amount of vertical space used by applet. The HEIGHT 
modifier allows expression in terms of a percentage.

CODE The applet’s main class name. Changing this value 
prevents the correct classes from being loaded.

CODEBASE The URL of the applet’s main class.

NAME The name of this instance of the applet. The NAME 
modifier enables multiple applets on the same page to 
locate each other and communicate.

ARCHIVE The URL of the JAR archive containing the classes. 
Netscape browsers download the archive and use the 
classes therein to accelerate startup. This URL should 
not be changed when specified in the applet.html 
file. Locally installed classes should omit this modifier.
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Table 2: Applet Parameters 

Applet Parameter Description

BGColor Sets an RGB color for the applet background. The 
default is light gray.

Debug When set to TRUE, the Debug Boolean string value 
(TRUE/FALSE) enables objects to report debugging 
information to the Java-based Hyperion Analyzer 
Analysis Server console. The default value is FALSE.

FrameHeight The FrameHeight string value is the height in pixels of 
the Hyperion Analyzer frame.

FrameWidth The FrameWidth string value is the width in pixels of 
the Hyperion Analyzer frame.

HideConfirmDialog API Toolkit-specific

When set to TRUE, the HideConfirmDialog string value 
hides confirmation dialog boxes. This is TRUE only for 
events triggered using scripting. Confirmation dialog 
boxes triggered by conventional GUI object events 
display normally. The default value is FALSE.

HideErrorDialog API Toolkit-specific

When set to TRUE, the HideErrorDialog string value 
hides error dialog boxes. This is only TRUE for events 
triggered using scripting. Error dialog boxes triggered 
by conventional GUI object events display normally. 
The default value is FALSE.

HideSearchMenu When set to TRUE, the HideSearchMenu string value 
hides the Search command from the right-click menu. 
The default value is FALSE.

HideToolBars When set to TRUE, the HideToolBars string value hides 
all Toolbars. The default value is FALSE.

HideMainToolBar When set to TRUE, the HideMainToolBar string value 
hides the Toolbar. The default value is FALSE.

HideMainMenu When set to TRUE, the HideMainMenu string value 
hides the Menu bar. The default value is FALSE.

HideTabBar When set to TRUE, the HideTabBar string value hides 
the Report Tabs bar. The default value is FALSE.



■ 193Hyperion Analyzer Release 7.0 Administrator’s Guide

HideStatusBar When set to TRUE, the HideStatusBar string value 
hides the Status bar. The default value is FALSE.

HideReportPopupMenu When set to TRUE, the HideReportPopupMenu string 
value hides the Report Tabs bar right-click menu. The 
default value is FALSE.

HidePrevNext When set to TRUE, the HidePrevNext string value hides 
the Back and Forward Toolbar buttons. The default 
value is FALSE.

HidePrevNextSm When set to TRUE, the HidePrevNextSm string value 
hides the dynamic Back and Forward Details bar 
buttons. The default value is FALSE.

HideHome When set to TRUE, the HideHome string value hides 
the Home Toolbar button. The default value is FALSE.

HideHomeSm When set to TRUE, the HideHomeSm string value hides 
the dynamic Home Details bar button. The default value 
is FALSE.

HideNew When set to TRUE, the HideNew string value hides the 
New Toolbar button. The default value is FALSE.

HideOpen When set to TRUE, the HideOpen string value hides the 
Open Toolbar button. The default value is FALSE.

HideSave When set to TRUE, the HideSave string value hides the 
Save Toolbar button.  The default value is FALSE.

HideSaveAs When set to TRUE, the HideSaveAs string value hides 
the SaveAs Toolbar button.  The default value is 
FALSE.

HideClose When set to TRUE, the HideClose string value hides the 
Close command on the Report Tabs bar right-click 
menu. The default value is FALSE.

HideCloseAll When set to TRUE, the HideCloseAll string value hides 
the CloseAll command on the Report Tabs bar 
right-click menu. The default value is FALSE.

Table 2: Applet Parameters (Continued)

Applet Parameter Description
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HideReloadReport When set to TRUE, the HideReloadReport string value 
hides the Reload Report command on the Report Tabs 
bar right-click menu. The default value is FALSE.

HideNav When set to TRUE, the HideNav string value hides the 
Cube Navigator commands on the Menu bar and 
Toolbar. The default value is FALSE.

HideReportProps When set to TRUE, the HideReportProps string value 
hides the Properties command on the Report Tabs bar 
right-click menu. The default value is FALSE.

HideImport When set to TRUE, the HideImport string value hides 
the Import command on the Menu bar. The default value 
is FALSE.

HideExport When set to TRUE, the HideExport string value hides 
the Export command on the Menu bar. The default value 
is FALSE.

HideDesigner When set to TRUE, the HideDesigner string value hides 
the Design Report command on the Menu bar and Tools 
Toolbar drop down menu. The default value is FALSE.

HideTools When set to TRUE, the HideTools string value hides the 
Tools command on the Menu bar and Toolbar. The 
default value is FALSE.

HidePrint When set to TRUE, the HidePrint string value hides the 
Print command on the Menu bar and Toolbar. The 
default value is FALSE.

HideUserSettings When set to TRUE, the HideUserSettings string value 
hides the User Preferences command on the Menu bar 
and Toolbar. The default value is FALSE.

HideReportGroupProps When set to TRUE, the Hide string value hides the . The 
default value is FALSE.

HideUndoRedo When set to TRUE, the HideUndoRedo string value 
hides the Undo and Redo commands on the Details bar. 
The default value is FALSE.

Table 2: Applet Parameters (Continued)

Applet Parameter Description
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HideDisplayTypes When set to TRUE, the HideDisplayTypes string value 
hides the Display command on the Menu bar and 
Toolbar. The default value is FALSE.

HideToggleInfoPanel When set to TRUE, the HideToggleInfoPanel string 
value hides the Show/Hide Information Panel command 
on the Details bar. The default value is FALSE.

HideToggleFilters When set to TRUE, the HideToggleFilters string value 
hides the Show/Hide Filters command on the Details 
bar. The default value is FALSE.

HideToggleToolbar When set to TRUE, the HideToggleToolbar string value 
hides the Show/Hide Toolbar command on the Details 
bar. The default value is FALSE.

Password The string value of a valid password. Automatic login is 
triggered when all prerequisite parameters are provided.

ServerURL The ServerURL string value is the targeted Hyperion 
Analyzer Analysis Server name or IP address. When no 
value is set, Hyperion Analyzer attempts to locate a 
Hyperion Analyzer Analysis Server console. The 
default value is FALSE.

UseFrame  When set to TRUE, the UseFrame string value displays 
the applet in an independent window instead of in the 
Web browser interface. The default value is FALSE.

UserID The string value of a valid user ID. Automatic login is 
triggered when all pre-requisite parameters are 
provided.

SupportResolveMember API Toolkit-specific

When set to TRUE, the Hyperion Analyzer Java Web 
Client validates member parameters against the 
Hyperion Essbase outline, before executing the API 
method. When set to FALSE the Hyperion Analyzer 
Java Web Client validates only member IDs but does not 
validate aliases verbatim (to expedite processing). The 
default value is TRUE.

Table 2: Applet Parameters (Continued)

Applet Parameter Description
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Support Undo API Toolkit-specific

When set to TRUE, the SupportUndo string value 
enables undo and redo capability for applicable API 
events. Note:  Setting this parameter to TRUE slows 
application processing.

The default value is FALSE.

language_COUNTRY Sets locale parameters, using ISO-639 two-letter codes 
for language (in lower case) and country (in upper case) 
(for example, enUS for English, United States). The 
default is determined by the client computer's 
configuration.

Table 2: Applet Parameters (Continued)

Applet Parameter Description
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Appendix

C
Repository Tables

The repository centrally stores Hyperion Analyzer system data in relational 
database tables.  The repository is multi-user and is typically installed in shared 
local area network locations.  This kind of installation enables users to log on to 
any machine on the network or Intranet.  Users can also access their own reports 
and user preferences without copying files or performing import/export tasks.

For security and system integrity, repository tables cannot be edited or 
manipulated.

Table 1: Repository Tables

Table Function

TBLAUTHSRVR Records the server address of the 
authenticating server.

TBLAUTHTYPE Records the authentication server type 
definition.

TBLDATABASES Records the database connections 
available to client applications.

TBLDBTYPE Records the data source definitions for 
TBLDATABASES records.

TBLEXTERNALGROUPS Records the mapping between external 
authentication directory server groups 
and Hyperion Analyzer user groups.

TBLGLOBALDB Records global connection definition for 
TBLDATABSES records.

TBLOBJECTS Records the types of objects in the 
repository: Database, Report, Report 
Group, User, User Group, and so on.
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TBLOBJINSTANCEPERMISSIONS Records the object instance permissions 
definition.

TBLOBJLINKSOPS Records additional properties of 
TBLOBJLINKS records.

TBLOBJLINKS Records data required to maintain links 
between objects.

TBLOBJTYPEPERMISSIONS Records object type permission 
definitions.

TBLOBJTYPES Records the object type IDs for the 
TBLOBJ table.

TBLPARENTCHILD Records report-report group 
relationship data.

TBLPERMSINROLESMAP Records the relationship between 
objects and roles.

TBLREPORTGROUPS Records report group definitions.

TBLREPORTS Records report definitions.

TBLREPORTSTATE Records the report content definition 
and global formatting data.

TBLREPORTTYPE Records report type definitions.

TBLROLES Records role definitions.

TBLSYSTEMPROPS Records system-level-Java properties 
affecting all users.

TBLUSERANDGROUPHASROLEM
AP 

Records user and user group – role 
relationship data.

TBLUSERCREDENTIALS Records the token created during any 
form of authentication.

TBLUSERGROUPS Records user group definitions.

TBLUSERS Records user ID definitions.

TBLUSERSINUSERGROUPMAP Records user-user group relationships.

Table 1: Repository Tables

Table Function
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Appendix

D
User Preferences

Users can customize the Hyperion Analyzer display and set behavior for new 
reports by setting user preferences.

User Preferences and Formatting Options

There are some identical formatting options and user preferences. User 
preferences are global settings applied to all new reports. User Preferences, 
however, can be overridden by database connection formatting and report-based 
formatting.

Order of Formatting Precedence

1. Formatting options saved with reports

2. Formatting options saved with the database connection

3. Formatting options specified in the User Preferences dialog box

Note: Some user preferences may take effect only when reports are reloaded.

Accessing User Preferences

➤ To display the User Preferences dialog box:

● Click the Tools toolbar button drop-down menu and select User Preferences.

● Select Tools > User Preferences from the Menu bar.

User Preferences Dialog Box
The User Preferences dialog box contains a navigation panel and a user 
preferences panel.
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➤ To navigate among user preferences, click either the panel name or navigation 
node.

Modifying User Preferences

➤ To change preferences, navigate through the user preference panels, make your 
selections, and then click the Apply button.

General User Preferences
General User Preferences are divided into three groups:

● Home Page

● Startup

● Change Password

Table 2: User Preferences Panels

Panel User Preferences

General Home Page,  Startup Settings,  Change Password

Point of View Point of View

Look and Feel Use of Cube Navigator in new reports, Desktop Wallpaper, 
and Interface Elements

Drilling Drilling Methods, Linking, Append or Replace Member 
Selections

Spreadsheet Spreadsheet Formatting

Chart Chart Formatting

Default Formatting Leading and Trailing Formatting, Replace Missing With, 
and Numeric Formatting

Personal Variables Personal Variables

Connections Create database connections, Set database connection 
properties.

OLAP Server Suppression,  Show Linked Report Object Icons
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Home Page User Preferences
You have the option of specifying a report as the Hyperion Analyzer Home Page. 
The specified report is displayed when users click the Home toolbar button. You 
can also elect the Hyperion Analyzer Desktop as your home page.

➤ To set the Hyperion Analyzer Home Page using user preferences:

1. Click the toolbar Tools button drop-down menu and select User Preferences.

2. Take one of the following actions:

● Click the Use Desktop button to set the Hyperion Analyzer Desktop as 
the Home Page.

● Click the Use Current Report button to set the current report as the 
Home Page.

● Click the ellipses (...) button to set a report from the Report Manager 
dialog box as the Home Page.

3. Click the Apply button.

4. Click Close.

➤ To set the Hyperion Analyzer Home Page using the Home toolbar button:

1. Click the Toolbar Home button drop-down menu.

2. Select one of the following options:

● Analyzer Desktop

● Set Current Report As Home Page

● Reset Home Page to Analyzer Desktop

Startup User Preferences
Startup user preferences enable users to specify the report or report group to be 
displayed at startup. Options include these starting points:

● The Normal mode interface (None)

● The Report Manager

● The Hyperion Analyzer Home Page

● A specific report group
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● A specific report

➤ To set startup user preferences:

1. Take one of the following actions:

● Click the Tools toolbar button drop-down menu and select User 
Preferences.

● Select Tools > User Preferences from the Menu bar.

2. Select the General tab of the User Preferences dialog box.

3. Select one of the startup user preferences option buttons:

● None

● The Report Manager

● Home Page

● Report group

● Report

4. Optional:  If you selected the Report Group, or Report option, click the 
ellipses (...) button and browse to a specific report group or report.

5. Click the Apply button, and then click Close.

Change Password Dialog Box
The Change Password button displays the Change Password dialog box, enabling 
users to change their Hyperion Analyzer password.

The Change Password dialog box requires that users to enter an alternate 
password.

Two events automatically prompt users to change their password:

● Hyperion Analyzer Administration Tools users can select the Change 
Password at Next Login checkbox, to prompt the manual update of their 
password.

● Administrators can require users to update their password at a regular 
intervals, using Administration Tools security settings.

You can also opt to change your passwords voluntarily using General User 
Preferences.
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Point of View User Preferences
Point of View user preferences enable users to insert automatically the dimensions 
and members that are of interest to them into the reports of others.

Points of View expedites the process of member selection in complex dimensions 
and ensures accurate, standardized selections. You can also generate reports and 
make member selections manually with Cube Navigator and Dimension Browser.

Consider the following four (4) benefits:

Generic and Specific Reports

Report designers in large enterprises can create a set of generic reports, knowing 
that individual users can superimpose diverse and user-specific member selections 
into these reports.

Replacing Member Selection Statements

Users can apply the complex calculations and analysis tool definitions of others' 
reports to the dimensions and members they track, using Point of View. This 
eliminates the need for the user to investigate and recreate these analyses.

Default Dimension Layout and Member Selections for New 
Reports

When Point of View is activated, the report-creation process is simplified. Cube 
Navigator is loaded with the dimension member selections designated by the 
current Point of View.

Session-based Point of View

Point of View is session-based. Point of View definitions are saved and recalled as 
part of individual database connections. This enables them to be used on all the 
reports using the corresponding database connection.

Reloading Reports

Users must reload the report for the applied Point of View definition to be 
displayed.
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Point of View and Personal Variables

Point of View definitions replace all existing member selections for corresponding 
dimensions and database connections. Personal variables can instead augment 
existing member selections for a single dimension.

Users can also leverage personal variables in the creation of Point of View 
definitions.

Point of View User Preferences

Using Point of View

The Use Point of View check box in Cube Navigator Options enables and disables 
point of view for the database query.

Table 3: Point of View User Preferences

Point of View User 
Preferences Description

Point of View Lists Point of View definitions for the current 
database connection.

Name Names the Point of View definition.

Database Connection Relates the Point of View definition to a database 
connection.

Activate This Point of View Enables the selected Point of View definition.

Member Selections Enables users to edit the Point of View definition.

Add Creates the Point of View definition.

Remove Deletes the selected Point of View definition.

Apply Saves User Preferences changes.

Close Closes the User Preferences dialog box.
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Look and Feel User Preferences
Look and Feel user preferences are organized into three groups: drilling, 
spreadsheet, and chart. Each group of Look and Feel user preferences is displayed 
on a separate panel.

Spreadsheet user preferences and chart user preferences are identical to 
spreadsheet options and chart properties.  They are only applied to subsequently 
created reports, however.

Look and Feel Options

Table 4: User Preferences Related to Look and Feel

Look and Feel User 
Preferences Description

Look and Feel • Sets interface elements to be displayed by default.

• Sets the Desktop wallpaper graphic.

• Sets whether or not Cube Navigator automatically lays 
out dimensions.

Drilling • Sets the default drilling method.

• Sets default Drill Linking options.

• Sets default drilled member display behavior.

Spreadsheet Sets default spreadsheet display type formatting.

Chart Sets default chart display type formatting.

Table 5: Look and Feel User Preferences

Look and Feel User 
Preferences Description

New Reports

Use Cube Navigator Enables or disables automatic layout of 
dimensions.

Desktop
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Use Cube Navigator Check Box

Hyperion Analyzer provides the option of automatically laying out the dimensions 
associated with any given database connection. This behavior locates the first 
dimension in the database connection on the row axis and all subsequent 
dimensions to the columns axis.

When the Use Cube Navigator Check box is selected no automatic layout is 
applied. Users must then use Cube Navigator to select and position dimensions in 
the report.

Drilling User Preferences
Drilling user preferences are organized into three groups:

● Methods

● Linking

Select Wallpaper Displays the Select Graphic dialog box, enabling 
users to select a GIF or JPEG file for use as the 
Desktop background.

Display

Report Tabs Sets report tabs to be displayed by default.

Menu Bar Sets the menu Bar to be displayed by default.

Toolbar Sets the toolbar to be displayed by default.

Toolbar Text Labels Sets toolbar text titles to be displayed by default.

Filter Panel Sets the ilter panel to be displayed by default.

Information Panel Sets the Information panel to be displayed by 
default.

Status Bar Sets status bar to be displayed by default.

Multiple Page drop-down List 
Boxes

Sets multiple page drop-down list boxes to be 
displayed by default.

Apply Saves User Preferences changes.

Close Closes the User Preferences dialog box.

Table 5: Look and Feel User Preferences
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● Behavior

Drilling User Preferences Options

Default Formatting User Preferences
Formatting options enable users to format headers and data based on dimension 
member selections.

Table 6: Drilling User Preferences

Drilling User Preferences Description

Method Sets drilling navigation through the dimension 
hierarchy to one of the following menu options:

Next Level Returns the next lowest level.

Descendants Returns all descendants.

Dimension Bottom Returns the lowest level (level O).

Siblings Returns members on the same level with the same 
parent.

Same Level Returns members on the same level.

Same Generation Returns members the same distance from the 
highest ancestor.

Linking

Pass Pages Sets drill linking to pass the page dimension 
member context.

Pass Filters Sets drill linking to pass the filter dimension 
member context.

Behavior

Append Member Selections Augments the drilled member with the drilling 
result set.

Replace Member Selections Replaces the drilled member with the drilling 
result set.

Apply Saves User Preferences changes.

Close Closes the User Preferences dialog box.



208 ■

User Preferences

Hyperion Analyzer 7.0 Java Web Client User’s Guide

While the formatting options are fixed, the scope of the formatting varies 
depending on the source of the formatting.

Default Formatting Options

Table 7: Default Formatting Options Overview

Formatting Options Description

Leading and Trailing 
Formatting

Currency Symbol Inserts the following currency formatting symbols 
into the Positive Prefix and Negative Prefix text 
boxes: Dollar ($), Cents (¢), Pound (£), Euro(E), 
Deutschmark (DM), Franc (F), and Yen (¥).

Positive Prefix Enters character to precede positive numeric values.

Positive Suffix Enters character to follow positive numeric values.

Negative Prefix Enters character to precede negative numeric values. 
Warning: The minus sign (-) is the default prefix. 
Deleting the default prefix without replacing it causes 
negative values to display positively.

Negative Suffix Enters character to follow negative numeric values.

Numeric Formatting

Grouped Thousands 
Check Box

Displays numeric digits as grouped by thousands.

Minimum Decimals Indicates the minimum number of decimal places to 
display.

Maximum Decimals Indicates the maximum number of decimal places to 
display.

Scale Enables abbreviated values by tens, hundreds, 
thousands, ten-thousands, hundred-thousands, 
millions, and billions.

Use Negative Color Check 
Box

Indicates that negative numbers are signified by a 
selected color.

Select Negative Color Enables users to select the color representing negative 
values.
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Personal Variables User Preferences
Personal variables enable users to define and name complex member selections. 
After they have been defined, users can leverage personal variables any time they 
are presented with the corresponding dimension and database connection.

Generic and Specific Reports

Other users can create personal variables using the same name, dimension, and 
database connection that contain the dimensions members that are of interest to 
them.

This technique enables everyone to create hybrid reports that feature both generic 
and user-specific content.

Point of View and Personal Variables

Point of View definitions replace all existing member selections for corresponding 
dimensions and database connections. Personal variables can instead augment 
existing member selections for a single dimension.

Users can also leverage personal variables in the creation of Point of View 
definitions.

Samples

Update Samples Updates the samples panel based on the most recent 
formatting selections.

Replace Missing With Replaces missing values with either a text string or 
zero.

Zeros

Text

Table 7: Default Formatting Options Overview
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Personal Variable User Preferences

Connections User Preferences
The Connections User Preferences panel provides an inventory of database servers 
and database connections available to the current user.

The database type, the database connection name, and any associated alias tables 
for available database connections are displayed.

Modifying Database Connection Properties

Users can display and edit the database connection properties by selecting a 
database connection and clicking the Modify button.

Table 8: Personal Variables User Preferences

Personal Variable User 
Preferences Description

Personal Variables Lists Personal Variable definitions for the current 
database connection.

Name Names the Personal Variable definition.

Database Connection Relates the Personal Variable definition to a database 
connection.

Dimension Indicates the dimension of the related database 
connection for which a Personal Variable is being 
created.

Member Selections Enables users to edit the Personal Variable definition.

Add Creates the Personal Variable definition.

Remove Deletes the selected Personal Variable definition.

Apply Saves User Preferences changes.

Close Closes the User Preferences dialog box.
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Adding Database Connections
Hyperion Analyzer provides users with an easy-to-use graphic interface for 
creating online analytical processing (OLAP) and relational database connections. 
Users are prompted to select a database type, log on to the database server, and 
select a specific database in turn, until the database connection is defined.

➤ To create an Essbase database connection using the Connections User Preferences 
panel:

1. Display the User Preferences dialog box using one of the following actions:

● Click the Tools toolbar button drop-down menu and select User 
Preferences.

● Select Tools > User Preferences from the Menu bar.

2.  Select Connections User Preferences.

3. Click the Add New button.

The Select Database Type dialog box is displayed.

4. Select Essbase from the drop-down list and Click OK.

The Hyperion Essbase Login dialog box is displayed.

5. Specify the Essbase server and a valid Essbase user ID and password.

6. Click OK.

The List Databases dialog box is displayed.

7. Select a database from the Available Databases list and click the right-arrow 
button.

The selected database is added to the Selected Databases list.

8. Click OK.

The selected database is added to the Connections User Preferences list.
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OLAP Server User Preferences
OLAP server user preferences enable users and administrators to set features of the 
OLAP server from the Hyperion Analyzer client.

Essbase imposes a maximum limit of 256 columns. Hyperion Analyzer sets a 
column limit of 50,000 data cells for a query. There is also a query governor that 
enables users to set limits on the number of cells returned by a query; the default 
is also 50,000 data cells.  For more information about the Analyzer.properties file, 
see the Hyperion Analyzer Administrator’s Guide.

Table 9: OLAP Server User Preferences

OLAP Server User Preferences Description

Suppress Omits the following components, as selected, 
from the query result set:

Missing Rows

Shared Members

Zero Rows

Show Linked Reporting Object 
Indicators Check Box

Prevents the display of LRO icons (Blue 
Triangles).
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administrator. An individual who installs and maintains the Hyperion Analyzer 
system, including establishing user IDs, passwords, database connections and 
security. See also System Manager.

Analysis Server. Hyperion Analyzer Analysis Server. An application server that 
distributes report information and enables Web clients to communicate with the 
OLAP server.

asymmetric analysis. A report characterized by groups of members that differ by 
at least one member across groups. There can be a difference either in the number 
of members or in the names of the members.

attribute. A dimension member classification. An attribute can be specified to 
select and group members that have the specified attribute associated with them, 
and to perform calculations and application-specific functions.

attribute dimension. A type of dimension that enables analysis based on the 
attributes or qualities of the members of its base dimension.

axis. A discrete aspect of the two-dimensional report on which multidimensional 
data is displayed, such as filters, pages, rows, and columns.

calculation. The process of aggregating data, or of running a calculation script on 
a database.

calculation script. A set of instructions telling Hyperion Essbase how to 
calculate the values of a database.

cell. A unit of data representing the intersection of dimensions in a 
multidimensional database. Also, the intersection of a row and column in a 
spreadsheet.

chart. One of the three report display types. Chart reports also have a chart type 
property set for them. Charts are created using Hyperion Analyzer.
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child. A member that has a parent above it in the database hierarchy. A child may 
have siblings (peers) that exist at the same level of the database hierarchy.

client. A client interface, such as Hyperion Analyzer, or a workstation on a local 
area network.

column. A vertical display of information in a grid or table. A column can contain 
data from a single field, derived data from a calculation, or textual information. 
Contrast with row.

database. A repository of data within Hyperion Essbase that contains a 
multidimensional data storage array. Each database consists of a storage structure 
definition (outline), data, security definitions, and optional scripts.

database connection. A user-friendly database alias used instead of a long 
database identifier (server name, application name, and database name) that 
enables database references to be more portable.

data source. A named client-side object connecting report components to 
databases, using database connections, queries, and other components.

descendant. Any member below a parent in the database outline.

Desktop. An automatically generated report that dynamically presents buttons 
that enable groups of reports to be accessed with a single click.

dimension. A data category that is used to organize business data for retrieval and 
consolidation of values. Each dimension contains a hierarchy of related members 
grouped within it.

display type. One of three Hyperion Analyzer formats saved to the repository: 
spreadsheet, chart, and Pinboard.

external authentication. The ability to log in to Hyperion applications using user 
information stored outside the application itself; user names and passwords are 
instead managed in a corporate authentication provider such as LDAP or 
Microsoft Windows NTLM.

hierarchy. A set of multidimensional relationships in an outline, often created in 
a tree format.

implied share. A member with only one child, or a member with multiple 
children of which only one child is consolidated. For this reason the parent and 
child share the same value.

intersection. A unit of data representing the intersection of dimensions in a 
multidimensional database. Also, a worksheet cell.
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JDBC. Java Database Connectivity driver. Client-server communication agent 
between Java-based clients and databases.

linked reporting object (LRO). An external file that is linked to a data cell in a 
Hyperion Analyzer report.

member. A discrete item that forms part of a dimension.

missing data. A marker indicating that data in the labeled location either does not 
exist, contains no meaningful value, or was never entered.

multidimensional database (MDDB). A method for referencing data through 
three or more dimensions. An individual record is the intersection of a point for a 
set of dimensions.

multithreading. A client-server process that enables multiple users to work on 
the same applications without interfering with each other.

online analytical processing (OLAP). A multidimensional, multi-user, 
client-server computing environment for users who need to analyze consolidated 
enterprise data in real time. OLAP systems feature drill-down, data pivoting, 
complex calculations, trend analysis, and modeling.

parent. A member that has subordinate members below it in the hierarchy.

personal variable. A means by which users define and name complex member 
selections.

pinboard. One of the three report display types. Pinboards are graphic reports, 
composed of backgrounds and interactive icons called Pins. Pinboards are created 
using Hyperion Analyzer Design Tools.

point of view (POV). A means by which users automatically insert dimensions 
and members that are of interest to them into the reports of others.

pins. Interactive icons placed on graphic reports called pinboards. Pins are 
dynamic. They can change images, and traffic lighting color based on the 
underlying data values and analysis tools criteria.

report. A Hyperion Analyzer display of selected multidimensional cube 
dimensions and members. A report is both the content and the format of the 
display. After it is saved to the repository, a report becomes a multipurpose file that 
users can display in numerous formats.

report group. A group of Hyperion Analyzer reports.

repository. A set of relational database tables for storing report definitions and 
Hyperion Analyzer system information.
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role. A user type label. Roles give or withhold the permissions needed for various 
Hyperion Analyzer tasks.

row. A horizontal display of information in a grid or table. A row can contain data 
from a single field, derived data from a calculation, or textual information. 
Contrast with column.

query. A component of the data source. Queries are SQL statements submitted to 
the database, which return multidimensional intersection result sets.

server. A multi-user database server that accesses data values based on the 
intersection of dimension members.

single sign-on. The ability for a user to access multiple Hyperion Applications 
after logging on just once using external credentials.

spreadsheet. One of the three report display types. Spreadsheets are tabular 
reports of rows, columns and pages, created using Hyperion Analyzer.

subset. A group of members selected by specific criteria.

substitution variable. A variable that acts as a global placeholder for information 
that changes regularly. You set the variable and a corresponding string value; the 
value can be changed at any time.

System Manager. An individual who installs and maintains the Hyperion 
Analyzer system including establishing user IDs, passwords, database 
connections, and security. See also administrator.

toolbar. A series of shortcut buttons providing quick access to the most 
frequently used commands.

traffic lighting. Color-coding of report cells, or Pins based on a comparison of 
two dimension members, or on fixed limits. Traffic lighting definitions are created 
using the Hyperion Analyzer Traffic Light Analysis Tool.

Uniform Resource Locator (URL). An address for a resource in the World 
Wide Web, such as a document, an image, downloadable files, a service, or an 
electronic mailbox. URLs use a variety of naming conventions and access 
methods, such as HTTP, FTP and Internet mail. URLs can point to files on a local 
network drive, or to reports in the Hyperion Analyzer repository.
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{system} and defaultuser Do Not Migrate, 140

A
About, 177
About Alias Tables, 115
About Database Connection Properties, 88
About Database Connections, 87
About Hyperion Financial Management Database 

Connections, 91
About Measures Formatting, 113
About Relational Access, 94
About Relational Database Connections, 96
Accessing Report Properties, 150
Accessing User Preferences, 74, 199
Action, 176
Actions List, 176
Adding Database Connections, 211
Additional Support, xv
Administrating Hyperion Analyzer, 19
Administration Resources, 21
Administration Strategies, 26
Administration Tasks, 19
Administration Tools Overview, 53
administration tools, Hyperion Analyzer, 21
AdminMigrate.exe, 133
Alias Tables, 115
Analysis Server Console Interface, 118
analysis server, Hyperion Analyzer, 21
Analyze, 177
Analyzer Authentication, 29

Analyzer authentication
overview, 29
setting, 31

Analyzer.Properties File, 122
Analyzer.properties File, 25
AnalyzerCredential.jsp, 152
analyzerCredential.jsp, 152
AnalyzerMigrate.exe, 134
api toolkit, 22
Applet Parameters, 191
applet parameters, 191
Application Window Title Bar, 54
Architectural Overview, 22
archives, copying to application server, 50
Assigning Database Connections to Users, 71, 107
Assigning Database Connections to Users Groups, 

79, 108
Assigning Report Groups to User Groups, 80
Assigning Report Groups to Users, 73
Assigning Roles to User Groups, 63
Assigning Roles to Users, 62
Assigning User Groups Report Group Access, 85
Assigning User Preferences to Users, 74
Assigning Users Groups Roles, 77
Assigning Users Report Group Access, 85
Assigning Users Roles, 69
Assigning Users to User Groups, 70, 78
Audience, xi
audience for this guide, xi
Authentication Options, 29
authentication options, 29
Automating the Distribution of HTML Web Content, 

20
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C
CancelDBLogin, 177
CancelEdit, 177
CancelSave, 177
Change Password, 200, 202
Change Password Dialog Box, 202
ChangePassword, 177
Client Installation of Hyperion Financial 

Management, 91
Cloning New Users, 67
Common Conversion Exceptions, 141
Configuration and Integration Options, 121
Configuration Test Servlet, 153
Configuring a Mail Server for Hyperion Analyzer, 

122
Configuring an LDAP or MSAD Provider, 43
Configuring an NTLM Provider, 41
Configuring Different Java Plug-in Versions, 131
Configuring Essbase XTD Deployment Services, 126
Configuring External Authentication, 33
Configuring External Authentication with Hyperion 

Essbase, 131
Configuring for SiteMinder Single Sign-On, 49
Configuring Hyperion Hub, 121
Configuring Integrated Hyperion Applications, 20
Configuring Microsoft Excel to Support Hyperion 

Analyzer, 131
Configuring Preferred Logging Priority, 48
Configuring the Provider Search Order, 40
Configuring Token Timeout, 48
Connections User Preferences, 210 to 211
Consulting Services, xv
consulting services, xv
Controlling the Result Set, 89, 123
Controlling the Result Set Size, 123
Controlling the Size of the Query Result Set, 96, 110
Conventions, xiv
Conversion Exceptions, 139
conversion exceptions, 139
conversion utilities, 133
Converting a View to a Report, 136
Converting Release 5.0.3 Users to Release 7.0 Users, 

135
Converting View Groups to Report Groups, 138
Copying Archives to the Application Server JRE, 50

Creating a Hyperion Essbase Database Connection in 
Administration Tools, 89

Creating a Hyperion Financial Mangement Database 
Connection in Administration Tools, 93

Creating Dynamic Measures Formatting, 115
Creating Measures Formatting Definitions, 113
Creating New Users, 66
Creating Relational Database Connections, 102
Creating Relational Drill-Through, 110
Creating Relational Drill-through, 110
Creating Report Groups, 83
Creating the Web Publishing XML File, 151
Creating Users, 66
Creating Users Groups, 75
CssConfig.xml File, 25
CssConfig.xml file

editing, 39
specifying location, 50

Custom Report SQL Spreadsheet, 94
Custom Templates, 158
Customizing HTML Web Content, 21, 157

D
Data Objects, 164
Database Connections

Configuring, 89
DBLogin, 177
Default Dimension Layout and Member Selections 

for New Reports, 203
Default Formatting Options, 208
Default Formatting User Preferences, 207
Default Nodes, 57
Default Roles and Permissions, 61
Defining a Relational Database Connection, 95
Defining Hyperion Analyzer User Groups, 38
Defining Relational Table Properties, 99
Defining the Relational Cube, 99
Deleting Report Groups, 84
Deleting Users, 69
Deleting Users Groups, 77
Desktop, 178
DimBrowser, 178
Document Structure, xii
Documentation Feedback, xvi
documents
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conventions used, xiv
feedback, xvi
ordering print documents, xiii
structure of, xii

documents, accessing
Hyperion Download Center, xiii
Hyperion Solutions Web site, xiii
Information Map, xiii
online help, xiii

DrillCell, 178
DrillDown, 179
Drilling Options, 206
Drilling User Preferences, 206
Drilling User Preferences Options, 207
DrillToTop, 179
DrillUp, 179

E
EditData, 180
Editing the Analyzer.properties File, 123
Editing the Configuration File, 39
Editing the CssConfig.xml File, 39
Editing User Preferences, 74
Editing Users, 68
Editing Users Groups, 76
Education and Training, 20
Education Services, xv
education services, xv
EIS Drill-through, 95
Environmental Variables, 154
Essbase Alias Tables, 115
Essbase Authentication, 30
Essbase authentication, setting, 32
Existing Configuration Files, 39
Exiting Hyperion Analyzer Administration Tools, 28
Exporting an .ARU XML File, 149
ExportToHtml, 180
External Authentication, 30
external authentication

components, 37
configuring, 33
overview, 30

external authentication platforms, supported, 31
External Authentication Prerequisites, 33
external authentication providers, supported, 30

External Authentication Requirements for Hyperion 
Integrated Applications, 126

F
FocusDisplayObject, 180
Formatting Data Value Tool Tips, 130
Formatting User Preferences, 207

G
General User Preferences, 200, 202
Generic and Specific Reports, 203, 209
groups, mapping to user groups, 51

H
Home, 180
Home Page, 200 to 202
Home Page User Preferences, 201
HTML Client

About Style Tags, 175
HTML Client List Template

Style Tags, 175
HTML Client Template

Style Tags, 174
HTML Web Client

Actions, 175
Samples, 188
Tags, 158
Templates, 157
URL Components, 176

HTML Web Client Actions, 175
About, 177
Analyze, 177
CancelDBLogin, 177
CancelEdit, 177
CancelSave, 177
ChangePassword, 177
DBLogin, 177
Desktop, 178
DimBrowser, 178
DrillCell, 178
DrillDown, 179
DrillToTop, 179
DrillUp, 179
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EditData, 180
FocusDisplayObject, 180
Home, 180
LoadGroup, 180
LoadReport, 181
Login, 181
Logout, 181
MoveDim, 182
NewDispType, 182
NewPage, 183
NextReport, 184
Portal, 189
PrevReport, 184
RefreshEdits, 184
Reload, 184
ReportManager, 184
RunCalc, 184
Save, 185
SaveAs, 185
SaveAsPage, 185
SendData, 185
SetDim, 186
SetParam, 187
SetServiceDispatcher, 187
SetSubscriptionController, 187
Startup, 188
ToggleFilters, 188
ToggleMultiPage, 188
ToggleStyle, 188
using, 176

HTML Web Client Templates, 157
Hyperion Analyzer

architecture, 22
components, 21

Hyperion Analyzer 5.0.3 Migration Utility, 133
Hyperion Analyzer Administration Tools, 21, 24
Hyperion Analyzer Administration Tools Interface, 

53
Hyperion Analyzer Analysis Server, 21
Hyperion Analyzer Analysis Server Console, 24, 117
Hyperion Analyzer Architecture Overview, 22
Hyperion Analyzer Batch Import/Export Utility via 

API Toolkit, 26, 66
Hyperion Analyzer Components, 21
Hyperion Analyzer Configuration Test Servlet, 24, 

153

Hyperion Analyzer HTML Web Client, 22
Hyperion Analyzer Import/Export Utility, 142
Hyperion Analyzer Installation and External 

Authentication Components, 37
Hyperion Analyzer Installer, 24
Hyperion Analyzer Java Web Client, 21
Hyperion Analyzer Migration Utility, 26
Hyperion Analyzer Repository, 95
Hyperion Analyzer Save As Web Page Batch Utility, 

25
Hyperion Analyzer Standalone (Windows) Client, 

150
Hyperion Analyzer Utilities, 133
Hyperion Analyzer Windows Client, 22
Hyperion Consulting Services, xv
Hyperion Download Center

accessing documents, xiii
Hyperion Education Services, xv
Hyperion Essbase authentication, 30
Hyperion Financial Management Alias Tables, 115
Hyperion Financial Management Installation on the 

Client, 91
Hyperion Hub, 25
Hyperion Integrated Application Definition 

Examples, 126
Hyperion NTLM Remote Server, installing, 36
Hyperion product information, xv
Hyperion Solutions Web Site

accessing documents, xiii
Hyperion support, xv
Hyperion Technical Support, xvi

I
Identifying Integrated Hyperion Applications for 

Hyperion Analyzer, 125
Import Process Order, 142
Important Notes on JDBC Drivers, 98
Important Notes on Relational Table Properties, 101
Importing an .ARU XML file, 143
Importing Authenticated Users, 148
Installation, Configuration and Migration, 19
Installing and Configuring JDBC Drivers, 97
Installing Hyperion Financial Management on the 

Client, 91
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Installing Hyperion Remote Authentication Module 
to Support UNIX applications, 36

Installing the Hyperion Financial Management Client 
on the Hyperion Analyzer Analysis Server, 91

Integrating OLAP and Relational Data, 109

J
JSP Templates, 150

L
Label Mode, 116
LDAP, 30

configuring, 43
Lightweight Directory Access Protocol Directory, 30
Linked Views Must Be Converted Together in a 

View Group, 140
LoadGroup, 180
LoadReport, 181
Locating the Web Publishing XML File, 152
Lockout Recovery, 28
lockout recovery, 28
Log Panel, 59
Logging On to Hyperion Analyzer Administration 

Tools, 27
Logging On to the Hyperion Analyzer Analysis 

Server Console, 117
logging priority, configuring, 48
Login, 181
Logout, 181
Look and Feel Options, 205
Look and Feel User Preferences, 205

M
Management Panel, 59
Managing Database Connections, 87
Managing Memory Allocation, 120
Managing Report Groups, 83
Managing Roles, 59
Managing Security and Access, 20, 29
Managing User Groups, 75
Managing Users, 65
Managing Users, User Groups and Database 

Connections, 20

Mapping Groups to User Groups, 51
Measures Formatting, 113 to 115
Measures Formatting Dialog Box, 114
Menu Bar, 54
Microsoft Active Directory, 30
Microsoft Windows NT Authentication, 93
Microsoft Windows NT LAN Manager, 30
migration process, 134
Modifying Database Connection Properties, 210
Modifying User Preferences, 200
MoveDim, 182
MSAD, 30

configuring, 43
Multiple-Domain Support for NT LAN Manager, 37

N
Named Report Startup Options, 140
Naming Conventions, 65, 75
Navigation Panel, 56
NewDispType, 182
NewPage, 183
NewReport, 183
NextReport, 184
No Defaults for Custom Report Selection Controls, 

140
Nodes, 56
NTLM, 30
NTLM provider, configuring, 41

O
OLAP Server User Preferences, 212
Optimizing Hyperion Analyzer, 117
Optimizing the Hyperion Analyzer System, 20
Other Hyperion Analzyer Resources, 23
Overview of the Migration Process, 134
Owning and Sharing, 140

P
Parameter, 180 to 184, 187
Permissions, 59
Personal and Global Database Connections, 88
Personal Variable User Preferences, 210
Personal Variables User Preferences, 209 to 210
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Point of View and Personal Variables, 204, 209
Point of View User Preferences, 203 to 204
Portal, 189
preferred logging priority, configuring, 48
Prerequisites for Starting, 27, 117
prerequisites for using this guide, xi
Prerequisites for Web Publishing, 150
PrevReport, 184
Print, 184
Privileges must be established on the computer 

running the application server (as opposed to the 
NT domain)., 37

provider search order, configuring, 40
Publish To, 151
Purpose, xi

R
RefreshEdits, 184
Registering Hyperion Analyzer with Hyperion Hub, 

122
Relational Drill-through, 94
Relational Drill-through Overview, 109
Relational Drill-through Process Overview, 109
Relational Overview, 94
Reload, 184
ReloadData, 184
Reloading Reports, 203
Removing Roles from Users, 63
Replacing Member Selection Statements, 203
Report Groups, 83
Report Properties, 150
ReportManager, 184
repository, 21
Repository Tables, 197
Required NTLM User Rights, 37
Resolving Hyperion Essbase Subscriptions in 

Hyperion Analyzer, 130
Restart the Hyperion Analyzer Analysis Server, 93
Restarting the Application Server, 50
Retrieving Relational Tables, 99
Reviewing a list of Reports in a Report Group, 86
RunCalc, 184
Running the Web Publishing Batch Utility, 152

S
Samples, 188

HTML Web Client, 188
Save, 185
SaveAs, 185
SaveAsPage, 185
Searching for Nodes, 57
Secure Socket Layer, 52
secure socket layer, 52
security options, 29
SendData, 185
Session-based Point of View, 203
Set Alias Table Dialog Box, 115
SetAliasController, 186
SetDim, 186
SetParam, 187
SetServiceDispatcher, 187
SetSubscriptionController, 187
Setting Alias Tables, 116
Setting Analyzer Authentication, 31
Setting Authentication Methods, 31
Setting Essbase Authentication, 32
Setting Hyperion Analyzer to Log Queries, 131
Single Sign-on, 31
Specifying the Alias Table to Use, 115
Specifying the Configuration File Location, 50
Starting Hyperion Analyzer Administration Tools, 27
Startup, 188
Startup User Preferences, 201
Style Tags

About, 175
List Template, 175
Template, 174

System Requirements, 96
System Status Panel, 119

T
Technical Support, xvi
technical support, xvi
Template Tag

styles, 174
Template Tag Styles, 174
Template Tag Styles List, 174
Template Tags, 158, 173
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, 158 to 174
Analyze, 158

Templates
Custom Templates, 158

Three Kinds of Database Connections, 88
ToggleFilters, 188
ToggleInfo, 188
ToggleMultiPage, 188
ToggleStyle, 188
token timeout, configuring, 48
Two Kinds of Conversion, 133

U
Unique Member and Calculation Names, 140
Updating the License Key Without Reinstalling, 124
Use Cube Navigator Check Box, 206
User Group Profiles, 75
user group profiles, creating, 38
user groups

mapping groups to, 51
User Preferences

Default Formatting of Headers and Data, 207
User Preferences and Formatting Options, 74, 199
User Preferences Dialog Box, 199
User Preferences Overview, 199
User Profile Creation and Authentication, 66
User Profiles, 65
user rights

required NTLM, 37
user roles, 38
User Sessions Panel, 119
users

converting, 135
importing, 148

using
HTML Web Client Actions, 176

Using Actions, 176
Using Actions to Retrieve Information, 189
Using Alias Tables, 115
Using Point of View, 204

V
Verifying Communications between the Application 

Server and Client, 92

Verifying DCOM Settings on the Client, 92
view groups, converting to report groups, 138
view, converting to a report, 136

W
Web Publishing Batch Utility, 150
Web Publishing XML File Explanation, 151
Where to Find Documentation, xiii

X
XML File Format Example, 143
XML File Format Explanation, 145
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